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Preface

* In addition to the above manuals, the following Fuji Electric FA Components & Systems Co., Ltd. site offers various manuals
and technical documents associated with MICREX-SX.

URL    http://www.fujielectric.co.jp/fcs/eng/

Thank you for your selection of Fuji Electric Programmable Controller MICREX-SX Series.
This User’s Manual explains programming of the MICREX-SX Series out of the operations of the loader for software package
FLEX-PC/MICREX-SX for personal computers which can be used for both the MICREX-SX Series and FLEX-PC Series. For
programming of FLEX-PC Series, refer to Help or “Software Package FEH403 for FLEX-PC Personal Computer Loaders.”
Also read the related manuals shown below.

Special Notes
This product cannot read programs created by Loader D300win dedicated for the MICREX-SX Series.

* Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation of the U.S.A.
* Pentium is a registered trademark or trademark of Intel Corporation of the U.S.A.

Title Manual No. Contents

MICREX-SX Series SPH
User's Manual Instructions

FEH588 Describes memory, language, system definition, etc. of the
MICREX-SX SPH Series.

MICREX-SX Series SPH
User's Manual Hardware

FEH201 Describes system configuration, hardware specifications of
each module, and operations of the MICREX-SX SPH Series.

MICREX-SX Series SPB (SX-mode)
User's Manual Instructions

FEH202 Describes memory, language, system definition, etc. of the
MICREX-SX SPB Series.

MICREX-SX Series SPB
User's Manual Hardware

FEH401 Describes system configuration, hardware specifications of
each unit, and operations of the MICREX-SX SPB Series.

MICREX-SX Series Board Controller
User's Manual

FEH423 Describes system configuration, hardware specifications,
software specifications, and operations of the Board Controller
for the MICREX-SX Series.

Notes

1. This manual may not be reproduced in whole or part in any form without prior written approval by the manufacturer.

2. The contents of this manual (including specifications) are subject to change without prior notice.

3. If you find any ambiguous or incorrect descriptions in this manual, please write them down (along with the manual No. 

    shown on the cover) and contact FUJI.



Safety Precautions

Be sure to read the "Safety Precautions" thoroughly before using the module.

Failure to follow CAUTION may lead serious result depending on the situation.
Be sure to observe each CAUTION because it describes important contents.
The following describes cautions which must be observed.

Caution : Indicates precautions where is a risk of moderate or slight personal injury or only material damage to the

 product if the product is handled incorrectly.

 Do not use parts which are found to be damaged or distorted when unpacking the unit because use of such parts may 

cause failure or malfunction.

 Do not apply shock to the product by dropping or falling, etc. because to do so may cause damage to or failure of the 

product.

 Do not bring a floppy disk close to magnetized objects because magnetism may cause failure.

 The product CD is a CD-ROM. Never reproduce it using a audio CD player.

 Large sound volume may cause damage to the ear or audio equipment.

 Perform disk check periodically. Use of damaged floppy disk or hard disk may cause failure or malfunction of created data 

and system.

 Be sure to attach and lock certainly the connector of the loader cable because failure to do so may cause malfunction.

 Do not get dust at connectors because dust may cause malfunction or failure.

 Insert the CD-ROM, loader connector, etc. into the right direction because failure to do so may cause malfunction or failure.

 Fully check safety before modifying the program during operation, performing forced output, activating or deactivating the 

equipment, or performing other operations because failure to do so may cause mis-operation resulting in damage to the 

equipment or accident.

 Do not turn off the power during loader operation (during access to hard disk or floppy disk, during communication with the 

PLC) because to do so may cause loss of data, failure or malfunction of the product, damage to the equipment, or accident.

 Use the equipment in a software operation environment described in the manual because failure to do so may cause failure 

or malfunction.

 Upgrade the software according to descriptions in the manual.

 When unplugging the loader cable or power cable, do not hold the cord because to do so may cause failure or malfunction.

 Operate the loader in a stable place where there is no risk of dropping because failure to do so may cause accident.

 When discarding this product, handle it as industrial waste.

�

�

�
�

�

�
�
�
�

�

�

�
�
�
�

Caution



Revisions

*The manual number is printed at the bottom right of the cover of this manual.

Printed on *Manual No. Revision contents

September,
2003

FEH590 First edition (Products Version 1.4.0.0)

October,
2003

FEH590a Description of new functions added according to system version up (V1.4.2.0).

January,
2004

FEH590b Description of new functions added according to system version up (V1.4.3.0).

March,
2004

FEH590c Description of new functions added according to system version up.

June,
2004

FEH590d Description of new functions added according to system version up (V2.0.1.0).
Product name changed from PLC Programmer to SX-Programmer Standard

September,
2004

FEH590e Description of new functions added according to system version up (V2.0.3.0).

February,
2005

FEH590f Description of new functions added according to system version up (V2.1.0.0):
FBD expression function of FB/user FCT
ST language editor
SPB SX-mode support

May,
2005

FEH590g Description of new functions added according to system version up (V2.1.1.0):
Procedure for creating user FBs
Program convert function

July,
2005
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Specifications for SPH2000
Instruction find function
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Specifications of arrays and structures
Convert function from a program file (M/F series)

March,
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Access level password function
Array/structure definition import function

August,
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FEH590k Considerations about the configuration check function (failure diagnosis) were added.

October,
2006

FEH590m Description of new functions added according to system version up (V2.3.0.0):
Function of exporting/importing data to/from a text file
Function of exporting device cross reference information to a text file
Function of saving system configuration in a ZIP file

November,
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Memory allocation setting for SPH2000

April,
2007
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July,
2007
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SX control utility function
Automatic analysis function of failure diagnosis
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Section 1 Overview

1-1 Special Notes

(1) There is no compatibility with SX-Programmer Expert (D300win).
Projects created by SX-Programmer Expert (D300win) can be read neither by SX-Programmer Standard (this loader) nor from
the MICREX-SX main unit. When online connection to SX_CPU created by D300win is made, an error message appears.

(2) Cautions in creating, changing or downloading a project
In the MICREX-SX series, a PLC program created by a user is called a “project”. A project consists of “system definition” and
“program (user application)” as shown in the figure below.

In the system definition, modules and the memory size of the CPU are registered, which are closely related to addresses that
are used in the program. When downloading a project, the program must match the system definition. Therefore, when
downloading a new project to the PLC, be sure to download the program and system definition at the same time and reset the
system.

Be sure to check both.

<Steps to follow in changing a project>

Note: Changing “no equipment” setting of a module in the module registration is also regarded as a change of system definition.

System definition

Program

� Module registration

� CPU memory size

� CPU running definition

etc.

� Program

� User FB (function block)

� User function

Project

Operation Step to follow

Changing both system definition
and program

Download both the system definition and program, and reset the PLC system. (Note)

Changing system definition only Download both the system definition and program, and reset the PLC system. (Note)

Changing program only Download the program, and start the PLC system.
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1-2 Basic Connection Configuration

A personal computer can be used as a program loader for the MICREX-SX Series by installing this software in it.

1-2-1 Connecting to SPH Series

2m

SX-Programmer

Dedicated loader cable

Type: NW0H-CNV (convertor)

NP4H-CB2 (cable)

Both of NW0H-CNV and NP4H-CB2 are necessary.

* Power for operation of the convertor is 

supplied from SPH_CPU.

Power consumption    5V DC: 15mA or less

Convertor

Personal computer

Using commercially available printer

MICREX-SX SPH series

* Commercially available USB cable

 Can be used only with a CPU module 

 that has a USB interface.

<List of CPU modules with a USB interface>

CPU type
USB connector type of
the CPU module

NP1PS-32R
NP1PS-74R
NP1PS-117R
NP1PS-245R

B type

NP1PM-48R
NP1PM-48E
NP1PM-256E

mini-B type
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1-2-2 Connecting to SPB Series

1-2 Basic Connection Configuration

3m

MICREX-SX SPB series / Board controller

SX-Programmer

Note: When using the SPB in SX-mode, the software version of the SPB must be V**. 10 or later.

Personal computer

Using commercially available printer

* Power for operation of the convertor is 

supplied from SPB_CPU.

Power consumption    5V DC: 15mA or less

Convertor

Dedicated loader cable

Type: NW0H-CNV (convertor)

NW0H-CA3 (cable)

Both of NW0H-CNV and NW0H-CA3 are neces-
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1-3 Installation

1-3-1 Personal Computer Operating Environment Required for this Loader

Note 1: With Windows XP, users who have no administrator’s privilege can not access any folder that requires administrator’s
privilege.  When multiple users may use a same personal computer, this loader should be installed in a folder that
can be read, written or deleted by any account other than administrator’s privilege.  If new creation, open, online
connection or other operation is still impossible, change the BDE (Borland Database Engine) environment setting.

Note 2: .NET Framework is necessary to use the “failure analysis” function supported from V2.3.3.0.
It is contained in the product CD-ROM of V2.3.3.0 or later versions.

Item Specification

Personal computer IBM-AT compatible equipment

CPU Intel Pentium 233MHz or higher is recommended.

Hard disk 200MB or more

CD-ROM drive Required at the time of installation

Memory capacity 64MB or more

Mouse
At least one of USB mouse, serial mouse, bus mouse, and PS2 mouse is
supported.

Keyboard 101 keybord

Display Resolution: 800 x 600 dots (1024 x 768 dots or more is recommended.)

Operating system

Windows 95/98/ME English Edition

Windows NT Workstation V4.0 English Edition SP6 or higher

Windows 2000 Professional English Edition

Windows XP

Other software (Note 2) .NET Framework2.0, .NET Framework1.1
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1-3 Installation

<How to change the environment setting for BDE>

Select [Control panel] from the Windows [Start] menu.  The [Control Panel] window is displayed.

In order to change the environment setting for BDE, double-click the BDE icon.  The [BDE Administrator] dialog box is
displayed.
On the tree diagram displayed on the [Environment Setting] tab window, select Drivers - Native - PARADOX, and set such
that the folder set for NET DIR can be read and deleted also by an account (User, Power User, etc.) other than
administrator’s privilege.
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1-3 Installation

1-3-2 Installation
This loader is offered in a CD-ROM which includes the installation program. When you insert the CD-ROM into the CD-ROM
drive with the personal computer turned ON, the following screen appears automatically.

When you click “SX-Programmer setup” in the above screen, installation starts. Perform the installation procedure according to
the instructions displayed in the screen.

Note 1: If [.NET Framework2.0] has not been installed in the destination personal computer, [.NET Framework2.0] is
automatically installed. (when installing the Standard loader with the product CD-ROM of V2.3.3.0 or later versions)
It takes a few minutes or sometimes more than ten minutes to install [.NET Framework2.0].
(The time required for installation depends on the performance of the personal computer used.)

Note 2: If this loader has already been installed, once uninstall and then install it. If you install it without uninstalling, it may not
operate normally.

Note 3: If the above installation screen does not appear after inserting the CD-ROM, click Start and then Run... of Windows,
enter “x:\autorun.exe” (x indicates the drive into which the CD-ROM is inserted), then click the [OK] button.
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This loader has two modes for program display: “Package displays” mode and “Individual displays” mode.

<Package displays>

2-1 Program Display Mode

<Individual displays>
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Section 2 Basic Programming Operations

2-1 Program Display Mode

2-1-1 Overview of the “Package displays” Mode
This mode displays all MICREX-SX SPH programs.  Individual programs, user FBs and user functions are created between a
program (PROG) instruction and a program-end (PEND) instruction, as shown below.  P-level, fixed-cycle interrupt and event
programs are created following a page command.

PROG P :  Default

Program

PAGE 0 : Ladder0

Program

PAGE

PEND

1 : Ladder1

Program

FBS 0 :  FB0

FBEND

PROG CO :  Fixed 5ms

Program

PAGE 2 : PROG1

PEND

Program

FCS 0 :  FCT0

FCEND

END

PROG 11 :  Event OFF

M0000000

Program

PAGE 3 : PROG2

PEND

P-level

Fixed-cycle
 interrupt

Event

User FB

Program 
command

Page 
command

Page 
command

Program 
command

Program-end 
command

User 
function

Program 
command

Program-end 
command

Program 
command

Page 
command

Program-end 
command

Program 
command

Page 
command

Program-end 
command

Program-end 
command
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Section 2 Basic Programming Operations

2-1 Program Display Mode

2-1-2 Overview of the “Individual displays” Mode
This mode displays the whole structure of a MICREX-SX SPH project as a project tree.  It also displays individual program,
user FB, and user function.

A selected program is displayed.

Project tree
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2-1 Program Display Mode

2-1-3 Display Mode Switching
You can switch between “Package displays” and “Individual display” modes to make or monitor a program.  The following
procedure is used to switch display modes.  The default setting for this loader is the “Package displays” mode.

Execute the [MICREX-SX Environment...] command in the [Options] menu.  The [Environment Options for MICREX-SX]
dialog box is displayed.

 On this dialog box, change “Ladder Display” mode and click the [OK] button.  The following dialog box is displayed.  Click
the [OK] button on the dialog box to complete the setting for “Ladder Display” mode switching.

Note: The switching of “Ladder Display” mode takes effect when the loader is restarted.
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2-1  Program Display Mode

<Comparison of the two display modes>

In these two display modes, individual object is displayed in the following manner:

Program tree in “Individual
displays” mode

Program window in
“Package displays” mode

In “Package displays” mode, default task program, fixed-cycle interrupt task program, event task program, and user FB/
user function are displayed in this order.  User FBs and user functions are displayed in their created order.
Programs are displayed in the order of their assignment to individual task, from top in order.  In “Package displays” mode,
no program is displayed unless assigned to a task.
In “Package displays” mode, programs are displayed in units of page.

PROG P :  Default

Program

PAGE 0 : Ladder0

PEND

FBS 0    :     Flicker

PROG CO :  Fixed 5ms

Program

PAGE 1 : PROG1

PEND

PEND

PROG 11 :  Event OFF

M0000000

Program

FBEND

END
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2-1 Program Display Mode

2-1-4 Switching FB/User FCT Display
Switches the display of FB and user FCT.

When you execute the [MICREX-SX Environment] in the [Options] menu, the [Environment Options for MICREX-SX] dialog
box appears.

When you check the [Display FB/User FCT call instruction in block type] box, a FBs and user a FCT in program is displayed
in FBD type (block type). You can change this setting anytime.

<Example of display in FBD type>

<Example of display in the conventional type>

Input parameter

Input parameter

Output parameter

Output parameter

Terminal name

Terminal name

Parameter address/tag

Parameter address/tag

Parameter value

Parameter value

Parameter data length + terminal No.

V: bit     

WV: word (16 bit)

DV:  

_V:  

double word (32 bit)

word/double word
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2-2 Structure of the Loader Screen

The user interface of this loader consists of a menu bar, a main tool bar, a program editing tool bar (displayed only in Edit
mode), a status bar, a program window, a project tree window (displayed only in “Individual displays” mode), and a message
window.

* It is recommended to always display the status tool bar and the main tool bar.  It is possible to hide them with the [View]
menu.

<“Package displays” mode>

Menu bar Main tool bar Program editing tool bar

Program window

Message window

Status bar
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2-2 Structure of the Loader Screen

<“Individulal display” mode>

Menu bar Main tool bar

Message window

Message window

Project tree
  window

Status bar

Program editing tool bar
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2-2-1 Main Tool Bar
The main tool bar contains the following buttons.  The main tool bar is displayed by default.  You can hide it by unchecking the
“Main Toolbar” in the [View] menu.

1) 2) 3) 4)    5)   6)     7)   8)   9) 10) 11) 12)  13) 14) 15)  16)  17) 18)

No. Name Function

1) New Opens a new offline program window.

2) Open Opens an offline program window from an existing disk file.

3) Online Displays the program of the connected PLC in the online window.

4) Save Saves the contents of the current program window in a disk file.

5) Print Prints the program and documentation information.

6) Print Preview Used to check the print image on the personal computer screen.

7) Search Searches for a reference for address or tag.

8) Jump to Line Jumps to the specified line.

9) Edit Mode Changes the editing mode in the program window.

10) Undo Cancels the last edit operation.

11) Redo Performs operation contrary to Undo.

12) Edit Tag Opens the tag editor.

13) Cut Moves the selected line to the clip board.

14) Copy Copies the selected line to the clip board.

15) Paste Inserts the line in the clip board into the program.

16) Run/Stop Starts or stops the operation of the PLC.

17) Step In Performs step-in of step operation.

18) Step Over Performs step-over of step operation.
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2-2-2 Status Bar
The following are displayed on the status bar.

1) 2)      3)        4)         5)    6)     7)       8)      9)        10)        11)

No. Name Function

1) Status Displays the explanation of the button at the current mouse cursor position.

2) Window Type Offline or Online

3)
Running/Waiting
Information

Displays the operation/wait status of the CPU monitored by redundant systems.
Running: Indicates that the CPU is operating.
Waiting: Indicates that the CPU is waiting.

4) PLC Model Displays the CPU type.

5) Connection Information

Displays the online connection information.
Direct connection: Connected with the CPU directly connected with the loader cable.
0-7: Connected with the CPU of the specified code. (The number is the CPU number.)
NW: 0-7: Connected with the CPU which is connected through the loader network.
(The number is the CPU number.)

6) Monitor/Edit Displays the monitor or edit window status.

7) Line No. Indicates the line number at the current cursor position.

8) Number of Steps Displays the (standard) number of steps of the POU currently being edited.

9) Sampling Trace Information Displays the sampling trace information.

10) Debug Information
Displays the break point setting of the PLC which is connected online.

Program: The setting of program address stop is present.
Data: The setting of data access stop is present.

11) Operating/Stopped Displays whether the connected PLC is currently operating or in a stop.
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2-2 Structure of the Loader Screen

2-2-3 Program Editing Tool Bar
The following buttons and tab windows are prepared for the program editing tool bar.

 <“Package displays” mode>

<“Individual displays” mode>

3)
4) 7)

10)1)

2)

5)

8)
9)

6) 11) 13)

12) Instruction group selection tabs

12) Instruction group selection tabs

13)

1)

2)

5) 6) 11)

3)
4)

9) 10)

No. Name Function

1) Insert Line Inserts a line above the line at which the cursor is currently positioned.

2)
Insert Line below the
cursor position

Inserts a line below the line at which the cursor is currently positioned.

3) Insert/Modify Line Commen Creates or changes a line comment for the line at which the cursor is currently positioned.

4)
Display Line as Instruction
List

Changes over the display mode (ladder display mode or list display mode) of the line at
which the cursor is currently positioned.

5) Draw Line
When this button is set ON, Draw Line mode is activated. For more information about how to
draw lines, refer to "2-3-3 Basic circuit editing operations".

6) Erase Line
When this button is set ON, Erase Line mode is activated. For more information about how
to erase lines, refer to "2-3-3 Basic circuit editing operations".

7) Append Task (PROG) Inserts a task at the current cursor position.

8) Insert Program (Page) Inserts a program at the current cursor position.

9) Insert Return
Inserts a return. For more information about how to enter a return, refer to "2-3-3 Basic circuit
editing operations".

10) Delete Line Deletes a line at which the cursor is currently positioned.

11) Download changes to PLC
Downloads a line, which was changed while PLC program was running, to the PLC while it is
running.

12)
Instruction group selection
tabs

Changes over instruction groups for MICREX-SX series.

13) Select Instruction Select an instruction to be written.
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2-2 Structure of the Loader Screen

2-2-4 Project Tree Window
In “Individual displays” mode, a whole project (project tree) is displayed.

Programs assigned  to tasks

Program
name

Program
No.

<Program Sort function>
This function sorts the programs existing on a project tree by “program name” or “program No.”

<Procedure for sorting>
Right-click the “Programs” folder on the project tree, and execute [Program Name] or [Program Number] command in the
[Program Sort...] pop-up menu.

* For both Program Name and Program Number, programs are sorted in ascending order. When Program Name is specified,
programs are sorted by comparing their names, independent of their kind.  On the other hand, when Program Number is
specified, program kinds are sorted first in the order of programs, function blocks and functions, and then programs are
sorted by program number in individual kind.

* Programs that are hidden by program protection become the target of sort.
* To open a project, “sort by program name” or “sort by program number” can be specified by [MICREX-SX Environment...].

For more information of the setting method, refer to “3-6 Options Menu”.

User FB

User function

Program

Project name

System definition

Task



2-13

Section 2 Basic Programming Operations

2-3 Editing a Project

2-3-1 Package Displays Mode
(1) Opening the program edit window
There are 3 categories of project editing, namely
1) Create a new project
2) Edit an existing project
3) Load a project from PLC and edit it

1) Creating a new project

Execute [New...] command in the [File] menu.  The [Template selection] dialog box is displayed.

 [Display menu] button

[Temperate operation] button

 On the [Temperate selection] dialog box, select a CPU you want to use, and click the [OK] button.  A program edit screen is
displayed, as shown below.  On the opened project, one program (page number: 0, program name: Ladder0) is prepared
for the default task (PROG P), so that you can immediately start creating a program.  In addition to the default task, a fixed-
cycle interrupt task (PROG C0 (5-ms intervals)) and an event task (PROG I1 (event startup memory: M0)) are prepared.

Default program

Fixed-cycle interrupt program

Event program
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2) Editing an existing project

 Execute [Open...] command in the [File] menu. The [Open Ladder File] dialog box is displayed.

Select a project file (*.spj) or a zipped project file (*.zpj) that you want to edit, and click the [Open] button.  Projects are
displayed from the top one in order.
Then, execute [Edit Mode] command in the [Edit] menu.  Program Edit mode is activated.

3) Loading a project from PLC to edit it

After checking connection between the PLC and this loader, execute [Online...] command in the [File] menu. The [Select CPU
Type] dialog box is displayed.

After setting up the connected CPU, click the [OK] button.  Projects stored in the CPU are loaded to display the programs,
from the top one in order.  The loader is in Edit mode.
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2-3 Editing a Project

(2) Adding/changing/deleting a program
1) Adding a program (page)

Select a position at which you want to add a program, and execute [Insert Program] command in the [Edit] menu. The
[Insert] dialog box is displayed.

Program name (max. 16 single-byte characters)

Set program name, program number, language type, parameters, etc., and click the [OK] button.  A page is inserted above
the selected position.

Note: If it is attempted to insert a program at a position
where no program can be inserted, the following
alarm message is displayed.
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2) Changing a program (page)

Double-click an arbitrary point on the page.  The [Properties] dialog box is displayed.

Double-click here.

After setting all necessary items, click the [OK] button.  The setting of the page is changed.

3) Deleting a program (page)

Select an arbitrary point on the page, and execute [Delete Line] command in the [Edit] menu.  The following confirmation
dialog box is displayed.

Click the [OK] button.  All lines existing on the page are deleted.

Note: No program can be deleted with the <Delete> key.
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(3) Cutting/copying/pasting a program
It is possible to execute cut, copy and paste in units of program (page).  For this,

 Select the PAGE instruction part of a program you want to cut or copy, and execute [Cut] or [Copy] command in the [Edit]
menu or in the right-click pop-up menu.

Cursor

 Select a point at which you want to paste the program, and execute [Paste] command in the [Edit] menu or in the right-click
pop-up menu.  The whole program is pasted.
When copying, the smallest one of unused program numbers is automatically assigned to the program number of PAGE
instruction, and the source program name added by “_1” (the value means the number of paste operations) is given as the
program name, as shown in the figure below.

Program number (page number)

Destination program for copy

Program nameSource program for copy

Program number (page number)

Program name
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(4) Program number usage condition
A program number is set for each program. Be careful not to set a same program number for different programs of same kind.

Click the [Program No. Usage...] button on the [Insert] dialog box, which is displayed when adding a program, or on the
[Properties] dialog box, which is displayed when changing a program.  The [Program No. Usage] dialog box is displayed,
on which you can confirm the currently used program numbers.

Changes over program kinds

(5) Protection of program
You can protect specific programs by setting passwords.  For protected programs, you can also set whether they are to be
displayed on the project tree or to be hidden from it.
For protected programs, the following operations are disabled:

Open
Delete, Cut, Copy and Paste
Initial Data List
Timer & Counter Setting...
Documentation
Tag Editor...
Program Printing
Import Programs...
Global Find/Replace...
Device Usage...
Device Cross Reference...

It is also impossible to edit the program properties dialog box.

X : Used
: Not used
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Check the [Protected] box, and click the [OK] button.

Then, execute [Protection Programs...] command in the [File] menu.  The [Set Password(Protection Programs)] dialog box is
displayed.  When there is no protection specified program, [Protection Programs...] command is disabled.

 Set a password and click the [OK] button.  The protection specified program comes in “Protected” mode.  The program is
not displayed.

Protected program

<How to cancel protection>

Execute [Protection Programs...] command in the [File] menu.  The [Password Enter] dialog box is displayed.

Enter the set password, and click the [OK] button.  Protection of the program is canceled.

<How to set protection>

In edit mode, select the PAGE instruction part of a program you want to protect, and execute [Properties] command in the
[Edit] menu. The [Properties] dialog box for that program is displayed.

Earlier than V2.3.2.0 : Maximum 8 characters (0 to 9, A to F) can be set.
V2.3.2.0 or later : Maximum 20 characters (0 to 9, A to F) can be set.

Note: If a project with a password of 9 characters or more is read
with the loader version earlier than V2.3.2.0 and downloaded to
the CPU again, the password is overwritten with another one.
Projects with a password of 9 characters or more must be used
with V2.3.2.0 or later version of the loader.
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(6) Copying/pasting a system definition
It is possible to copy system definition between opened program files.

Open the source and destination programs for copy, and with the source project activated, execute [Copy System Definition]
command in the [PLC functions] menu.

Source program for copy

Then, with the target project for copy activated, execute [Paste System Definition] command in the [PLC functions] menu.

Target progran for copy

A warning dialog box is displayed, as shown below.  Click the [OK] button.  The setting window for the pasted system
definition is displayed, on which you can confirm or change the content of the setting.

Note: When the PLC model is different, the following window
is displayed. If you paste the system definition, the CPU
memory size definitions are initialized.
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(7) Adding/changing/deleting a task (PROG)
1) Adding a task

Select a position (PROG instruction of existing task) at which you want to insert a task (PROG), and execute [Insert Task]
command in the [Edit] menu.  The [Insert] dialog box is displayed.

Note: Only “Insert” mode is available when in
“Package displays” mode.

Enter task name, task type and other setting items.  After setting all necessary items, click the [OK] button.  The task is
inserted above the current cursor position.

Added task

Create a program by inserting a program (PAGE instruction) between PROG and PEND instructions.

2) Changing a task

Double-click the task (PROG instruction part) you want to change.  The [Properties] dialog box for that task is displayed.

After changing the content of the setting, click the [OK] button.  The setting of the task is changed.

3) Deleting a task

Select the task (PROG instruction part), and execute [Delete Line] command in the [Edit] menu or in the right-click pop-up
menu.  The following confirmation dialog box is displayed.

Click the [OK] button.  The task and the programs included in it are all deleted.
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2-3-2 Individual Displays Mode
(1) Opening the program edit window
There are 3 categories of project editing, namely
1) Create a new project
2) Edit an existing project
3) Load a project from PLC and edit it

1) Creating a new project

Execute [New...] command in the [File] menu.  The [Template selection] dialog box is displayed.

[Display menu] button

[Temperate operation] button

On the [Temperate selection] dialog box, select a CPU you want to use, and click the [OK] button.  A project tree window is
displayed.
Double-click a program icon on the project tree.  The program is displayed in the program window.
Click [Edit Mode] command in the [Edit] menu.  Edit mode is activated.

* A program (program name: Ladder0, program No.: 0) is prepared in the project tree.
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2) Editing an existing project

Execute [Open...] command in the [File] menu.  The [Open Ladder File] dialog box is displayed.

Select a project file (*.spj) or a zipped project file (*.zpj) that you want to edit, and click the [Open] button.  A project tree is
displayed.
Double-click the icon for the program you want to edit.  The program is displayed in the program window.
Then, execute [Edit Mode] command in the [Edit] menu to activate program edit mode.

3) Loading a project from PLC to edit it

After checking connection between the PLC and this loader, execute [Online...] command in the [File] menu. The [Select
CPU Type] dialog box is displayed.

After setting up the connected CPU, click the [OK] button.  A project tree is displayed.
Double-click the icon for the program you want to edit.  The program is displayed in the program window.
Then, execute [Edit Mode] command in the [Edit] menu to activate program edit mode.
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(2) Adding/changing/deleting a program
1) Adding a program

Select the program at the position where you want to add a program, and click the <Insert> key.  The [Insert] dialog box is
displayed.

Program name (max. 16 single-byte characters)

Set program name, program number, language type, parameters, etc, and click the [OK] button. The program is added to
the project tree, as shown in the figure below.  When “Insert” mode is active, the program is added above the current cursor
position; when “Append” mode is active, the program is added below the current cursor position.

2) Changing a program

You can change the program setting that is defined in the program configuration.  For this,
On the project window, right-click the program, the setting of which you want to change, and execute [Properties...]
command in the displayed pop-up menu.  The [Properties] dialog box for that program is displayed.

Change the setting items as you desire, and click the [OK] button.  The setting of the program is changed.
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3) Deleting a program

To delete a program from a project tree,

Select the program you want to delete, and press the <Delete> key.  The following confirmation dialog box is displayed.

Click the [Yes] button.  The program is deleted from the project tree.  All programs included in the program are deleted.

(3) Cutting/copying/pasting a program
It is possible to execute cut, copy and paste in units of program on a project tree.  For this,

Right-click the program you want to cut or copy, and execute [Cut] or [Copy] command in the displayed pop-up menu.

Right-click a point at which you want to paste the program, and execute [Paste] command in the displayed pop-up menu.
The program is pasted below the current cursor position.
When copying, the smallest one of unused program numbers is automatically assigned to the program number of PAGE
instruction, and the source program name added by “_1” (the value means the number of paste operations) is given as
the program name, as shown in the figure below.

Pasted program
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(4) Program number usage condition
A program number is set for each program.  Be careful not to set a same program number for different programs of same kind.

Click the [Program No. Usage...] button on the [Insert] dialog box, which is displayed when adding a program, or on the
[Properties] dialog box, which is displayed when changing a program.  The [Program No. Usage] dialog box is displayed,
on which you can confirm the currently used program numbers.

Changes over program kinds

X : Used
: Not used

(5) Protection of program
You can protect specific programs by setting passwords.  For protected programs, you can also set whether they are to be
displayed on the project tree or to be hidden from it.
For protected programs, “Open”, “Delete”, “Cut”, “Copy”, “Paste”, “Initial Data List”, “Timer & Counter Setting...”,
“Documentation”, “Tag Editor...”, “Program Printing”, “Import Programs...”, “Global Find/Replace...”, “Device Usage...” and
“Device Cross Reference...” operations are disabled.  It is also impossible to edit the program properties dialog box.

<How to set protection>

Select the PAGE instruction part of a program you want to protect, and execute [Properties] command in the [Edit] menu.
The [Properties] dialog box for that program is displayed.

Check the [Protected] box, and click the [OK] button. Check the [Protected] box, and click the [OK] button.
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Then, execute [Protection Programs...] command in the [File] menu.  The [Set Password(Protection Programs)] dialog box is
displayed.  When there is no protection specified program, [Protection Programs...] command is disabled.

Set a password and click the [OK] button.  The protection specified program comes in “Protected” mode.  On the program
windows, it is indicated as follows:

To hide protected programs from a project tree, execute [MICREX-SX Environment...] command in the [Options] menu, check
the [Protected Program is not displayed in the program organization] box on the [Project Tree] tab window of the [Environment
Options for MICREX-SX] dialog box, and click the [OK] button.

Earlier than V2.3.2.0 : Maximum 8 characters (0 to 9, A to F) can be set.
V2.3.2.0 or later : Maximum 20 characters (0 to 9, A to F) can be set.

Note: If a project with a password of 9 characters or more is read
with the loader version earlier than V2.3.2.0 and downloaded to
the CPU again, the password is overwritten with another one.
Projects with a password of 9 characters or more must be used
with V2.3.2.0 or later version of the loader.
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<How to cancel protection>

Execute [Protection programs...] command in the [File] menu.  The [Password Enter] dialog box is displayed.

Enter the set password, and click the [OK] button.  Protection of the program is canceled.

(6) Copying/pasting a system definition
It is possible to copy system definition between opened program files.

Open the source and destination programs for copy, right-click the [System Definition] icon for the source program, and
execute [Copy] command in the displayed pop-up menu.

Destination program for copy

Source program for copy

 Right-click the [System Definition] icon for the destination program, and execute [Paste] command in the displayed pop-up
menu.
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(7) Adding/changing/deleting a task (PROG)
1) Adding a task

 Select a position at which you want to insert a task (PROG), and execute [Insert Task] command in the [Edit] menu.  The
[Insert] dialog box is displayed.

Select “Task [PROG]” for “Kind”, and enter task name, task type and Task Setting items.  After setting all necessary items,
click the [OK] button.  The following confirmation dialog box is displayed.  Click the [OK] on this dialog box.  When “Insert”
mode is active, a task is added above the selected task; when “Append” mode is active, a task is added below the current
task position.

Added task
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2) Changing a task

Right-click the task you want to change, and execute [Properties...] command in the displayed pop-up menu. The [Properties]
dialog box for that task is displayed.

After changing the content of the setting, click the [OK] button.  The setting of the task is changed.

3) Deleting a task

Select a task and press the <Delete> key.  The following confirmation dialog box is displayed.

Task to be deleted

Click the [OK] button.  The task is deleted.
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(8) Assigning a program to a task and canceling/changing the assignment
1) Assigning a program

Right-click a task on a project tree or an already defined task, and execute [Insert...] command in the displayed pop-up menu.
The [Insert] dialog box is displayed.

Select “Program” for “Kind”.  The window display changes as follows:

 Select a program that is to be assigned to the task, and click the [OK] button.  The program is assigned to the task.  When
“Insert” mode is active, the program is added above the current cursor position; when “Append” mode is active, the program
is added below the current cursor position.
It is impossible to add a program, which is already registered to a task, to the same or other task.
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2) Canceling the assignment of program to a task

To delete a program that is assigned to a task,

 Select the program you want to delete, and press the <Delete> key.  The confirmation dialog box is displayed.  Click the [Yes]
button on this dialog box to cancel the program assignment to the task.

3) Changing the destination task for program assignment

You can change the destination task for program assignment by cutting the program assigned to a task and pasting it to your
desired task.

 Right-click the object program, and execute [Cut] command in the displayed pop-up menu.

Then, select the icon for the destination task for program assignment or a program assigned to the task, and execute
[Paste] command in the right-click pop-up menu.  The program is assigned to the task.
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2-3-3 Basic Line Edit Operations
(1) Inserting a line

When program display mode is active, execute [Edit Mode] command in the [Edit] menu.  Program edit mode is activated.
To create a program, insert a line for one row with [Insert Line] command.  You can start building a circuit with the inserted
line.
When you want to insert a line above the current cursor position, execute [Insert Line] command in the [Edit] menu; when
you want to insert a line below the current cursor position, execute [Insert Line below the cursor position] command in the
[Edit] menu.  When [Insert Line] command is executed, a line space for one row is prepared on the window, and E’s are
marked on the left and right power rails.  E’s mean that the line is currently edited.

<Example of inserting a line in Package displays mode>

Edit cursor

Space for one row
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(2) Entering an instruction
Select an instruction you want to enter from the ladder editing tool bar, and click a point on the window at which you want to
insert the instruction.

<Example of entering an instruction>

Select an instruction by clicking the corresponding button on the ladder editing tool bar.

Click

Position to insert the instruction

Then, click a point on the window at which you want to insert the instruction.  The [Address Entry] dialog box is displayed.

Enter an address, and click the [OK] button.  The [Tag Entry] dialog box is displayed.  Enter a comment (Tag) for the address,
and click the [OK] button.  The instruction is input.

* Tag is not a mandatory item to enter.

Input instruction
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To erase a line, click the [Erase Line] button, then drag the mouse while holding down the left mouse button on the line to be
deleted.

<Drawing a line with keyboard>

To draw a line, press the <  >, <  >, <  > or <  > key together with the <Ctrl> key.
To erase a line, press the <  >, <  >, <  > or <  > key together with the <Ctrl> and <Alt> keys.
When you press the  <  > key together with the <Ctrl> key beyond the currently edited line, a new line is inserted and extended
vertically but cannot be connected to the lower line.
To merge the currently edited line with the lower line existing below the current cursor position and edit them as one line,
execute [Merge with next Line] command in the [Edit] menu.

2-3 Editing a Project

(3) Drawing/erasing a line
To create parallel contact lines, etc., the line draw function is used.  To draw or erase a line, the [Draw Line] or [Erase Line]
button prepared on the ladder editing tool bar is used.

Draw Line Erase Line

When you set ON the [Draw Line] button by clicking it, Line Draw mode is activated.  When the [Erase Line] button is clicked
in this mode, the [Draw Line] button is set OFF and instead the [Erase Line] button is set ON, and Line Erase mode is
activated.
In Line Draw mode, you can draw a line in units of cursor by dragging the mouse while holding down the left mouse button.

<Line drawing pattern>

To the right To the left

Upward
Downward
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(4) Changing the content of an instruction
You can rewrite the address or tag of already input instruction.  For this,

 Double-click the instruction, the content of which you want to change.  The [Address Entry] dialog box is displayed.

Note: The content of the displayed [Address Entry] dialog box
depends on the instruction selected.

 When you want to change the address, enter your desired address.
Then click the [OK] button.  The [Tag Entry] dialog box is displayed.

* Tag is not a mandatory item to enter.

 Change the tag as needed, and click the [OK] button to complete changing the content of the instruction.

(5) Inserting an instruction
This loader has no special command to insert an instruction.  To insert an instruction, first prepare a space for inserting an
instruction by inserting/deleting a row and inserting/deleting a column, and then enter an instruction.
Be careful that if an instruction is entered without preparing a space for inserting it, existing instruction is overwritten and
therefore deleted.  If deleted, re-execute the editing operation, using [Undo] command in the [Edit] menu.

(6) Deleting an instruction
Move the cursor on the instruction you want to delete, and press the <Delete> key.  The instruction is deleted.
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(7) Inserting/deleting a row
 Select a position at which you want to insert a row, and execute [Insert Row] command in the right-click pop-up menu.  A new
row is inserted below the current cursor position.

(8) Inserting/deleting a column
 Select a position at which you want to insert a column, and execute [Insert Column] command in the right-click pop-up menu.
A new column is inserted to the right of the current cursor position.
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* Without executing [Merge with next Line] command in the [Edit] menu, you can merge the lines.  For this, draw a line by
dragging the mouse while holding down the <Ctrl> key or pressing the <  > or <  > key together with the <Ctrl> and <Shift>
keys.

(10) Splitting a line
There is no special command to split a line into two independent lines.  Delete all vertical lines and, when two lines look to be
independent of each other, move the cursor to the other line.  They are split automatically.

2-3 Editing a Project

(9) Merging lines
 To merge the line at the current cursor position with the lower line, use [Merge with next Line] command in the [Edit] menu.
Move the cursor to a position at which the two lines are to be merged, and execute [Merge with next Line] command in the
[Edit] menu.

Then, press the <  > key together with the <Ctrl> key to merge the lines.
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(11) Entering a return
If a line cannot be displayed by a single row, for example, due to 12 or more contacts connected in series, the return mark is
used to display the whole line.

 By clicking [Returning] button, a return mark is entered.

<When there is no output command>

<When there is an output command>

* If you execute [Insert Line] in the right-click menu when the cursor is placed at the end of a line, a return mark is automatically
inserted.

Note: The return mark may not be displayed depending on the line form or operating procedure.  But the line will be displayed
correctly when you move the cursor out of the line and line conversion is completed.
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(12) Line conversion
This loader has no special command to convert the edited ladder diagram.  After editing, when you move the cursor to other
circuit by operating the keyboard or the mouse, the line on which the cursor was positioned just before is automatically
converted into an instruction word (mnemonic).

If the line cannot be converted into instruction word (mnemonic) due to disconnection or wrong ladder diagram, the cursor
cannot be moved out of the currently edited line.

(13) Selecting lines
Part of the line or the whole line can be selected using the mouse or the keyboard.

1) Using the mouse

 By dragging the edit cursor from the upper left corner to the lower right corner of part of the line that you want to select, the
area is selected. The area that has been selected is displayed in yellow (default color).

2) Using the keyboard

 By pressing the cursor key together with the <Shift> + <Alt> keys, the line is partly selected.
When you want to select the whole line, press the cursor key together with the <Shift> key.

Drag the edit cursor from the upper left to the lower right to select the range.

When you drag the cursor to the next line, the whole line is selected.
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(14) Cutting and pasting in units of line
Selected line can be moved with the Cut & Paste functions.

In Edit mode, [Cut], [Copy] and [Paste] commands in the [Edit] menu can be used.  It is possible to execute these commands
by using Windows standard shortcut keys (<Ctrl>+<X>, <Ctrl>+<C> and <Ctrl>+<V>) or the Speed button on the main tool bar.
Cut and paste are performed in units of line.  When you want to cut and paste part of a line, refer to the paragraph for cutting
and pasting part of a line as a rectangular area.  To cut or copy a ladder, it is necessary to select lines or a line group first.

When Cut or Copy command is executed, the selected lines are copied to the clip board.  When Cut command is executed, the
selected lines are deleted from the program.

Paste command is enabled only when one or more lines are present in the clip board.  These lines are pasted in front of the
current cursor position.  If multiple lines are selected when Paste command is executed, these lines are deleted and then the
lines existing in the clip board are inserted.

(15) Entering instructions by guidance
In programming, instructions can be described using “Guidance”.

 Set ON the [Instruction Entry by Guidance] button, and click a point at which you want to enter an instruction.  The [Instruction
Enter] dialog box is displayed.



2-42

Section 2 Basic Programming Operations

2-3 Editing a Project

 On this dialog box, select (click) a category.  The instructions prepared for the selected category are displayed in the
“Instruction List” box.  From the instruction list, select one you want to enter.  The selected instruction is displayed in the
“Instruction” text box.

After selecting an instruction, click the [OK] button.  Instruction entry mode is activated.  Depending on the instruction
selected, the device entry dialog box or the parameter entry dialog box is displayed.

* In addition, the “Guidance” window of word instructions can also be displayed by using the following procedure.

 Click the [Word Instructions] tab of the instruction group selection tabs. The buttons of the word instruction group are
displayed.
 Select (click) a program group button and then click the position where you want to insert the instruction. The [Instruction
Enter] dialog box is displayed.

The clicked word instruction
group is selected.
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(16) Parameter setting of FB/user FCT displayed in FBD type
Double-click the top part of a FB/user FCT for parameter setting. The [Address Entry] dialog box appears.
 Set all necessary items and then click the [OK] button. The [Parameter Entry] dialog box appears. On this dialog, addresses
and tags of the parameter can be edited.

You can display the [Parameter input] dialog box by clicking any part of
the FBD. (not necessarily require to click the top part of the FBD)
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(17) Displaying a program in user FB/user FCT
When a program is edited, a program in the user FB/user FCT can be displayed from the calling part (FBD part) of the user FB/
user FCT.

Right-click the top part of a user FB/user FCT and execute the [Open] command in the menu. The program of the user FB/
user FCT is displayed.

* You can also display it by double-clicking the top part of the user FB/user FCT while pressing down the <Ctrl> key or by
pressing <Ctrl> + <Shift> + <Enter> with the top part of the user FB/user FCT selected.

Top part  when displayed in conventional type

<Program of user FB/user FCT>

Top part  when displayed in FBD type
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2-3-4 Saving a Project
Edited project can be saved in a file.
It is saved in an SX project file (*.spj) or in an SX zipped project file (*.zpj).

Execute [Save] command in the [File] menu.
If the project was created newly and has not yet saved, the [Save As] dialog box is displayed.
Set the items “Save in”, “File name” and “Save as type”, and click the [Save] button.  The project is saved.

* When communication with PLC is enabled (online), PLC internal data can be saved in a text file.  For more information, refer
to “3-1-5 File Menu - Save”.

Note: An SX project file (*.spj) consists of multiple files.  When you save an edited project in a medium, such as a floppy disk,
save it in an SX zipped project file (*.zpj), in which files are zipped and saved as one file.  Do not use commercially
available zipping tool.
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2-3-5 Loading a Project
There are two methods for loading a project to a PLC: the one to load a loader internal project and the other to load a project
saved in a file.

Connect the loader to the PLC, and execute [Load] command in the [File] menu.  The [Load] dialog box is displayed.

* When “Set CPU No. and path when loading” is selected from the [Function Setting] tab window
of the [Environment Options for MICREX-SX] dialog box under the [Options] menu, the [Select CPU
Type] dialog box is displayed. Set a CPU to be connected and the path, and click the [OK] button.
The [Load] dialog box is displayed.

Note: When communication with PLC is disabled, the following message is displayed.
If displayed, check the cable connection and communication setting.
For more information of communication setting, refer to “3-6-4 Options Menu - MICREX-SX Communications”.

For “Load Data”, either “Loader” or “File” is selected.  When “Loader” is selected, the currently opened project becomes the
source project for loading.  When multiple files are opened, the currently active project becomes the source project for
loading.
When “File” is selected, the [Browse] button is enabled.  Click the [Browse] button to display the [Download file to PLC]
dialog box.  Select a project and click the [Open] button to determine the project to be downloaded.

*
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After selecting the source project and the data to be downloaded, click the [OK] button.  The download confirmation dialog
box is displayed.  Click the [Yes] button to start download.

Source project

Data to be downloaded

If the PLC is running, the warning dialog box is displayed.  When the [Yes] button is clicked, the PLC stops running, and
download is started.

When download is complete, the following dialog box is displayed.  Click the [OK] button to complete the download operation.
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2-3-6 Monitoring a Project
(1) Monitoring the program after a program is downloaded
After a program is downloaded, the program window always displays the newest status when online.  Contacts and coils are
displayed in red when they are conducting.

* You can check online/offline on the status bar.
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(2) Monitoring a PLC internal project
You can monitor a PLC internal project by loading it.

Connect the loader with the PLC, and execute [Online...] command in the [File] menu.  The [Select CPU Type] dialog box is
displayed.

Select a CPU to be connected, and click the [OK] button.  PLC internal projects are downloaded to this loader.

* In “Package displays” mode, the loader is ready for monitoring.  In “Individual displays” mode, program can be monitored
when it is displayed on the program window.



2-50

Section 2 Basic Programming Operations

2-3 Editing a Project

(3) Monitoring the data
The program window contains the ladder display page and the data display page, which can be changed over by clicking the
tabs displayed at the bottom of the program window.  When data is displayed, the data editing tool bar is displayed on the top
of the page.  You can display the content of arbitrary memory by editing the data page.

Data is displayed in one of the following types:
Bit
2-byte ASCII
8-byte ASCII
16-byte ASCII
Binary float
16-bit signed integer multi format
16-bit unsigned integer multi format
32-bit signed integer multi format
32-bit unsigned integer multi format
Time
Date and time
Date
Duration

When multi format display is selected, the bit, decimal, hexadecimal and ASCII formats are displayed together in one line.



2-51

Section 2 Basic Programming Operations

2-3 Editing a Project

<Displaying and editing data>

The following entry boxes and buttons are prepared on the data editing tool bar.

Data display section

1)            2)                      3)     4)  5)   6)  7)    8)  9) 10)   11)

No. Name Function

1) Address/tag entry box Enters memory address or tag name for display

2) Data type entry box Specifies data type for display

3) Entry button
When an address or a tag is entered in the address/tag entry box and this
button is clicked, the content of specified memory is displayed at the current
cursor position.

4) Data continuous display button Displays data continuously from the current cursor position.

5) Next button Displays the next address of the device at the current cursor position.

6) Displayed data delete button Deletes the data displayed at the current cursor position.

7) Displayed data all delete Deletes all the data displayed in the data display window.

8) Forcible setting button Forcibly sets data in the I/O memory.

9) Forcible setting cancel button Cancels the forcible setting of the device at the current cursor position.

10) Forcible setting all cancel button Cancels the forcible setting of all devices.

11) Displayed data setting save button Saves the status of currently displayed devices in a file.
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(1) Basic procedure
Add a program for a user FB. Right-click the [Program configuration] icon or an existing program on the project tree and
execute the [Insert] command from the popup menu to display the [Insert] dialog.
Set Kind to Function Block and enter the user FB name and program No.

Select Function Block.

Next, set the user FB parameters. Click the [Parameter Setting...] button to display the [User Function Block Parameter
Setting] dialog. After setting the necessary items, click the [OK] button.

Set parameters used
for the user FB.

Set work memory used
inside the user FB.

Set the number of FBs, if any,
used in the user FB.

Note: Setting must be made so that the total
word count becomes an even number.

When a fucntions is used in
the user FB, if the function
uses the ENO flag, set this
checkbox to ON.

* To assign an array or structure to the parameter, assign the desired parameter to the “top address” on the [Array/Structure
Declaration] window after setting the parameter.

Enter the user FB name.

Set the program No.
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Create a program in the user FB.

<FB operations>

Specify the flicker ON/OFF pulse time to input parameter “DV0001”. The flicker signal is output to output parameter “V0002”.

Timer FB used inside the user FB

set_time (DV0001) set_time (DV0001)

out (V0002)
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(2) Insert parameters
Use the following procedure to insert each parameter (terminal) of a user FB.

Click the the [Add] button on the [User Function Block Parameter Setting] dialog to display the [Parameter] dialog.

After setting each item, click the [OK] button. The parameter is set in the FB.

Item Description

Parameter No. User can specify a desired value. By default, the highest unassigned number is displayed.
The setting range is 1 to 256. In the same FB, duplicate FB parameter Nos. are not allowed.

Parameter Name A parameter name can be up to 32 characters long.
In the same FB, duplicate parameter names are not allowed. In addition, if "Allow duplicate Tags" in
the [Environment Options for MICREX-SX] is set to OFF, a parameter name duplicating with a tag
in another program cannot be used. (Also, a parameter name duplicating with a local device of a
timer or counter cannot be used.)

Input/Output Select Input, Output or Inut/Output for the parameter.

Data Length Set the data length of the parameter.
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(3) Reading user FB
This paragraph explains how to use the FB in the “program” of the project where the FB was created.

After clicking the “Call/Others” button, click the user FB insertion position to display the [Instruction Enter] dialog.

Click here.

On the [Instruction Enter] dialog, select “USERFB” and click the [OK] button. The following dialog is displayed. On this dialog,
select the FB to be used, specify its instance No., and then click the [OK] button.

The [Parameter Entry] dialog box is displayed. Enter necessary parameters such as the device and constant and click the
[OK] button.
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As shown in the figure below, the user FB is displayed.

<Displayed in block type>

<Displayed in ladder type>

(4) Using user FB created in another project
This paragraph explains the how to use a user FB created in another project.

Execute the [Import Programs...] command in the [File] menu to display the [Import Programs] dialog.
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Click the [Browse...] button and select the project from which a user FB is imported.

Check the box for the program
(user FB) to be imported.

After selecting the program to be imported, click the [OK] button to display the confirmation dialog shown below. Click the
[OK] button to import the selected program.

* The user FB imported can be used in the same procedure as that described in (3).
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(1) Editing ladders

(2) Editing instruction word list

(3) Cut & paste

(4) Changing/moving display

Select instruction group Alphabet key of Group tab, <C> key for "Common (C)"

Enter instruction Function key assigned to each instruction

Undo <Ctrl>+<Z> key

Redo <Ctrl>+<Y> key

Insert Line (Above) <Ctrl>+<I> key

Insert Line (Below) <Ctrl>+<Alt>+<I> key

Draw Line <Ctrl>+<arrow> key

Delete Line <Ctrl>+<Alt>+<arrow> key

Insert Row <Alt>+<Insert> key

Delete Row <Alt>+<Delete> key

Insert Column <Ctrl>+<Insert> key

Delete Column <Ctrl>+<Delete> key

Select rectangular area <Shift>+<Alt>+<arrow> key

Select Line <Shift>+<arrow> key

Global Search <Ctrl>+<U> key

Global Change <Ctrl>+<R> key

Device Cross Reference <Ctrl>+<B> key

Device Cross Reference
<Shift>+<Ctrl>+<B> key
* Indicating to the result, not Indicating to the address input dialog box.

Tags Editor <Ctrl>+<T> key

Insert Row <Alt>+<Insert> key

Delete Row <Alt>+<Delete> key

Select Row <Shift>+<arrow> key

Cut <Ctrl>+<X> key

Copy <Ctrl>+<C> key

Paste <Ctrl>+<V> key

Change File (Ladder)/Data tag <Ctrl>+<PageUp> key/<Ctrl>+<PageDown> key

To Left End of Row <Home> key

To Right End of Row <End> key

Page unit scroll <PageUp> key/<PageDown> key

Monitor instance <Ctrl>+<Alt>+<F> key
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New <Ctrl>+<N> key

Open <Ctrl>+<O> key

Save <Ctrl>+<S> key

Exit <Alt>+<X> key

Print <Ctrl>+<P> key

Edit Mode <Ctrl>+<E> key

Transfer Changed Line to the PLC <Ctrl>+<D> key

Search <Ctrl>+<F> key

Replace <Ctrl>+<H> key

Search Next <Ctrl>+<L> key

Jump to Specified Line <Ctrl>+<G> key

Default Display <Ctrl>+<M> key

Decimal Display <Ctrl>+<K> key

Hexadecimal Display <Ctrl>+<J> key
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This chapter explains all the functions that can be used from the main menu shown below.

� File menu ............................. File processing commands
� Edit menu ............................. Ladder editing functions
� Search menu ........................ Search functions
� PLC Functions menu ........... PLC-specific functions
� Auxiliary menu ...................... Auxiliary functions
� Options menu ...................... Loader setup options
� View menu ............................ Program window display mode setting functions
� Window menu ...................... Window display options
� Help menu ............................ Help functions and program information

The File menu offer the following commands:

� New ....................................... Opens a new project file.
� Open ..................................... Opens an existing project file.
� ReOpen ................................ Re-opens a program file once closed.
� Online ................................... Displays a program of the connected PLC in the online window.
� Save ...................................... Saves the contents of the current program window in a disk file.
� Load ...................................... Loads a specified program file to the PLC.
� Save As ................................. Saves the contents of the current program window under a specified file name.
� Verify ...................................... Compares the contents of the current program window with the contents of the project file.
� Save As ................................. TemplateSaves the created project as a template.
� Import Programs .................. Imports a specified program from other project.
� Protection Programs ............ Protects the program(s) (disables “open,” “delete,” “copy,” “change setting” and other

operations)
* For operating method, refer to “2-3 Editing a Project.”
� Read Only ............................. Sets a password for the project and write-protects it.
� Page Setup ........................... Sets up the page format for printing.
� Print ....................................... Prints the program and documentation information.
� Print Preview......................... Displays the print image in the screen.
� Exit ........................................ Terminates the loader.
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3-1-1 File Menu - New
This command opens a new file.

� Execute [New...] command in the [File] menu. The [Template selection] dialog box is displayed.

[Template operation ] button

[Display menu] button

� Select CPU type you want to use and click the [OK] button to edit a new project.

<Display mode changeover for the [Template selection] window>

You can change display mode for the [Template selection] window.  For this,

� Click the [display menu] button, and select a desired display mode (Large Icon, Small Icon, List, or Detail) from the menu.

<List display mode>

<Small Icon display mode>

<Large Icon display mode>

<Detail display mode>
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3-1-2 File Menu - Open
This command opens an existing project file.

� Execute [Open] command in the [File] menu. The [Open Ladder File] dialog box is displayed.
On this dialog box, select a file type and a project file you want to open.
When a file is selected and the [Open] button is clicked, the project is opened in offline mode.

<Files of type>

Type of file (extension) Usage

SX Project (*.Spj)
MICREX SX SPH series project file. This project file consists of multiple files,
and you must specify this project file when you want to open a file.

Zipped SX Project (*.Zpj)
A project file consisting of multiple files is made into a zipped file. This type is
used to save a project in a floppy disk or other medium.

Ladder Files (*.Fxl, *.Lad, *.PMA)
Program file type for FLEX-PC series

Ladder Files (*.Fxl)

SX Template (*.Sxt) Template type for MICREX-SX SPH series

Ladder Template (*.Fxt) Template type for FLEX-PC series

Micrex-F Program (*.Ldx)
Program file type for MICREX-F series. If you open this program, the program
convert function is automatically activated.
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3-1-3 File Menu - ReOpen
Up to 10 program files last closed are displayed as a list, allowing file selection.

�When [ReOpen] command in the [File] menu is executed, the previous project file is displayed.

�When a project is selected, the selected project is opened in offline mode.
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Enable/disable status of network
setting is displayed.

� Select “MICREX-SX Series” for “CPU Type”, set a CPU to connect, and click the [OK] button.  Project data begins to be
loaded from the connected CPU.  When the loading of data is complete, the project is displayed in online mode.

<Options for this dialog box>

� Specified CPU
Allows connection with the CPU in the same configuration with the number specified by the CPU number specification.
When this check box is not set to ON, connection with the CPU directly linked with the loader is made.

� Upload ZIP file
Allows selection of tag data in the online mode from ZIP files in the PLC or project file the personal computer.

� Reflect a real structure
Reflects the actual configuration information in the system definition.

� Ethernet definition
If this check box is set to ON, set files downloaded into an Ethernet interface module can be uploaded when connected
online.

� Clear PLC memory on opening window
Clears the memory of the PLC and then connects with the PLC. Note that this PLC memory clear function also clears the
password of the PLC.
Note: Pressing the <Ctrl>+<Alt>+<F12> keys enables this check box.

* For network settings, refer to 3-4-10, “Network.”

3-1-4 File Menu - Online
This command loads a project stored in the currently connected CPU to this loader, and opens it.  This command is used to
monitor or diagnose the currently running program or data or to modify a program.

� Execute [Online] command in the [File] menu.  The [Select CPU Type] dialog box is displayed.

3-1 File Menu
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3-1-5 File Menu - Save/Save As
These commands are used to save the content of the currently opened project.

� Execute [Save...] command in the [File menu].  The currently opened project is saved by overwriting a project of the same
file name.

� If the project was newly created or loaded online, because no project name is given to it, the [Save As] dialog box is displayed.
This dialog box is displayed also when [Save As...] command in the [File] menu is executed.

� Set a folder, a file name and a file type as you want, and click the [Save] button.  The project file is saved.
For file type, either SX project or Zipped SX project can be selected.  The project is saved as an “<entered project
name>.Spj” file in the <entered project name> directory.  To zip the project, select “SX ZIP Project [*Zpj]” for “Files of type”.
And it is saved as an “<entered project name>.Zpj” file.

Note: Maximum 32 single-byte characters (or 16 double-byte characters) can be set for the file name.  Symbols ‘:’, ‘.’, ‘*’, ‘?’, ‘”’,
‘<‘, ‘>’ and ‘|’ cannot be used for file name.  Space character cannot be used, either.

<Files of type>

Type of file (extension) Usage

SX project (*.Spj)
MICREX SX SPH series project file. This project file consists of multiple files,
and a project is saved as an "<entered project name>.Spj" file in the <entered
project name> directory

Zipped SX project (*.Zpj)
A project file consisting of multiple files is made into a zipped file. This type is
used to save a project in a removable medium, such as a floppy disk.
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<Data saving function>

When connected to a CPU, it is possible to load the CPU internal memory data and save it as a text format file.
� Non-retain memory (standard memory) (M)
� Retain memory (L)
� System memory (SM)
� User FB memory
� System FB memory

The data file is saved in the following location:
Location: Project name/CONFIG/Configuration/RES/Resource name

For example, when a project, which contains a resource named as NP32, is named as “abc” and saved in the “C:/work” folder,
it is saved in the location “C:/work/abc/CONFIG/Configurtation/RES/NP32”

For data file, a file is created for individual memory type and named as follows:

Resource name + Memory type symbol.txt

<System definition window>

For example, when resource name is “Resource”, file name becomes as follows:
� Non-retain memory : ResourceM.txt
� Retain memory : ResourceL.txt
� System memory : ResourceSM.txt
� User FB memory : ResourceUFB.txt
� System FB memory : ResourceSFB.txt

Non-retain memory M

Retain memory L

System memory SM

User FB memory UFB

System FB memory SFB
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<Text format data file specifications>

(1) Tab-separated file format
Data files are saved in data memory text files with the following format.

� “Word address” field
The default format is a 6-digit decimal number. When editing, zero suppression can be enabled or disabled.

� “Bin” field
The default format is a 16-digit binary number. When editing, zero suppression can be enabled or disabled.

� “Dec” field
The default format is a signed decimal number (with zero suppression). When editing, signed or unsigned format can be
specified and zero suppression can be enabled or disabled. If the value is out of the range from -32768 to 65535, it is
handled as 0.

� “Hex” field
The default format is a 4-digit hexadecimal number. When editing, zero suppression can be enabled or disabled. If the value
is out of the range from 0000h to FFFFh, it is handled as 0.

� “Duration” field
The default value is millisecond or ms (with zero suppression). If the value is out of the range from 0ms to 4294967295ms,
it is handled as 0ms. The unit can be d, h, m, s, or ms. Data input to an odd number address are ignored.

� “Date” field
If the value is out of range from 1970-01-01 to 2106-02-07, it is handled as 1970-01-01.
Data input to an odd number address are ignored.

� “Time of Date” field
If the value is out of the range from 00:00:00 to 23:59:59, it is handled as 00:00:00.
Data input to an odd number address are ignored.

� “Date and Time” field
If the value is out of the range from 1970-01-01-00:00:00 to 2106-02-07-06:28:15, it is handled as 1970-01-01.
Data input to an odd number address are ignored.

� “Real” field
If the value is out of the range from 3.4028234E+38 to -1.1754944E-38, 0, and the range from 1.1754944E-38 to
3.4028234E+38, it is handled as 0.0E+0.

� “Character” field
When a text file is output, the Fuji Electric original code is converted into the Shift JIS code. When a text file is input, the Shift
JIS code is converted into the Fuji Electric original code.

This type of text file uses carriage and return characters (0Ah, 0Dh) as a delimiter. Therefore, if a character corresponding to
carriage and return characters is converted to text, a delimiter appears in one record, resulting in broken document format
when the text file is loaded in Excel, etc. For this reason, if the upper or lower byte of a word data contains 0Ah or 0Dh, it is
converted to a blank character before output.
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(2) Data file loading rules
This type of data file consists of multiple fields by expressing each data value with the data format for each data.
This loader loads this data file according to the following rule.

� For the data field, the leftmost valid data has the priority. For example, in order to edit a data file based on the duration,
delete data of the Bin, Dec, and Hex fields and then enter data in the Duration field.
� This priority rule can be specified for each record. According to the above rule, it is also possible to edit addresses 0 to 100

based on the Bin field and addresses 101 to 200 based on the Hex field.
� If any address is duplicated, the data of the last record has the priority. For example, when the address field of record 1 is

100 and the address field of record 5 is also 100, the data of record 5 is loaded.

(3) File size
The rough capacity of a text file can be calculated as follows:
File size    Memory size / 2 x 128 bytes (Even number address record size + Even address record size)

Example: Default size of the non-retain memory of SPH300 32K product
8192 / 2 x 128 = 524288 bytes    512KB

(4) Using data for spreadsheet software
Since data files are tab-separated text files, they can be used for spreadsheet software. The following example uses this data
file with Microsoft Excel 2000.

Example of Usage with Microsoft Excel 2000

This data file contains various numerical expressions such as binary, hexadecimal, time, real number, etc. In
order to use this data file efficiently for Excel, it is necessary to make Excel recognize each tab-separated field as
a character string.
To make Excel load each field as a character string, perform the following procedure.

1. Activate Excel.
2. Execute the Open command of the File menu to load the data file.
3. When “Text file wizard - 1/3” appears, press the [Next] button.
4. When “Text file wizard - 2/3” appears, press the [Next] button.
5. When “Text file wizard - 3/3” appears, press and hold the <Shift> key, then click each column in the Data

Preview box to select all columns.
6. Select the [Character String] radio button in the “Column Data Format” box and then press the [Finish] button.

With the above operation, each field of the data file is loaded into Excel as a character string. Edit data of desired
cells and then save the file with overwrite operation.

* Note that, during data editing, data is not saved correctly if the cell attribute is changed to other than “Character
string”.
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3-1-6 File Menu - Load
This command loads the currently opened project or a project saved in a file to the connected CPU.

� Execute [Load...] command in the [File] menu. The loader checks connection with the CPU. When the connection is
confirmed, the [Load] dialog box is displayed.

* If the [Specified CPU number and route information at the downloading] box is checked on the [Environment Options for
MICREX-SX] under the [Options] menu, the [Selection CPU] dialog box is displayed when [Load...] command in the [File]
menu is executed.
Set a CPU to connect and the path to it, and click the [OK] button.  The [Load] dialog box is displayed.

Note: If communication with the PLC is disabled, the following message is displayed.
In such case, check the cable connection and communication setting.
For more information about communication setting, refer to “3-6-3 Options Menu - MICREX-SX Communications”.

*

* With version V2.3.0.0 or later, system configuration information can be saved as a ZIP file in the CPU.
This function allows you to restore a module name registered in the system definition from the ZIP file in the CPU module
when connected online. The [System Configuration] check box is set ON by default.



3-11

Section 3 Menu Reference

3-1 File Menu

� For “Load Data”, either "Loader" or “File” can be selected.  When “Loader” is selected, the currently opened project becomes
the source project for loading.  When multiple files are opened, the currently active project becomes the source project for
loading.

�When “File” is selected, the [Browse...] button is enabled.  Click the [Browse...] button to display the [Download file to PLC]
dialog box.  On this dialog box, select a project and click the [Open] button to determine the project to be downloaded.

� After selecting the source project and the data to be downloaded, click the [OK] button.  The download confirmation dialog
box is displayed.  Click the [Yes] button to start download.

Source project for loading

Data to be downloaded
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� If the PLC is running, the warning dialog box is displayed.  When the [Yes] button is clicked, the PLC stops running, and
download is started.

�When download is complete, the following dialog box is displayed. Click the [OK] button to complete the download operation.

<Options for this dialog box>

� EClear retain memory ............ The retain memory in PLC is initialized at the time of loading.
� Clear FB/SFB variables .......... Initializes retained variables of FB/SFB in the PLC at the time of loading.

With the Standard CPU, High-Performance CPU (V26/V30-V36/V3A), this option cannot be
selected.

� FB Memory Remapping ......... Assigns the information on user FB and system FB used by the system, from the top of the
FB memory.

� System definition .................... Loads the system definition.
When loading the system definition, an error results in the following cases:
1) If a tact interval in unit of 0.5ms is specified for PLCs with the Standard CPU and High-

Performance CPU of version V50 or earlier.
2) If a tact interval in unit of 11ms or longer is specified for PLCs with other than V3A-V3Z of

High-Performance CPU of version V35 or earlier.
3) If the T link master (extension) or the OPCN-1 master (extension) is specified for PLCs

with the Standard CPU and High-Performance CPU of earlier than version V56.
� Data ......................................... Loads data. The data to be loaded is selected from the following memories.

Non-retain memory (M), Retain memory (L), System memory (SM), System FB instance
memory, User FB memory

� ZIP File .................................... Compress the program name, tag information, etc. and then transfers data to the PLC when
the check box is set to ON.

<Number of tags which can be stored in a ZIP file>

The maximum storage sizes of a ZIP file is 128K bytes (SPH300/SPH2000), 64K bytes (SPH200), 32K bytes (SPB (SX-mode))
or 128K bytes (board controller). With a compression rate of 40%, the maximum file capacity before compression is 320K bytes
(SPH300/SPH2000), 160K bytes (SPH200), 80K bytes (SPB (SX-mode)) or 320K bytes (board controller).

* 80 bytes is required for each tag and 50 bytes for each program.

(Calculation example) When the number of tags is 1, the number of tags which can be registered is as follows:
SPH300/SPH2000 : (320K bytes - 50 bytes) / 80 bytes     4000
SPH200 : (160K bytes - 50 bytes) / 80 bytes     2000
SPB (SX-mode) : (80K bytes - 50 bytes) / 80 bytes     1000
Board controller : (320K bytes - 50 bytes) / 80 bytes     4000

� Module driver ................................................. Set this check box to ON when loading drivers to Ethernet or the communication
module corresponding to the LONWORKS driver.

� Use the machine code which is already ...... When this check box is set to ON, the machine code generated at the time of
program check is loaded to the CPU. Since compilation is not performed at
the time of loading, the loading time can be shortened.
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3-1-7 File Menu - Verify
This command compares the contents of the current program window with the contents of the project file. When the window is
the online window, this function makes it possible to compare the contents of the PLC with the contents of the project file.
The program and system definition can be compared individually or collectively.

� Execute [Verify...] command in the [File] menu.  The [Verify] dialog box is displayed.

When Program is checked, this command verifies the task information and program information.
For the task information, the property and instance information of task (program information assigned to task) are verified.
For the program information, the property, parameter setup information, local device setup, and ladder program are verified.
The ladder program is verified for each line and the line number of mismatched lines is displayed.
When System definition is checked, the system definition is verified.

The data to be verified is selected from the following memories.
� Non-retain memory (M)
� Retain memory (retain memory (L))
� System memory (SM)
� System FB instance memory
� User FB instance memory
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3-1-8 File Menu - Save as Template
You can save a created project as a template.  When saved as a template, the program configuration, system definition and
created programs that exist at the timing to save are all saved.

� Execute [Save As Template...] command in the [File] menu.  The [Save as a template] dialog box is displayed.

� Enter a file name and click the [Save] button.  The project is saved as a template.  You can enter a brief comment in the
[Explanation] text box.

�When a new project is created, the [Template selection] dialog box is displayed as below, in which the saved project is
displayed as a template.
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3-1-9 File Menu - Import Programs
This command imports a specified program (program, user functions, user FBs) from other project file to the currently opened
project file.
User functions and user FBs called from the program to be imported are also imported. When FB2 is imported with the call
configuration shown below, FB3 and FB4 are also imported.

If the same program name exists in the target location of importing (project already opened), the ladder program is overwritten
and the program number is imported as the one of the target location of importing.
However, if the program name to be imported is different from the program type in the target location of importing (program,
user function, user FB), importing is not performed.

� Execute [Import Programs...] command in the [File] menu.  The [Import Programs] dialog box is displayed.
Click the [Browse...] button to display the [Import Programs] dialog box.  On this dialog box, select a project as the source for
import, and click the [OK] button.  Programs are listed in the list box on the [Import Programs] dialog box.
For the source project for import, either SX project file (.spj) or Zipped SC project file (.zpj) can be selected.

A tree diagram is displayed, which shows
the relation of programs called from the
programs that are registered to the project
to be imported.
On this dialog box, select programs to be
imported, by checking the boxes for the
corresponding programs.

Note: Protected programs cannot become the object of import.

FB 2 call FB 3 call FB 4 call

FB 1 FB 2 FB 3 FB 4
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<Function of the buttons provided on the dialog box>

� [Browse] button
Select a project to be imported. An SX project file (.spj) and an SX compressed project files (.zpj) can be selected. Progress
is displayed in the dialog immediately after selecting a project file.
In the subsequent tree display, up to the level of the program registered in the project is displayed, as shown below. The
project file currently opened cannot be selected. When it is selected, message “The file already opened cannot be opened”
appears.

� [All Select] button
Selects all programs.

� [All Release] button
Deselects all programs.

� [All Program] button
Selects all programs of the Program type.

� [All Function] button
Selects all programs of the Function type.

� [All Function Block] button
Selects all programs of the Function Block type.

� Select a program you want to import, and click the [OK] button. Before import is started, a confirmation dialog box is displayed.
If no program is selected, the message “There is no program to be imported” is displayed.

� Click the [OK] button. The selected programs are imported.
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3-1-10 File Menu - Read Only
To prevent misoperations of the project editing, set a passwaord and write-protect it. In the project in “Read Only” state, the
following operations cannot be performed.
� Save / Save as
� Load / Download changes to PLC
� Memory Clear
� Download of User ROM Utility

<How to set “Raed Only”>

� Open the project that you want to protect, and execute [Read Only] command in the [Edit] menu. The [Set Password] dialog
box is displayed.

� Set a password with 6-to-32 alphanumeric characters, and click the [OK] button. By saving the project, saving it under a
specified name or downloading it to the PLC, the project becomes “Read Only” state. In the project in “Read Only” state,
the disabled commands cannot be executed as shown below. (The following figure is an example of the [File] menu.)

<No “read only” setting> <In a “read only” state>

Disabled commands

A checkmark is placed on the “Read Only” command.

<How to cancel “Read Only”>

� Execute [Read Only] command in the [File] menu. The [Enter Password] dialog box is displayed. Enter the set password,
and click the [OK] button. Write-protection is canceled.

* If the entered password does not agree with the set password, the following error message is displayed.
Please take note that there is no other way to cancel “Read Only” but to enter the correct password.
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3-1-11 File Menu - Page Setup
This command is used to specify all items related to printing in the Print Selection dialog.

(1) Page setup
For page setup, heading, footer and margins can be set.  Heading and footer are printed on each page.  In addition to these,
top, bottom, left and right margins can be set.

� Execute [Page Setup...] command in the [File] menu.  The [Print Selection] dialog box is displayed.  Click the [Page setup]
tab, and set necessary items for page setup.

Auto setting Prints the present date of Windows.
Manual setting Prints the date set as in the date box.

* When you execute [Save] command of the File menu, the contents of the Page Setup page are saved in the project file (*.spj)
or compressed project file (*.zpj) together with the project.
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(2) Printout Setup
Specify print conditions for various print items.

� Execute [Page Setup...] command in the [File] menu.  The [Print Selection] dialog box is displayed.  Click the [Printout setup]
tab, and click a tab from those displayed at the bottom of the dialog box to display the setup window for your desired item to
print out.

1) I/O Device Listing

This tag page is used to register Programs to be printed.

The program marked with an asterisk (*) is to be printed.
It is selected or deselected using the [Enable/Disable] button.

Register programs accompanying device list printing.

� To select all programs for I/O device list printing, set the [All Programs] button to ON.
� To print the I/O device list only for selected programs, set the [Programs from List] button to ON, select the target program

using the program selection text box, then click the [Add to List] button to register the program.
�When the [Include Common] check box is set to ON, tags common to all programs are printed.
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2) Program

This tab page is used to set print conditions for program.

� To print the entire program, set the [Whole Program] check box to ON.
� To print the specified program or line in the program, set the [Whole Program] check box to OFF, then select the program to

be printed using Program Kind and Program No. Then, it is also possible to enter the start line number and end line
number and select a line in the program for printing.

For Address/Tag Select (address and tag print format), Address, Tag, or Both Address & Tag can be selected. When Address or
Tag is selected, more compact print format (allowing more ladder diagrams to be printed in a single page) is possible.

�When [Both Address & Tag] option button is set to ON, address and tag are attached to the program at the time of printing.
When the [Tag] option button is set to ON, only tag is attached to the program at the time of printing.
When the [Address] option button is set to ON, only address is attached to the program at the time of printing.

� For Tag Height, specify the number of rows to be printed.
�When the [Protect Line Breakup] check box is set to ON, the line is printed on the next page to avoid printing on the current

and next pages.
�When the [Include Cross Reference(1)] check box is set to ON, the cross reference is appended to the ladder diagram.

When the [Include Inputs(2)] check box is set to ON, the cross reference on the input side is printed. When the [Include
Outputs(3)] check box is set to ON, the cross reference on the output side is printed. The number of items (up to 32767) can
be specified for each setting.

For Page No. Format, the starting page number and a desired character string attached to the page number can be specified.
Example: To print page format “P-1”, enter “P-\” in the Page No. format box.

To print page format “1P”, enter “\P” in the box.
* “\” indicates the page number.
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3) Devices Used

This tab page is used to register devices accompanying device usage printing.

� Enter the memory identifier. Available devices are listed below.
For example, enter “L” to specify the retain memory area with the bit address, “WL” with the word address or “DL” with the
double word address.

When you click this button,
I/Os registered in the system
definition are automatically
registered as bit devices or
word devices.

� After entering the start and end addresses, click the [Add to List] button to register devices.

Bit Word Double word

Input (X) X WX DX

Output (Y) Y WY DY

Standard memory (M) M WM DM

Retain memory (L) L WL DL

System memory (SM) SM WSM DSM

User FB memory (F) F WF DF

Timer (T) T

Counter (C) C

Devices marked with an asterisk (*) are to be printed.
Make setting using the [Enable/Disable] button.

Register devices accompanying device usage printing here.
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4) Device Cross Reference

This tab page is used to register devices under cross reference.

Devices marked with an asterisk (*) are to be printed.
Make setting using the [Enable/Disable] button.

Register devices under cross reference here.

� Enter the memory identifier. Available devices are listed below.
For example, enter “M” to specify the standard memory area with the bit address, “WM” with the word address or “DM” with
the double word address.

� After entering the start and end addresses, click the [Add to List] button to register devices.

Bit Word Double word

Input (X) X WX DX

Output (Y) Y WY DY

Standard memory (M) M WM DM

Retain memory (L) L WL DL

System memory (SM) SM WSM DSM

User FB memory (F) F WF DF

Timer (T) T

Counter (C) C

When you click this button,
I/Os registered in the system
definition are automatically
registered as bit devices or
word devices.
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SAMP01: Project

Programs

Hardware

System Definition

RES0: (00) NP1PS-117

Tasks
DEFAULT: Default

FLICKER_FB: Function Block (0)

PG00000: Program (0)

PG00001: Program (1)

Ladder2: Program (2)

PG00000: (0)

PG00001: (1)

SAMP01: Project

Programs

Hardware

System Definition

RES0: (00) NP1PS-117

Tasks
DEFAULT: Default

FLICKER_FB: Function Block (0)

PG00000: Program (0)

PG00001: Program (1)

Ladder2: Program (2)

       FLICKER_FB

PG00000: (0)

PG00001: (1)

3-1 File Menu

5) Project Tree

This tab page is used to print the program calling relationship (programs currently called from the program) when printing the
project tree.

Set this check to ON to print the project
tree with program calling relationship.

<Print example (1) without Program calling relationship>         <Print example (2) with Program calling relationship>

Calling relationship
Ladder 2 calls FLCKER_FB.
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6) Initial Data

This tab page is used to register programs accompanying initial data list printing of devices.

Programs marked with an asterisk (*)
are to be printed. Make setting using
the [Enable/Disable] button.

Register programs accompanying initial data list printing here.

� To specify all Programs for initial data list printing, set the [All Programs] button to ON.
� To print the initial data list only for the selected Programs, set the [Programs from List] button to ON, select the target

program using the program selection text box, then click the [Add to List] button to register the program.
�When the [Include Global] check box is set to ON, the initial data list of global devices is printed.
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7) Program Properties

This tab page is used to register programs accompanying property printing. The property information of the following program
is printed.
� Program Name
� Program No.
� Type (Kind)
� Use of enable flag (ENO)
� Local device setup information
� Parameter list (only functions and function blocks)
� Array/structure declaration
� Information on memory in function blocks (only function blocks)

Programs marked with an asterisk (*)
are to be printed. Make setting using
the [Enable/Disable] button.

Register programs accompanying property printing here.

� To specify all programs for property printing, set the [All Programs] button to ON.
� To print the property only for the selected programs, set the [Programs from List] button to ON, select the target program

using the program selection text box, then click the [Add to List] button to register the program.
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8) AFB Ladder

This tab page is used to make setting for printing of the ladder diagram created in auto feedback.

� To print the entire program, set the [Whole Program] check box to ON.
� To print lines with range specification, set the [Whole Program] check box to OFF and then specify the start and end line

numbers.

For Address/Tag Select (address and tag print format), Address, Tag, or Both Address & Tag can be selected. When Address or
Tag is selected, more compact print format (allowing more ladder diagrams to be printed in a single page) is possible.

�When [Both Address & Tag] option button is set to ON, address and tag are attached to the program at the time of printing.
When the [Tag] option button is set to ON, only tag is attached to the program at the time of printing.
When the [Address] option button is set to ON, only address is attached to the program at the time of printing.

� For Tag Height, specify the number of rows to be printed.
�When the [Protect Line Breakup] check box is set to ON, the line is printed on the next page to avoid printing on the current

and next pages.
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9) Simulation Panel

This tab page is used to print settings of buttons, lamps, and other objects currently being created in the simulation screen.

�When the [Simulation Item List Printout] check box is set to ON, settings of objects currently being created in the simulation
screen are printed.
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3-1-12 File Menu - Print
When this command is executed, the Print dialog appears. Select required print items and perform printing.

� I/O Device Listing .................. Prints a list of address, tag, and explanation.
� Ladder ................................... Prints the ladder program and ladder program with cross reference.
� Instruction List ....................... Prints the program with the instruction word list format.
� Devices Used ........................ Prints the device usage.
� Device Cross Reference ...... Prints the input and output information on all devices used for the program.
� System Definition .................. Prints the system definition.
� Project Tree ........................... Prints the project tree as text image.
� Initial Data List ...................... Prints the initial data list set in [Initial Data List] of the “PLC Functions” menu.
� Program Properties .............. Prints the property setup information of program.
� AFB Ladder ............................ Prints the auto feedback line. Refer to Appendix 1 for AFB.
� Simulation Panel ................... Prints settings of objects created in the simulation screen. Refer to Appendix 1 forsimulation.

In this dialog, page setup, printer setup, and print preview can also be performed.

1) Printing the I/O device list

When the [I/O Device Listing] check box is set to ON, the I/O device list is printed. Print settings are made in the [I/O Device
Listing] tab page in the “Print Selection” dialog.

2) Printing the program

When the [Program] check box is set to ON, the program is printed with the ladder diagram format. Printing is made in black
and white (background in white and lines in black), independent of the color set by color specification in environmental setup
with version V1.4 or later.
Print settings are made in the [Ladder] tab page in the “Print Selection” dialog.

3) Printing the instruction word list

When the [Instruction List] check box is set to ON, all lines of all programs are printed with instruction word list (mnemonic)
format.

4) Printing the device usage

When the [Devices Used] check box is set to ON, the usage of registered devices is printed.
The devices to be printed are specified in the [Devices Used] tab page in the “Print Selection” dialog.

5) Printing the device cross reference

When the [Device Cross Reference] check box is set to ON, the cross reference information of registered devices is printed.
The devices under cross reference information printing are specified in the [Device Cross Reference] tab page in the “Print
Selection” dialog.
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6) Printing the system definition

When the [System Definition] check box is set to ON, the contents of the system definition are printed. The items to be
printed are shown below.
� System configuration
� System redundancy definition
� System fail-soft activation definition
� Module configuration information

7) Printing the project tree

When the [Project Tree] check box is set to ON, the project tree is printed in text format.
Whether program calling relationship is to be printed or not can be selected in the [Project Tree] tab page in the “Print
Selection” dialog.

8) Printing the initial data list

When the [Initial Data List] check box is set to ON, the initial data list of the device currently used in the registered program or
global device is printed. Programs are registered and whether the global device is to be printed can be specified in the [Initial
Data] tab page in the “Print Selection” dialog.

9) Printing the Program properties

When the [Program Properties] check box is set to ON, program properties (Program Name, Program No., Kind, use of enable
flag (ENO), local device setup information, parameter list (functions and function blocks only), and function block memory
information (function blocks only) are printed.
Programs accompanying properties information printing can be selected in the [Program Properties] tab page in the “Print
Selection” dialog.

10) Printing the AFB ladder

When the [AFB Ladder] check box is set to ON, the auto feedback line created with AFB is printed.
For the auto feedback line, range specification is possible which is made in the [AFB Ladder] tab page in the “Print Selection”
dialog.

11) Simulation panel

When the [Simulation Panel] check box is set to ON, the settings of the object currently being created in the simulation screen
are printed.

3-1-13 File Menu - Print Preview
This menu is used to check the print image on the personal computer screen. Preview items are selected using the tool bar in
the preview window. Items which can be previewed are shown below. If the printer driver is not installed, error message “The
default printer does not exist” appears. Be sure to install the printer driver before previewing.

The following functions can be used in addition to selection of preview items.
� Jump ................. Jumps to a specified page.
� Print ................... Prints a specified page.
� Setup ................. Sets the printing format.

3-1-14 File Menu - Exit
To terminate the loader, execute the [Exit] command of the File menu. If a program window where any change is made is open,
a dialog for prompting save operation appears when closing the main program. Open help windows are also closed.
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3-2 Edit Menu

The [Edit] menu contains the following commands.

<Package displays mode>                                 <Individual displays mode>
* When the Simulation tab is enabled,

the following additional menu is
displayed.  For more information of
simulation, refer to Appendix 1.

� Edit Mode ................................................. Selects the editing mode in the program window.
� Undo ........................................................ Cancels the line edit operation last performed.
� Redo ........................................................ Performs the canceled operation again.
� Cut ............................................................ Moves a selected line to the clip board.
� Copy ......................................................... Copies a selected line to the clip board.
� Paste ........................................................ Pastes the line of the clip board in the program.
� Copy to Library ......................................... Saves a desired line in a file as a library line.
� Paste from Library ................................... Load a file registered as a library line in the program currently being created.
� Insert Task ............................................... Inserts a task (enabled only in “Packagedisplays” mode)

* Refer to paragraph 2-3-1.
� Insert Program ........................................ Inserts a program (PAGE instruction) (enabled only in “Package displays” mode)

............................................................ * Refer to paragraph 2-3-1.
� Insert Line ................................................ Inserts a new line above the cursor position.
� Insert Line below the cursor position ..... Inserts a new line below the cursor position.
� Insert Returning ....................................... Inserts a return of a line. * Refer to paragraph 2-3-1.
� Delete Line .............................................. Deletes the line at the current cursor position.
� Display line as Instruction List ............... Displays the current line using instruction words (mnemonics).
� Expand/Collapse Parameters ................ Change display mode of the parameters.
� Merge with next Line ............................... Merges the current line with the following line.
� Insert/Modify Line Comment ................... Adds or modifies line comment.
� Download changes to PLC ..................... Downloads the program changed online to the PLC.
� Program properties ................................. Displays or sets the properties of a program. (Enabled only in “Package displays”

mode)
� Local Device Property ............................. Sets local devices.
� ST Editor .................................................. Opens the ST editor when the language of a prgram is “ST”.

* For information about ST language, refer to “Appendix 2  How to Use ST Language”.

3-2-1 Edit Menu - Edit Mode
This command is used to change over between “Edit” and “View” modes for the program window.

� Execute [Edit Mode] command in the [Edit] menu.  Mode of the program window is changed over to “Edit” when View mode
is currently active, or to “View” when Edit mode is currently active.
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3-2-2 Edit Menu - Undo, Redo
(1) Undo
Cancels the editing operation performed last.

� Execute [Undo] command in the [Edit] menu.  The system is restored to the status that took effect just before the last editing
operation.
This function can be executed also with the [Undo] button on the main tool bar or with the <Ctrl> and <Z> keys.

* The operation history retains last 20 operations. When 20 operations are exceeded, the oldest information is deleted.

�Operations retained in the operation history
� Changing a line
� Cursor movement
� Inserting a line
� Deleting a line
� Selecting a line
� Selecting a device
� Cutting a selected line (only in the offline mode)
� Copying a selected line (only in the offline mode)
� Pasting a selected line (only in the offline mode)
� Cutting a rectangular area
� Copying a rectangular area
� Pasting a rectangular area
� Merging lines
� Selecting ladder mnemonic display

�Operations clearing the history information
� Closing a project file
� Replacement
� Setting editing mode to OFF
� Cutting a selected line (only in the online mode)
� Copying a selected line (only in the online mode)
� Pasting a selected line (only in the online mode)
� Changing the PLC model

(2) Redo
This command reversely works to the [Undo] command in the [Edit] menu.

� Execute [Redo] command in the [Edit] menu.  The system is restored to the status that took effect just before the last editing
operation.
This function can be executed also with the [Redo] button on the main tool bar or with the <Ctrl> and <Y> keys.

* The operation history retains last 20 operations. When 20 operations are exceeded, the oldest information is deleted.

�Operations retained in the operation history
� Changing a line
� Cursor movement
� Inserting a line
� Deleting a line
� Selecting a line
� Selecting a device
� Cutting a selected line (only in the offline mode)
� Copying a selected line (only in the offline mode)
� Pasting a selected line (only in the offline mode)
� Cutting a rectangular area
� Copying a rectangular area
� Pasting a rectangular area
� Merging lines
� Changing ladder mnemonic display

�Operation clearing the history information
� Closing a project file
� Replacement
� Setting the editing mode to OFF
� Cutting a selected line (only in the online mode)
� Copying a selected line (only in the online mode)
� Pasting a selected line (only in the online mode)
� Changing the PLC model
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3-2-3 Edit Menu - Cut, Copy, Paste
You can cut or copy and paste a task in units of program or line.  For more information about the operating method, refer to
“2-3 Editing a Project”.

<Function to convert lines copied from FLEX-PC/MICREX-F series>

When you copy a line of FLEX-PC or MICREX-F series and paste it on a MICREX-SX project (in Edit mode), the [Address
Assignment] dialog box is displayed.  On this dialog box you can assign specified address range of FLEX-PC to specified
addresses of MICREX-SX series and paste the copied line.

Note: It is impossible to paste a program of MICREX-SX series to MICREX-F series or FLEX-PC series.

� On the source program loader for copy (in this example, PLC Programmer of MICREX-F series) select a line to be copied
and execute copy.

For MICREX-F series, S’s are marked on the left and right power rails of selected line.

� Change operation over to this loader, select a position to insert the line, and execute [Paste] command in the [Edit] menu.
The [Address Assignment] dialog box is displayed.

Address assignment conditions

* The setting of address assignment conditions can be changed to match the system.
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� Check the assignment conditions, and click the [OK] button.  The line is copied and inserted, and the [Assignment Result
Display] dialog box is displayed.

� On the [Assignment Result Display] dialog box, click the [Save] button to save the result as a text file.  This function is
convenient when it is necessary to change addresses after a line is pasted.
Click the [Close] button.  The following confirmation dialog box is displayed.  When the [Yes] button is clicked on this dialog
box, the pasting of the line is complete without saving the result as a text file.

Note: If E’s are marked on the left and right power rails, the line is erroneous.
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<How to set address assignment conditions>

� To add an address assignment, click the [Append] button to display the “Address Entry” dialog, enter the start and end
addresses of the FLEX-PC program, enter the start address of the MICREX-SX project, then click the [OK] button. The
address assignment is appended to column “Operand paste condition setup”.

� To change an address assignment, select the target device, click the [Change] button to display the “Address Entry” dialog
with the paste conditions for the selected memory displayed, change each item, then click the [OK] button. The specified
change is reflected.

� To delete an address assignment condition, select the target item and then click the [Delete] button.
� The registered “Address assignment condition” can be saved in a file. When you click the [Register] button, the “Registration”

dialog appears. Enter a file name and then click the [OK] button.

* The registered file can be loaded using the combobox of the “Address Assignment” dialog.
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3-2-4 Edit Menu - Copy to Library, Paste from Library
(1) Copy to library
This function is used in the editing mode to select desired lines and then save them in library files.

� Select a line you want register to a library.  While holding down the <Shift> key, click the first one of the lines you want to
register, and then click the last one of them.  The selected lines are displayed in yellow hatching.

� Execute the [Copy to Library] command. The “Copy to Library” dialog appears.
Select a folder, enter a file name, then click the [Save] button.
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(2) Paste from library
This function is used in the editing mode to load lines from library files.

� Put the cursor on the position where a library line is to be inserted and then execute [Paste from Library]. The “Paste from
Library” dialog appears.

3-2 Edit Menu

� Select a file (*.slb) and then click the [Open] button. The specified library line is pasted.
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3-2-5 Edit Menu - Display line as Instruction List
This command displays the ladder diagram at the current cursor position as a list of instruction words.

� Select a line you want to display as a list of instruction words, and execute [Display Line as Instruction List] command in the
[Edit] menu.  The line at the current cursor position is displayed as a list of instruction words.

* Even in “Instruction List Display” mode, it is possible to edit programs.

* The instruction word list displays the instruction and operand constituting the ladder diagram in list form. The operand can
be displayed in three formats: address and tag, address only, and tag only. The display mode can be selected using
Address/Tag Display in the [Editor Options] tab page in the [Environment Options for MICREX-SX] dialog of the Options
menu. Tags are enclosed in single quotation marks (‘).

* To change the instruction code or operand, move the cursor and then change it directly. When the cursor escapes from the
row currently being edited, the row is converted.

* To enter an instruction, enter the instruction name directly or press the corresponding function key assigned to the instruction
Speed bar. To enter an instruction with the AND attribute corresponding to the function key instruction, press the <Shift> key.
To enter an instruction with the OR attribute, press the <Ctrl> key.
For example, to enter the LDI instruction, press the <F3> key when the Common tab is selected. To enter the ANI or ORI
command, press and hold the <Shift> key and the <Ctrl> key and then press the <F3> key.

* If the tag to be entered contains a space, enclose it with single quotation marks (‘) to distinguish between a space for
delimiting operands and a space in the tag.

� Execute [Display Line as Instruction List] command in the [Edit] menu.  Display of the line is restored to ordinary ladder
diagram.

Note: If the line has been changed and the ladder diagram cannot be displayed, error symbol “E” is displayed at the left and
right power rails and the line becomes red.
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3-2-6 Edit Menu - Insert/Modify Line Comment
You can set a comment for individual line.

� Select a line, and execute [Insert/Modify Line Comment...] command in the [Edit] menu.  The [Line Comment Number] dialog
box is displayed.  On this dialog box, line comment numbers that are not yet used are displayed by default.  You can also
enter arbitrary numbers you want.  When changed to an already used number, the comment of an already created line is
displayed.  After entering a line comment number, click the [OK] button.  A line comment is displayed on the ladder diagram.
The setting range of line comment number is 0001 to 32767 (7FFFH).

� Set a comment number and click the [OK] button.  The [Line Comment Editor] dialog box is displayed.

� Enter a comment, and click the [OK] button.  The line comment is displayed on the diagram, as shown below.
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3-2-7 Edit Menu - Download Changes to PLC
You can rewrite a project stored in the currently running PLC.

� After modifying an online program, execute [Download changes to PLC] command in the [Edit] menu.  Only the modified
program (page) is complied and downloaded to the PLC.

If you have performed any of the following operations, the function to download changed lines to the PLC cannot be performed.
� Changing the system definition  (Note 3)
� Changing the parameter setup of functions and function blocks
� Deleting and changing a definition or declaration of arrays/structures
� Appending, deleting, and changing a task
� Appending, deleting, and changing a program instance
� Deleting a program
� Changing a program number
� Performing program check with the [Use an created the machine code by download] check box set ON
� Appending, deleting, and changing an initial value
� Importing initial data files

Note 1: When you execute “Download changes to PLC” for the High-Performance CPU, an available program space of 8192
or more steps is required in the CPU. “User program capacity stored in CPU” can be checked using [Display PLC
Information] of the PLC Functions menu.

Note 2: With versions earlier than V2.3.1.0, you cannot rewrite the project during PLC running if an expansion FB not used in
the project is added. (When a new expansion FB is imported)

Note 3: Changed lines can be downloaded to the PLC even after the system definition is opened. However, since the system
definition and memory boundary may have been changed, the following warning message appears.
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3-2-8 Edit Menu - Local Device Property
This command sets the memory range to be used only by active programs in the program window.

� Execute the [Local Device Property] command of the Edit menu. All programs in the project are displayed.

� Select Programs to be set or changed and then click the [Modify] button. The following dialog appears. Specify the range of
local devices and then click the [OK] button.

* The non-retain memory and retain memory can be specified as a local device. The range starting from the Start Address to
the address determined by Local Area (the number of words) can be specified as a local device for the currently displayed
program. Only an even number can be specified for Start Address and Local Area.

* Device addresses set as a local device are displayed in ladder display in the color specified as a local device in the
[Environment Options for MICREX-SX] dialog displayed by selecting an Options menu command. (The default color is
brown.) They are printed with an underline at the time of ladder printing.
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The Search menu offers the following commands:

� Find .................................. Searches for an address or a tag for the active program.
� Replace ........................... Replaces an address with another one for the active program.
� Search Again ................... Repeats the previous search.
� Global Find ...................... Searches for an address or a tag for all programs.
� Global Replace ............... Replaces an address with another one for all programs.
� Instruction Find ................ Searches for an instruction, user function or user FB for all programs.
� Section Find .................... Searches for a section No. in a program.
� Go to Line ........................ Moves on to a specified line number.

3-3-1 Search Menu - Find, Replace, Search Again
(1) Find
This command searches for an address or a tag for the active program.

� Execute the [Find] command in the [Search] menu. The [Search] dialog box is displayed.

<Options>

� Direction ............................ Select the search direction: Forward (from the start to the end of scope of search) or Backward
(from the end to the start of scope of search).

� Origin .................................. Specify the location from which search is to be started: From Cursor (the current cursor position)
or Entire Scope (the top of the program in the current program).

� Scope ................................. Select the scope of search from following two options:
� Whole Program ................. This option is the default setup allowing search for the whole program in the current program.
� Selected lines .................... Performs search only for the selected lines.
� Range ................................ Specify the type of the instruction to be searched for.
� All Elements ...................... Searches for all types of instructions.
� Contact Instructions .......... Searches for contact instructions (A contact, B contact, rising edge differential, and falling edge

differential).
� Output Instructions ............ Searches for coils, inverted coils, sets, and resets.
� Data Instructions ............... Searches for all instructions not described in items for contact instructions or output instructions.

�When you have entered an address or a tag in the Address/Tag edit box, click the [Find] button to start search. If an
occurrence is found, the line is displayed by scrolling it to the top of the program window; otherwise, a message appears.
Then, click the [Find] button to search for the next occurrence. Click the [Cancel] button to end search.
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(2) Replace
This command replaces a desired address or a specified address range with a different address. Contacts can be inverted
(from A contact to B contact, from B contact to A contact). Replace can be used only in the editing mode.

� Execute the [Replace] command in the [Search] menu. The [Replace] dialog box is displayed.

<Address replacement mode>

� Enter the original address in the Address/Tag edit box and then enter a replacement address in the “Replace with” edit box.
Bit addresses are replaced only with a bit address and word addresses only with a word address. A tag can also be entered
instead of the original and replacement addresses.

Upon completion of replacement, the number of replaced addresses is displayed.
� To perform the replacement operation at one time for an address range, enter an address range in the Address/Tag edit box.

For example, to replace a range from M0000 to M000F with a range from M0020 to M002F, enter an original address range
using ‘-’ (M0000-M000F). As the replacement address, enter the starting address of the replacement address, M0020.

<Notes on address replacement>

With the replacement function, whether the address is suitable for each instruction is not checked at the time of address
replacement. After executing the replacement function, perform program check. In case of collective replacement, address
range cannot be specified with a tag using a ‘-’.

<Options>

� Range options function in the same manner as the Search dialog (refer to 3-3-1, “Search - Find”). After setting these options,
click the [OK] button to start the Replace operation.

� When the [With Tag/Description] check box to ON, the tag defined for the address is also replaced. For example, if tag
definition “Contact 1” is made for M0001 when replacing M0000 with M0001, the tag of M0001 becomes “Contact 1.” Then,
when the [Delete Tag/Description] check box is set to ON, tag of M0000, “Contact 1”, is deleted at the same time.

� When the [Include Word Device] check box is set to ON, the word address included in the specified double word address is
also replaced. When replacing DM000 with DM200, for example, WM000 is replaced with WM200 and WM001 is replaced
with WM201 in the program.

� When the [Include Bit Device] check box is set to ON, the bit address included in the specified word address is also replaced.
When replacing WM000 with WM200, for example, M0001 is replaced with M2001 in the program.

� When the [Change NO/NC contacts] check box is set to ON, all contacts of the specified address are inverted (from A contact
to B contact, from B contact to A contact). The address after conversion cannot be specified.
For example, if the logic of a physical input signal is inverted, this function make it easier to deal with the inversion.
However, differential contacts are not inverted.

(3) Search again
This command is used to repeat search for the same address. This function is used when the Search dialog is closed after
an occurrence is found. The search conditions specified in the “Search” dialog last executed are applied. Search is continued
from the address found last. By repeating this function, all the occurrences within the specified search range can be found.
This function is also assigned to the <Ctrl>+<L> key.



3-43

Section 3 Menu Reference

3-3 Search Munu

3-3-2 Search Menu - Global Find, Global Replace
(1) Global find
This command searches for an address or a tag for all programs.

� Execute the [Global Find] command in the [Search] menu. The [Global Find] dialog box is diplayed.

<Options>

� Range options function in the same manner as the Search dialog (refer to 3-3-1, “Search - Find”). After setting these options,
click the [OK] button to start the Global Find operation.

� When the [Clear the Message Window] check box is set to ON, contents of the the search in the message window are
ceared everytime the search is executed and only the newest contents of the search are displayed. You will be able to keep
the contents of the search in the message window by setting this check box to OFF (max. 32000 lines).

� After entering an address or a tag in the [Address/Tag] edit box, click the [OK] button to start global search. If an occurrence
is found, it is diplayed in the Search tab in the message window. When you double-click the contents of the message
window, the line found is displayed.



3-44

Section 3 Menu Reference

3-3 Search Munu

(2) Global replace
This command replaces a desired address or a specified address range with a different address. Contacts can be inverted
(from A contact to B contact, from B contact to A contact). Replace can be used only in the editing mode.

� Execute the [Global Replace] command in the [Search] menu. The [Global Replace] dialog box is displayed.

<Address replacement mode>

� Enter the original address in the Address/Tag edit box and then enter a replacement address in the “Replace with” edit box.
Bit addresses are replaced only with a bit address and word addresses only with a word address. A tag can also be entered
instead of the original and replacement addresses.
Upon completion of replacement, the number of replaced addresses is displayed.

� To perform the replacement operation at one time for an address range, enter an address range in the Address/Tag edit box.
For example, to replace a range from M0000 to M000F with a range from M0020 to M002F, enter an original address range
using “-” (M0000-M000F). As the replacement address, enter the starting address of the replacement address, M0020. The
address range cannot be specified with a tag.

<Notes on address replacement>

With the replacement function, whether the address is suitable for each instruction is not checked at the time of address
replacement. After executing the replacement function, perform program check. In case of collective replacement, address
range cannot be specified with a tag using a “-”.

<Options>

� Range options function in the same manner as the Search dialog (refer to 3-3-1, “Search - Find”). After setting these options,
click the [OK] button to start the Global Replace operation.

� When the [With Tag/Description] check box to ON, the tag defined for the address is also replaced. For example, if tag
definition “Contact 1” is made for M0001 when replacing M0000 with M0001, the tag of M0001 becomes “Contact 1.” Then,
when the [Delete Tag/Description] check box is set to ON, tag of M0000, “Contact 1”, is deleted at the same time.

� When the [Include Word Device] check box is set to ON, the word address included in the specified double word address is
also replaced. When replacing DM000 with DM200, for example, WM000 is replaced with WM200 and WM001 is replaced
with WM201 in the program.

� When the [Include Bit Device] check box is set to ON, the bit address included in the specified word address is also replaced.
When replacing WM000 with WM200, for example, M0001 is replaced with M2001 in the program.

� When the [Change NO/NC contacts] check box is set to ON, all contacts of the specified address are inverted (from A contact
to B contact, from B contact to A contact). The address after conversion cannot be specified.
For example, if the logic of a physical input signal is inverted, this function make it easier to deal with the inversion.
However, differential contacts are not inverted.

� When the [Clear the Message Window] check box is set to ON, contents of the the replace in the message window are
cleared everytime the replace is executed and only the newest contents of the replace are displayed. You will be able to
keep the contents of the replace in the message window by setting this check box to OFF (max. 32000 lines).
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3-3-3 Search Menu - Instruction Find
This command searches for an instruction, user function or user FB for all ladder programs.

� Execute the [Instruction Find] command in the [Search] menu. The [Instruction Find] dialog box is displayed.

In the instruction list box, up to 10 instructions
are memorized as input history.

If the [Clear the Message Window] check box is set to ON,
new contents of the search are displayed below the contents
of the last search in the search tab screen of the message
window that shows contents of search.
This check box is ON by default.

� Enter an instruction that you want to search for in the instruction list box, and then click the [OK] button. The contents of the
search are displayed in the “Search” tab window of the message window. (circuit No. and device position)

* An instruction that you want to search for can be selected by using the “Guidance” on the dialog.

* If many instructions are found (e.g. LD instruction),
up to 32000 instructions can be displayed.
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3-3-5 Search Menu - Go to Line
This function is used to display a line with the specified line number. It can also be executed using the <Ctrl>+<G> key. When
you execute this command, the [Go to Line Number] dialog appears. In this dialog, enter the line number of the target line, with
a number from 1 to the maximum number of lines. After entering the line number, click the [OK] button. The specified line
appears at the top of the display window.

3-3-4 Search Menu - Section Find
This command searches for a section instruction by a section No. in a ladder program.

� Execute the [Section Find] command in the [Search] menu. The [Section Find] dialog is displayed.
Enter a section No. (0 to 65535) and click the [OK] button to start search.

� If the corresponding section instruction is found as a result of the search, the section No. is displayed on the top line of the
window.

If the corresponding section instruction is not found, the following error message appears.
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The PLC Functions menu offers the following commands:

<SPH package displays mode> <SPH individual displays mode>

� System Definition ............................. Displays and changes the system configuration.
� Copy System Definition ................... Copies a system definition (enabled only in package displays mode)
� Paste System Definition .................. Pastes a copied system definition (enabled only in Package displays mode)

* For more information about copy/paste of system definition, refer to paragraph 2-3-1.
� PLC Information ............................... Displays the PLC information.
� Memory Clear ................................... Clears various memories.
� Memory Transfer .............................. Transfers a program between the flash memory and the RAM (enabled only in SPB)
� User ROM ......................................... Loads a project, sets write protection, outputs a text, or loads/writes a tag project from

the user ROM (CompactFlash card) mounted on High-Performance CPU Type R to
this loader.

� Initial Data List ................................. Sets initialization data for various memories.
� Set Calendar .................................... Sets the calendar of the PLC.
� Type define / declare ........................ Performs definition and declaration (address assignment) of arrays and structures.
� Failure Diagnosis ............................ Displays the failure diagnostic information on the connected PLC.
� Password ......................................... Sets and changes a password in the PLC.
� Data Modify ....................................... Modifies PLC internal memory from a ladder window.
� Debug Functions .............................. Performs break point setting, step execution, forcible ON/OFF, Sampling trace and

conditional monitor.
� Network ............................................ Sets the route information of the loader network.
� Set Monitor Instance ........................ Sets the instance to be monitored.
� Redundancy Control ........................ Switches between Active CPU and Standby CPU.
� Run/Stop ........................................... Starts and stops PLC operation.

<SPB package displays mode> <SPB individual displays mode>
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� CPU Type .................................... Displays the PLC model (Standard CPU or High-Performance CPU).
� CPU Version ............................... Displays the version of the connected SX_CPU in the online mode.
� Program capacity of CPU .......... Displays the maximum program capacity (the number of steps) of the CPU.
� User program size ..................... Displays the size of the user program (the number of steps) based on the latest

compilation result.
� User ROM ................................... Displays the user ROM recognition status (Enable, Enable(Read only), Disable) by the

CPU.
� Operation Key mode .................. Displays the key switch status (Run, Term, or Stop) of the connected CPU.
� Running Status ........................... Displays the operation status (Run, Stop, Break) of the connected CPU.
� Error Status ................................. Displays the error status (Normal, Nonfatal fault, or Fatal fault) of the connected CPU.

If the ERR or ALM indicator of the CPU is lit, “Nonfatal fault?” or “Fatal fault?” is displayed.
If a fatal fault and a nonfatal fault occurs simultaneously, “Fatal fault?” is displayed.

� Password ................................... Displays the presence or absence (Set or None) of the connected of CPU.
* Access Level means “3-level access restriction function”. For more information, refer to “Appendix 4”.
� Trigger condition ........................ Displays the trigger condition setting (Set or None) of the connected CPU.
� Force ........................................... Displays the forced setting (Set or None) of the connected CPU.
� Condition monitor ...................... Displays the condition monitor setting (Set (access level) or None) of the connected CPU.
� Running time .............................. Displays the execution time and the present, minimum, and maximum values of the

execution period of all the tasks currently being executed

This information is not displayed if the CPU is in a stop in the offline or online mode.

The task execution information is displayed by clicking the measurement start button. When you click the Clear button,
measured values are cleared.

3-4-1 PLC Functions Menu - System Definition
This command is executed when defining the system configuration. The [System Definition] command of the PLC Functions
menu can also be executed by double-clicking the System Definition icon displayed in the project tree.

The PLC of the MICREX-SX Series contains the system configuration definition which defines PLC operations. Each program
window is provided with these system definitions. In the online window, the system definition displayed is the system
definition of the PLC connected with the personal computer. When you execute this command, the System Definition dialog
appears. The system configuration can be displayed and changed in this dialog.

Refer to Section 4, “System Definition” for details.

3-4-2 PLC Functions menu - PLC Information
This command displays PLC information.

� Execute [PLC Information...] command in the [PLC functions] menu.  The PLC information is displayed.
When online, the information of connected PLC is displayed; when offline, the information of the corresponding offline
window is displayed.  When online, the content of display is regularly refreshed.

3-4 PLC Functions Menu
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3-4-3 PLC Functions Menu - Memory Clear
This function clears specified area of CPU memory.

� Execute [Memory Clear...] command in the [PLC functions] menu.  The [Memory Clear] dialog box is displayed.  When online,
the memory of the connected PLC is cleared; when offline, the corresponding offline memory is cleared.  When offline, the
memory is prepared in the loader and used by the simulation function.

� Check the boxes for the memories to be cleared, and click the [OK] button.  The memories are cleared.

Note: This command can be executed only when the CPU is stopped with the key switch set at TERM.  The command cannot
be executed when the key switch is set at a position other than TERM.  When the CPU is running with the key switch set
at TERM, the memory clear operation is performed only when the confirmation message for stop is displayed and the
user permitted to stop the CPU.

� System Definition ................. When the system definition has been initialized, the online window is opened again.
� Program ............................... Clears the entire program (all Programs). When the program has been cleared, the

onlinewindow is opened again.
� ZIP file ................................... Clears the ZIP file data stored in the CPU. When the ZIP file is cleared, each name

(Program name, resource name, task name, etc.) and tag data are cleared.
� Input/Output Memory ............ Clears the entire data of the input/output memory (input and output memory). All bit registers

are set to OFF and all data items set to 0.
� Non Retain Memory ............. Clears entire data of the non-retain memory (standard memory). All bit registers are set to

OFF and all data items set to 0.
� Retain Memory ..................... Clears the entire data of a retain memory (retain memory). All bit registers are set to OFF and

all data items set to 0.
� User FB Memory ................... Clears the entire data of the user FB memory (instance memory for user FB). All bit registers

are set to OFF and all data items set to 0.
� System FB Memory .............. Clears the entire data of the system FB memory (instance memory for systems FB). All bit

registers are set to OFF and all data items set to 0.
� Resource initialization ......... When this option is checked, all the memories (including password) in the CPU are initialized.

Initialization may take up to about 2 minutes.
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3-4-4 PLC Functions Menu - Memory Transfer
Data is transferred between the built-in RAM of the SPB basic unit, built-in flash memory and flash memory card. When this
function is selected, the dialog box to specify the memory device of the source and destination is displayed. If the source is
built-in RAM, the built-in flash memory or flash memory card can be selected for the destination. If the source is built-in flash
memory or flash memory card, the built-in RAM can be selected for the destination.

�While being online with the SPB basic unit, execute the [Memory Transfer] command in the [PLC functions] menu. The
[Memory Transfer] dialog box is displayed.

� After setting the source and destination, click the [OK] button. The memory is transferred.
If the PLC is running, the dialog box to confirm that you are stopping the PLC is displayed.

�When you click the [Yes] button, the memory is transferred and the dialog box to inform you of the completion of the transfer
is  displayed. Click the [OK] button to exit the memory transfer function.
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3-4-5 PLC Functions Menu - User ROM
This command loads data from and saves data in the user ROM card (CompactFlash card) mounted on the High-performance
CPU applicable to user ROM cards. This command is provided with the following functions:
� Loading a project
� Write-protection
� User ROM utility functions
� Exporting user ROM file to text file
� Tag project load/write function

(1) Loading a project
Loads a project from the user ROM card mounted on the CPU module.

� Execute the [Load Project?] sub-command of the [User ROM] command of the PLC Functions menu in the online mode. A
confirmation dialog appears. Click the [Yes] button to load a project from the user ROM card mounted on the CPU.

* With V1.4.2.0 or later version, it is possible to store tag projects in user ROM card.  When both “zip file” and “tag project”
exist in the user ROM card that is installed in the PLC, the dialog box for confirming which of these to give priority is displayed.

(2) Write-protection
Makes the user ROM card mounted on the CPU write-protected.

<How to set write-protection>

� Execute the [Write-Protection?] sub-command of the [User ROM] command of the PLC Functions menu in the online mode.
The “Write protection” dialog appears.

� Check the [Write protection] box and click the [OK] button.  The [Set password for write protection] dialog box is displayed.
Password can be set in the range from 6 to 32 characters.  Single-byte alphanumeric characters and “+”, “-”, “=” and “/”
symbol characters can be used for this purpose.

* Even when the user ROM card is write-protected,
by setting the [Allow to write by F_WRITE] box to
ON, data using an application program
(F_WRITE) can be written to it.

� Set the password, and then click the [OK] button.
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<How to cancel write protection>

� In online mode, execute the [Write Protection] command in the [User ROM] pull-down menu under [PLC functions], and the
[Write protection] dialog box will be displayed.  On this dialog box, check the [Write protection] box.  The following dialog box
is displayed.

� Enter the set password and click the [OK] button. Then, write protection is canceled.

* When the user ROM is write protected, the following functions are disabled:

[Online window]
� Program/system definition/ZIP file transfer and clear (restricted by PLC)
� Password registration/cancellation (restricted by PLC)
� Resource initialization
� Memory clear and online

[User ROM utilities]
� Program/system definition/ZIP file download and clear
� Password registration/cancellation
� Formatting

(3) User ROM utility functions
Downloads and uploads a project and clears and formats memories for the user ROM card mounted in a PC card slot of the
personal computer.

1) Downloading

Downloads the project currently opened in the loader to the user ROM card.

� Execute the [User ROM Utility?] sub-command of the [User ROM] command of the PLC Functions menu. The “User ROM
Utility” dialog appears.

* With version V2.3.0.0 or later, system configuration
information can be saved as a ZIP file in the CPU.
This function allows you to restore a module name
registered in the system definition from the ZIP file in
the CPU module when connected online.

*
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� Select the drive mounting the user ROM card and the data to be loaded and then click the [OK] button. A download confirmation
dialog appears. Click the [Yes] button to start downloading. Upon completion of downloading, the following dialog appears.

Note 1: Downloading to write-protected user ROM card is not possible. Write-enable the card before downloading.
Note 2: Downloading to password-registered user ROM card is not possible. Enter a password before downloading.

2) Uploading

Loads a project in the user ROM card to the loader.

� Click the [Upload] tab in the “User ROM Utility” dialog, the Upload tab page appears. Select the drive mounting the User
ROM and then click the [OK] button. The project in User ROM is loaded and then opened as a new project.

3) Maintenance

Clears projects in the user ROM card, and sets, cancels, and changes the password, as well as write-protects or write-
enables and formats the card.

� Click the [Maintenance] tab in the “User ROM Utility” dialog. The Maintenance tab page appears. Select the drive mounting
the user ROM card and then perform each operation.
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<Clear>

Clears project data in the user ROM card (program, system definition, and Zip file).

� Click the [Clear] button in the Maintenance tab page. The “Clear” dialog appears.

� Set the check box for each item to be cleared to ON and then click the [OK] button.

<Setting, changing, canceling password>

Sets a password for the user ROM card and protects operations other than a formatting.

� Click the [Password] button in the Maintenance tab page. The “Set Password” dialog appears.

� Enter a new password (with 6 to 32 alphanumeric characters) and then click the [OK] button.
When password registration is completed, the following dialog appears.

� If a password has already been registered in the user ROM card, the following dialog appears when you click the [Password]
button.

� Enter the registered password and then click the [OK] button. The “Change/Delete Password” dialog appears allowing you
to cancel or change the password.
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<Format>

Formats the user ROM card. The card is formatted in the DOS format and a project folder is created.

� Click the [Format] button in the Maintenance tab page. The “Warning” dialog appears.

� Click the [OK] button. The “Format” dialog appears. Check items and then click the [Start] button.

Note: Do not select the [Quick (erase)].

� Click the [OK] button. The following “Confirm” dialog appears.

Note: The WindowsXP-based loader does not operate normally
with the CPU software versions earlier than V59.
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4) Security

Setting to the user ROM card, for the write protection/cancel write protection .

� Click the [Security] tab in the “User ROM Utility” dialog, indicating to the display for the setting to the write protection.
Select to the drive, the user ROM card is insetted.
When does not set the write protection, the [Write protection] check box is “OFF”.

� Check the [Write protection] box and click the [OK] button.  The [Set password for write protection] dialog box is displayed.
Password can be set in the range from 6 to 32 characters.  Single-byte alphanumeric characters and “+”, “-”, “=” and “/”
symbol characters can be used for this purpose.

� Set the password, and then click the [OK] button.

<How to cancel write protection>

� In online mode, execute the [Write Protection] command in the [User ROM] pull-down menu under [PLC functions], and the
[Write protection] dialog box will be displayed.  On this dialog box, check the [Write protection] box.  The following dialog box
is displayed.

� Enter the set password and click the [OK] button.  Then, write protection is canceled.

* Even when the user ROM card is write-protected,
by setting the [Allow to write by F_WRITE] box to
ON, data using an application program (F_WRITE)
can be written to it.
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(4) Exporting user ROM file to text file
Exports a file (data) in the user ROM card using the High-Performance CPU module applicable to user ROM cards.

�When the user ROM card is mounted on the High-Performance CPU module and access to user ROM is enabled
(UROM_LED lit), select the [Export User Files] sub-command of the [User ROM] command from the PLC Functions menu.
The “Export user ROM File to Text File” dialog appears.

� Specify “Export To” user file and “Export From” text file and then click the [OK] button. The specified user file is exported to the
specified text file (the binary data in the user file is loaded and then converted to text data).

* For each of “Export To” and “Export From”, up to 20 files are memorized as history information.

Note: If the specified “Export To” file does not exist, an error results.

<Format of output text file>

The format of the output text file is shown below. It can be displayed using any text editor.

Binary expression ASCII expression
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(5) Writing/Importing of tag project
This function writes or imports a zipped tag project into the user ROM card that is installed in the CPU.

<Writing a tag project>

� Execute the [Write Tag Project] command in the [User ROM] pull-down menu under [PLC functions], and the tag data and
line comment data of the currently opened project are zipped and written in the user ROM card.

<Importing a tag project>

� Execute the [Import Tag Project] command in the [User ROM] pull-down menu under [PLC functions], and the [Import Tag
Project] dialog box will be displayed.

� Check the boxes for the tag files that you want to import.  When you want to import also the line command data / program
name, check the [Import line command data] box / [Import program name] box and check the [OK] button.

Note: The error massage is displayed, in the case already some program name exists when the tag project import.
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3-4-6 PLC Functions Menu - Initial Data List
You can set initial values for the output parameters of standard memory (M), retain memory (L), user FB instance memory (F)
and user FB memory.  For user FB memory, this setting can be made only by word address.  When a PLC application program
is started (during the first scan), the initial values specified by this dialog box are set.

� Execute [Initial Data List...] command in the [PLC functions] menu.  The [Initial Data List] dialog box is displayed.  For global
devices and the local devices for the currently displayed program, the set initial values are displayed in the dialog.

� Add ..................... Adds a device to the Initial Data List. When you click the [Append] button, the Initial Value Edit? dialog
appears. When you enter device addresses and tags for initial value setting and then click the [OK]
button, they are added to the Initial Data List.
The Retain Memory check box in the Initial Value Edit dialog is enabled only when the device of the
instance memory for user FBs is specified. When you check the retain memory, the specified address
can be used as retain memory. It can also be specified as retain memory without setting initial values.

� Modify ................. Changes the data at the current cursor position in the Initial Data List. When you click the Modify button,
the Initial Value Edit? dialog appears in which the data at the current cursor position is displayed. When
you change data and then click the [OK] button, the data in the Initial Data List is changed.

� Delete ................ Deletes the data at the current cursor position in the Initial Data List.
� Clear .................. Clears the entire data in the Initial Data List.
� Show .................. Parameter Adds all the output parameters of function blocks to the List without initial values. Set initial

values for output parameters as required.
� Input Mode ......... Selects “Int” (decimal) or “Hex” (hexadecimal) for initial values.

Initial value data can be transferred to the PLC using the transfer function.
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3-4-7 PLC Functions Menu - Type define / declare
(1) Specifications of array and structure

Note 1: Definitions and declarations of arrays and structures are stored in the program memory of the CPU. The amount of
program memory used by arrays and structures is obtained by the following equation.

[Equation]
(Program memory used by arrays and structures)
= 4 + (No. of array definitions) x 5 + (Structure 0   No. of steps of definition) + ...... + (Structure n  No. of steps of definition)
+ (No. of declarations of arrays and structures) x 7
* No. of steps of structure definition = (No. of members) + 3 (steps)

[Sample calculation]
Supposing,
 � No. of array definitions: 3,
 � Structure 0 (No. of members: 10)
 � Structure 1 (No. of members: 5)
 � No. of declarations of arrays and structures: 5
then
(Program memory used by arrays and structures) = 4 + (3 x 5) + (10 + 3) + (5 + 3) + (5 x 7) = 75 steps

Note 2: The system memory (SM), timer (T), counter (C), integrating timer (TR) and step control (SC) are not available.

Note 3: Information about definitions and declarations of arrays and structures is stored in the last user function No. which the
CPU can obtain (SPH300: No. 511) and then in the program memory of the CPU. Therefore, when using arrays and
structures, the last user function No. (SPH300: No. 511) cannot be used.

Item Specification

Nesting depth 1 level (array of arrays, array of structures)

Array

Max. No. of difinitions 512 (User program: 256, Expansion FB provided by Fuji: 256) (See note 1.)

Max. No. of elements 32767

Element No. specification
1 to specified No. of elements No. of elements: max. 32767
* When element No. specification exceeds the range, upper limit or lower limit data is

accessed.

Max. No. of declarations
583 (See note 1.)
* "Declaration" means assigning a defined array to an address.

Data type Bit, word, double word, array (defined by user)

Array name ARY_n n : array definition No. (from 0 (decimal))

Available memories

Entire program: I/O memory (W, Y), standard memory (M), retain memory (L)

Inside of user FB: I/O memory (X, Y), standard memory (M), retain memory (L),
memory for user FB (F), parameter (V), (I/O parameter only)

Structure

Max. No. of difinitions 512 (User program: 256, Expansion FB provided by Fuji: 256) (See note 1.)

Max. No. of members 255

Data type of member Bit, word, double word, array (defined by user)

Structure name STR_n n : structure definition No. (from 0 (decimal))

Member name specification

Member name indicating sign + member definition No. (from 1)
* The member name definition No. is automatically assigned when the structure is defined.

Member name identifying sign: R (bit), WR (word), Double word (DR), Array (ARY_n)

Max. No. of declarations
584 (When No. of members: 1 and No. of structure definitions: 1) (See note 1.)
* "Declaration" means assigning a defined structure to an address.

Available memories
(See note 2.)

Entire program: I/O memory (W, Y), standard memory (M), retain memory (L)

Inside of user FB: I/O memory (X, Y), standard memory (M), retain memory (L),
Memory for user FB (F), parameter (V), (I/O parameter only)
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(2) Array definition
� Execute [Type define / declare...] command in the [PLC functions] menu. The [Data type Define / Declare] dialog box is

displayed. This dialog box contains the [Array definition], [Structure definition] and [Array/Structure Declaration] windows. The
[Array definition] window is initially displayed. The windows can be switched by clicking the corresponding tab.

� Click the [Add] button on the dialog box to display the [Array] dialog box.
After setting “Number”, “Index range” and “Data length”, click the [OK] button. The array is defined.

* For “array of arrays”, enter an array No. in this box.
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(3) Structure definition
� Execute [Type define / declare...] command in the [PLC functions] menu. The [Data type Define / Declare] dialog box is

displayed. Then, click the [Structure definition] tab to display the [Structure definition] window.

� Click the [Add] button on the dialog box to display the [Structure] dialog box.
Set “Data length” for each member and then click the [OK] button. The members are added to the member list.
After completing addition of members, click the [OK] button. The structure is defined.

For “array of structures”, enter an array No. in this box.

On the member list, the members of the
“structure” selected by the structure name.
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(4) Array/Structure declaration
Assignment of a defined array or structure to an actual address is called “declaration”.

� Execute [Type define / declare...] command in the [PLC functions] menu. The [Data type Define / Declare] dialog box is
displayed. Then, click the [Array/Structure Declaration] tab to display the [Array/Structure Declaration] window.

� Click the [Add] button on the dialog box to display the [Declare] dialog box.
Enter an array or structure to be used and the top address of the memory to which the array or structure is assigned.
Clicking the [OK] button completes declaration.

* For a double-word array and structure, assign to an
even address; for a bit array, to bit 0.
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(5) Representation in programs
On application programs, arrays and structures are represented as shown below.

(6) Importing array/structure definition
From other project, array/structure definition that has already been defined is imported.

� Click the [Import] button on the [Data type Define / Declare] dialog to display the following dialog.

[Array]

WM100[5]

Top address

Array element No.

[Array of arrays]

WM100[5][WM0]

Top address

Array element No.

Array element No.

[Array of structures]

WM100. WR2[3]

Top address

Member name

Array element No.

[Structure]

WM100. WR2

Top address

Member name
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� Select a project and click the [Open] button. Arrays and structures that are defined in the selected program are displayed.

� Select arrays and structures to be imported and click the [OK] button. The following confirmation dialog is displayed.

� Click the [OK] button to import the arrays and structures to the [Data type Define / Declare] dialog.

Displayed like this if the imported definition overlaps
the existing arrays and structures.

* Even if you click the [OK] button in a state above, an error message appears and importing is not completed.
Change the overlapping number or delete the definition to eliminate the overlap.
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<Renumbering definition>

� Select one of the overlapping definitions whose number you want to change and click the [Renumber definition] button.

Definition to be renumbered.

� Enter a new number on the [Renumber definition] dialog and click the [OK] button. The definition number is changed.

*  The changed No. is also reflected in the
array/structure declaration.
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* Users can change definition numbers or delete definitions of expansion FBs.

3-4-8 PLC Functions Menu - PLC Calendar
This command sets time to the built-in calendar of the PLC. This function can be used only in the online window.

When the Set Time & Date dialog appears in which the present time of the PLC is displayed.
When you set time and date and then click the [OK] button, they are transferred to the PLC and then registered to the built-in
calendar of the PLC. This time is retained and updated by the PLC even if the power of the PLC fails. The allowable setting
ranges from 1970/01/01 00:00:00 to 2069/12/31 23:59:59.

3-4 PLC Functions Menu

(7) Array/structure number
Array/structure numbers are classified as shown in the table below to avoid overlap between numbers used in “user program”
and numbers used in “expansion FB” provided by Fuji.

Item User program Expansion FB

Array/structure No. that can be defined 0 to 255 256 to 511

Array/structure No. that can be used for declaration 0 to 511 0 to 511

Array No. that can be specified for data type of array 0 to 511 0 to 511

Array No. that can be specified for data type of
structure member

0 to 511 0 to 511
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3-4-9 PLC Functions Menu - Failure Diagnosis
When you execute this command, the Failure diagnosis dialog appears. This command can also be executed from the pop-up
menu which is displayed by click the right mouse button on Resource of the project tree. The failure diagnostic display function
is a function which displays the failure status of the PLC.

(1) Display overview
The failure diagnostic function consists of the system configuration display section and the diagnostic information display
section.
The system configuration display section displays the connected module section where a failure has occurred in visual form.
The diagnostic information display section displays details of failure information, etc.
The display contents are refreshed (updated) automatically at fixed intervals.

� System configuration display section ........ Displays the system configuration in tree form. A mark is displayed on the icon
at failed positions.
(Fatal fault: , Nonfatal fault: , Fatal and nonfatal faults: )

� Diagnostic information display section ..... Displays the system RAS and detailed RAS as text data.
� Configuration display selection .................. Select “Bus connection composition” or “User definition composition.” The

default setting is “User definition composition.”
� History information selection ..................... Select “Current RAS”, “1 previous generation”, “2 previous generations”, and

“3 previous generations.” The default setting is “Current RAS.”
� [File save] .................................................... Saves the RAS information file.
� [File view] ..................................................... Displays the RAS information file.
� [File delete] .................................................. Deletes the RAS information file.
� [Check configuration] .................................. Checks whether the module configuration registered in the system definition

matches the actual configuration and indicates the mismatch item.
� [Failure analysis] ......................................... Analyzes the status of the PLC system and displays error description, location

and remedies.
� [Close] ......................................................... Closes the Failure diagnosis dialog.
� [Help] ............................................................ Displays Help of the failure diagnostic function.

Configuration display selection History information selection

System configuration display Diagnostic information display

(System RAS, detailed RAS)

RAS information file operation
[Check configuration] button

[Failure analysis] button

Performs a text search in [Level Contents] field.
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(2) System configuration display section
The system configuration display section has the following two modes which can be selected from the configuration display
selector combobox.

1) User definition composition

Displays the system configuration information, specified in the system definition and then downloaded by the user, in tree form.
Data is displayed by uploading the system configuration information from the CPU.

2) SX Bus connection composition

Displays the configuration of modules connected with the SX bus in tree form.
Data is displayed by selecting “Detailed RAS - Read all module information” from CPU.
Only modules directly connected with the SX bus are displayed in order of the SX bus station number.
For the CPU and processor link module, the SX station number and the CPU number are displayed.

<Display specifications>

� If a fault is present, a mark corresponding to the degree of the fault is displayed on the icon.
(Example: Fatal fault: , Nonfatal fault: , Fatal and nonfatal faults: )
� Icon display for modules is the same as that for the system definition.
� “Base board” and “Power supply” are not displayed.
� The default setting of the configuration display selection is “User definition composition.” If “User definition composition”

is not present (if the system definition has not yet been downloaded), “SX bus connection composition” is displayed.
� At the time of initial display, the CPU module (CPU number: 00) is selected.
� If communication is disconnected during RAS information display, a blank is displayed.

Configuration display selection

System configuration display
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(3) Diagnostic information display section
The failure diagnostic display section displays detailed fault information for the module selected in the system configuration
display section.

<Display specifications>

The display contents are grouped by tabs. The item of each tab depends on the selected module.
The starting tab is “System RAS” which displays the system RAS information in the CPU module (CPU number: 00) at the
time of initial display.
Tabs are displayed in one or two rows depending on each module.
If communication is disconnected during RAS information display, message “Communication error” appears.
“Current RAS”, “1 previous generations”, “2 previous generations”, or “3 previous generations” is selected depending on
the RAS history. The default setting is “Current RAS?.”

<History display>

When the previous RAS (“1 previous generation”, “2 previous generations”, or “3 previous generations”) is selected
as RAS history, the fault history data is loaded from the CPU and then displayed.
It there is no history data (all 0s), the following display results.

<Message data display items>
RAS with “message + value” : Same display as the case where there is history data.
RAS with “message only” : “No data” is displayed.

<Binary data display items>
Displays all 0s.

<Search function>

The text search combobox and the search start button are provided at the bottom of the diagnostic information display
section, allowing text search for the contents currently displayed in the diagnostic information display section.
The search start position is the row at the current cursor position in the diagnostic information display section. When the
cursor is not displayed, it is the top position.
The search direction is Downward only. The cursor move to the row containing a matched character string.
Each item name of the selected tab is automatically inserted in the “Text Retrieval” list box, making it easier to jump to
each item.
When search character strings are entered, up to five search character strings are memorized, allowing you to perform
search again using a previously used search character string even after activation of failure diagnosis next time. When the
number of search character strings exceeds five, the oldest one is deleted.

History information selection

Diagnostic information display

(System RAS, detailed RAS)
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(4) RAS information file operation
The information in the Failure diagnosis dialog can be saved in a disk file. The RAS information file can be displayed and
deleted. Each operation can be performed using each file operation button in the Failure diagnosis dialog.

1) File save

This button is used to save the data displayed in the Failure diagnosis dialog in a file.

� Click the [File save] button in the Failure diagnosis dialog. The Save RAS File dialog appears.
� Specify the target location and each item and then click the [Save] button. The data are saved in the specified file.

<Preservation item>

Specify the data to be saved using “System configuration information”, “Diagnosis details”, and “Dump list of system memory.”
By default, “User definition” is selected for “System configuration information” and “Selection module” is selected for “Diagnosis
details”.

� System configuration information
The contents in the system configuration display section are saved. Select [All], [User definition], or [SX bus connection
composition].
� Diagnosis details

The contents in the diagnostic information display section are saved. Select [All modules], [Selection module], or [Only the
display data].
� Dump list of system memory

System memory data are saved as hexadecimal text data.
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2) File view

This button is used to display the contents of a RAS information file.

� Click the [File view] button in the Failure diagnosis dialog. The “View RAS file” dialog appears.
� Specify a target RAS information file and then click the [View] button. The specified RAS information is displayed.

3) File delete

This button is used to delete a RAS information file.

� Click the [File delete] button in the Failure diagnosis dialog. The “Delete RAS file” dialog appears.
� Specify a target RAS information file and then click the [Delete] button. The specified RAS information file is deleted.
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(5) Configuration check function
If the system configuration registered in the system definition does not agree with the actual configuration, a fatal fault occurs
in the system, which cannot start to run. In this case, a “System configuration error” message is displayed on the system RAS.
To operate the SX system normally, it is necessary to match the system definition with the actual configuration.

� Click the [Check Configuration] button on the [Failure diagnosis] dialog box. The [Check Configuration] dialog box is displayed.
� On the dialog box, the contents of the module registration in the system definition and the actual configuration are

displayed. If there is a mismatch between them, the mismatch spot is displayed in red.

3-4 PLC Functions Menu

4) Format of save file

The file name and data formats for RAS information files are shown below.
The file name is “****.RAS” (**** is specified by the user) and data are all text data.
Data are saved in order of the configuration information data and the diagnostic information data.

<Save data>

System configuration type "SX bus connection composition" or "User definition"

Configuration information data

Tree information title "** tree information **"
Row 1 data
Row 2 data
:
:

Last row data

Diagnostic information data
(for each tab information)

Diagnostic information title "** Diagnostic Information **"
RAS history (Current, 1 previous generation, 2 previous generations, and 3 previous
generations)
1st tab name
Data in the 1st tab
2nd tab name
Data in the 2nd tab
:
:

Last tab name
Data in the last tab
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Module configuration registered in the system definition Actual module configuration

* The above example shows that a module that has not been registered in the system definiton exists in the actual configuration.

<Differences of SX bus station numbers between user definition composition and bus connection composition>
If the SPH system is reset when a system configuration error occurs due to a configuration definition mistake or module
failure, etc., numbers beginning with 1 are assigned to the SX bus stations in their connected order on “bus connection
composition” box.
Note that if the CPU or power supply is reset due to a system configuration error after arbitrary SX bus station numbers are set
as shown in the figure below, the SX bus station numbers of “user definition composition” do not match those of “bus
connection composition”.

In the example below, different SX bus station numbers are displayed as follows:
DC/AC input 16 points User definition composition: 10 Bus connection composition: 1
Relay output 16 points User definition composition: 20 Bus connection composition: 2
Sink-type output 16 points User definition composition: 30 Bus connection composition: 3
Ethernet module User definition composition: 1 Bus connection composition: 4

Mismatch configuration

<Measures>

1) To match “user definition composition” with “bus connection composition”, it is recommended to assign SX bus station
numbers in their connected order.

2) Even if an error occurs in the system during operation, “user definition composition” matches “bus connection composition”
until the system is reset. Perform failure diagnosis before resetting the system.
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(6) Failure analysis function
This function automatically analyzes the status of the PLC system from the system memory and RAS information in the CPU
and displays the error description, cause, remedies and location.

Note: This function can be used only with SPH 300 series of CPUs.

1) Example of displaying failure analysis results

Click the tab to change over the window.

Error description display area

All the errors detected in the PLC system are displayed.
By clicking each error description, the remedies, fatal failure
information and failure position of the error are displayed.

Remedy display area

The probable causes and remedies of the error selected on
the “error description display area” are displayed.

Fatal failure information display area

If the error is a fatal failure, its name, cause and time of
occurrence are displayed.
If the error is a nonfatal failure, this area is not displayed.

Failure position display area

The failure position is displayed.
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2) Personal computer environment necessary for the failure analysis function

The following software is necessary to use the failure analysis function.

Item Specifications

Operating system

Windows95/98/ME Japanese or English Edition

Windows2000 SP3 or later Japanese or English Edition

WindowsXP SP2 or later Japanese or English Edition

Other software
.NET Framework 2.0
Microsoft Internet Explorer 6.0 SP1
Microsoft Data Access Components (MDCA) 2.8

Note 1: The failure analysis function is not available under Windows NT.

3) Display specifications of the failure analysis screen

Click the [Failure analysis] button to perform failure analysis and display the result.
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Note 1: If two or more fatal failures occur, only the description of the first detected error is displayed on the “fatal failure” tab
window.

<Display specifications of the failure analysis screen>

1) Icon

If two or more errors occur at the same time, description of all the
errors are displayed in the “error description display area.”
In the “Remedy display area” and “Fatal failure information/failure
position display area,” information about the currently selected
error is displayed.

2) Display color

Icon Description

Fatal failure has occurred.

Nonfatal failure has occurred.

Both fatal and nonfatal failures have occurred.

Set as "no equipment" in the system definition.

Display color and example Description

Backgorund color: yellow, Text color: black This module is disconnected. (or fatal failure has occured.)

Backgorund color: gray, Text color: red This module is registered in the system definition, however, does not exist
in the actual configuration.

Backgorund color: gray, Text color: blue This module exists in the actual configuration, however, is not registered in
the system definition.
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4) Automatic execution of failure analysis

If an error occurs in the system, failure analysis can be automatically executed by simply clicking the [Failure diagnosis]
command in the [PLC Functions] menu.

<Setting procedures>

� Execute the [MICREX-SX Environment...] command in the [Options] menu. The [Environment Options for MICREX-SX] dialog
box appears. On this dialog box, click the [Function setting] tab to display the following window.

� Set the [When the breakdown occurs, the failure analysis is automatically started.] check box to ON and click the [OK] button.
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3-4-10 PLC Functions Menu - Password
The password function of the CPU allows you to specify a character string consisting of 6 to 32 characters including
alphanumeric characters (not case-sensitive) and symbols (+, -, =, /) as a password for accessing the CPU. When a
password is specified, it is retained in the CPU until it is deleted or changed. Unless a correct password is entered, the online
window of the CPU with password setting cannot be opened. The password function can be used only in the online window.

<When no password is set for the CPU>

� Execute [Password...] command in the [PLC functions] menu.  The [Set Password] dialog box is displayed.

� Enter a character string of 6 to 32 alphanumeric and/or symbol characters in the [Enter New Password] box, and click the
[OK] button.  The password is set as a new password for the CPU.  Once the online window is closed, it is necessary to
enter the password to open the online window for the CPU.

<When a password is set for the CPU>

� Execute [Password...] command in the [PLC functions] menu.  The [Change/Cancel Password] dialog box is displayed.

� On this dialog box, you can change or cancel an already set password.  To cancel a password, turn on the optional [Cancel
Password] button, and click the [OK] button.  The password is deleted from the CPU, and you can access the CPU without
password.  To change an already set password, turn on the optional [Change Password] button, enter a new password,
and click the [OK] button.  The new password is transferred to the CPU.

Note: When you open the online window of the CPU with password setting, a dialog with message “PLC is Password
Protected” appears. When you click “Clear CPU memory”, all the memories including the password are cleared.
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3-4-11 PLC Functions Menu - Data Modify
Data memory of the PLC can be modified with a ladder window displayed.

� Execute the [Data Modify] command in the [PLC functions] menu or right-click on the ladder diagram and execute the [Data
Modify] command in the right-click menu. The [Data Modify] dialog box is displayed.

� In the “Address” box, specify the address whose data you want to modify and then enter a data value in the “New Value” box.
Clicking the [Write Value] button executes the modification of the PLC internal memory.

<Data format to be entered into new  value>

Data type Input range Input example

BIT(BOOL type) ON, OFF ON, OFF

INT type -32768 to 32767 INT#123, 123

DINT type -2147483648 to 214748647 INT#123, 123456

UINT type 0 to 65535 UINT#123

UDINT type 0 to 4294967295 UDINT#123, 4294967295

REAL type -2128 < N <= -2-126, 0, 2-126 <= N < 2128 1.23, 1.3E-5

TIME type
0ms to 4294967295ms
0ms to 49d17h2m47s295ms

TIME#10s, 10000

DATE type 1970-01-01 to 2106-02-07 2000-12-31, DATE#2005-04-01

TOD type 0:00:00 to 23:59:59 17:15:00, TOD#12:12:12

DT type 1970-01-01 to 2106-02-07-6:28:15 2005-2-14-12:23:00, DT#2005-11-03-00:10:03

STRING Impossible to input -

WORD H0000 to HFFFF H1234

DWORD H00000000 to HFFFFFFFF H12345678
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Function Specification
SPH300
/200

SPH2000

Multi-point breakpoint Up to 32 points of break points can be set for one project. X O

Logical concatenation of break stop
condition

For one device, up to 4 points of break stop conditions by a
specified value of data can be concatenated with AND or OR.

X O

Break stop
condition

Program address break After an instruction set as the breakpoint is executed. O O

BOOL data match
(=1, =0)

=1: When the specified BOOL variable is turned ON
=0: When the specified BOOL variable is turned OFF

O O *

Rising/falling edge of
BOOL data

Rising edge: When the specified BOOL variable is changed from
OFF to ON.

Falling edge: When the specified BOOL variable is changed from
ON to OFF.

O O *

Data comparison match
When the specified data meets the specified conditions
Comparison conditions (=, , <, >, <=, >=)

O O *

Reading/ writing to data
(READ/WRITE)

After reading to the specified data
Afetr writing to the specified data

O X *

3-4 PLC Functions Menu

3-4-12 PLC Functions Menu - Debug Functions
The debugging functions can be used only in the online mode. The debug functions include break point, step Execution,
forced ON/OFF, program operation, condition monitor, and sampling trace.

This command offers the following sub-commands:
� Break Point ............................................... Sets and cancels a break point.
� Step Execute ............................................. Executes the program step by step.
� Force On/Off .............................................. Sets and cancels forced ON/OFF.
� Program Operation .................................. Selects and executes a program in the program.
� Condition Monitor Setting ......................... Registers the condition monitor.
� Condition Monitor Result Display ............ Displays the result of the condition monitor.
� Trace Execution ........................................ Sets and executes sampling trace.
� Trace Display ............................................ Loads the result of sampling trace from the CPU and displays it.

(1) Break Point
The break point function stops execution of the PLC under specified conditions. There are two different break point functions,
Program Address Break and Data Access Break, and one break point can be set for each. Break points for Program Address
Break and Data Access Break can be specified at the same time.
The break point function cannot be performed if the key switch of the CPU is set to other than TERM or if the program changed
after online connection has not yet been transferred. Be sure to transfer the program to the PLC.

<Functions of break point>

* When a specified device is executed, a judgement on the condition is made.

<Program address break>

Program Address Break is a break point for the instruction position. When you select this function, the program is executed
using the cursor position as a break point. For the instruction specified as a break point, the background color changes
indicating that it is a break point position.

� Select a device to be a berek point from the online program window (edit mode), and execute [Program Address Break...]
command in the [Break Point] submenu under [Debug Functions] in the [PLC functions] menu.  A break point is set. If the set
point is executed, the program is stopped.

* If the PLC is reset, break point settings are canceled.
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<Data access break>

Devices which can be specified as a trigger point include input/output memory, non-retain memory, retain memory, system
memory, instance memory for user FBs, and instance memory for systems FB (T, C, TR).

� Select a device from the online program window (edit mode), and execute [Data Access Break...] command in the [Break
Point] submenu under [Debug Functions] in the [PLC functions] menu.  The [Data Access Break] dialog box is displayed.

<SPH300/SPH200>

� Enter a trigger point and stop condition, and click the [OK] button. Break point setting is performed. For the set conditions,
up to 16 points are retained as history. The history data can be selected using the [List Select] button.

<SPH2000>

� For SPH2000, set a circuit position and stop condition of a device to be specified as a break point.
Click the [Get Cursor position] button to display the program name, circuit number and device of the cursor position. Set a
stop condition and click the [Entry] button. The registration status can be checked on the [Trigger point list] screen.
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<About data access break of SPH 2000>

For SPH 2000, when a device of a specified circuit position is executed and it satisfies the stop condition, the program is
stopped. Even if there are multiple same devices (M2) as shown in the figure below, the break condition is the time when M2 is
on when the specified circuit position, “circuit No. 2-1”, is executed.

<Break point reset>

When you select this function, the Break Point Reset dialog appears. When you check the break point to be canceled and then
click the [OK] button, the specified break point is canceled.

<Logical concatenation of break points> (for SPH2000 only)

With SPH2000, up to 4 points of break stop conditions by a specified value of data can be concatenated with AND or OR for
one variable.

<Concatenation setting example>

The procedure for setting a break condition to stop the program when the device “WM2” is 1000 or 2000<=WM2<=3000.

�While monitoring a program, execute [Data Access Break...] command in the [Break Point] submenu under [Debug
Functions] in the [PLC functions] menu. The [Break point] dialog is displayed.

� Place the cursor at the position where you want to set a break point, and click the [Get Cursor position] button. The device of
the cursor position is displayed in the “Trigger point” box.

Cursor

* Both the monitor screen and the “Break point” dialog are enabled.
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� Select “= ” for the stop condition, set the compared data at “1000”, and then click the “Entry” button.
In the same manner, set the following two break conditions:

Stop condition: “>=”,  Compared data: “2000”

Stop condition: “<=”,  Compared data: “3000”

� Next, concatenate the break conditions on the “Break point” dialog.
For setting 2000<=WM2<=3000, select two conditions as shown below and click the “AND” button. The concatenated
conditions are added.
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� Also, for setting the state in which WM2=1000 or 2000<=WM2<=3000 as a break condition, set the two conditions as shown
below and click the “OR” button.

� By setting a check box to ON or OFF, the break condition can be enabled or disabled.

(2) Step Execute
This command executes steps in units of instruction, starting from the break point.

�While program operation is stopped by [Break Point] command, execute [Step In] or [Step over] command in the [Step
Execute] submenu under [Debug Functions] in the [PLC functions] menu.  Each time either command is executed, one
instruction is executed.

The background color at the step execution position changes during step execution. The background color can be specified
using the [Environment Options for MICREX-SX] dialog of the Options menu.
To stop Step Execute and continuous CPU operation, execute individual continuation of the start/stop function of the PLC.

� Step In ......................... When the position for step execution is a user function or user FB, control is transferred to the top
of the user function or user FB.

� Step Over .................... When the position for step execution is a user function or user FB, control is transferred to the
position next to the user function or user FB.

(3) Force On/Off
This command forcibly sets data in I/O memory. The forced ON/OFF setting function can be used only when the data sheet is
selected.
For devices to which forced setting is applied, an asterisk (*) is displayed to the left of the address for data display.

� Forced Set .................. When you select this function, the Forced Setting? dialog appears. Enter a value and then click the
[OK] button. Forced setting is performed for the device at the current cursor position.

� Forced Reset .............. When you select this function, a confirmation dialog appears. When you click “Yes”, forced setting
applied to the device at the current cursor position is canceled.

� Forced all Reset ......... When you select this function, a confirmation dialog appears. When you click “Yes”, all the specified
forced settings are canceled.
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(4) Program Operation
Program Operation is a function which selects and performs one or more programs assigned in one resource (CPU module).
Debugging work can be done for each program using this function.

Note: The Program Operation function cannot be used during execution of other test functions (break point, step execution,
condition monitor). However, other test functions can be used after execution of the Program Operation function.

� Execute the [Program Operation] sub-command of the [Debug Functions] command of the PLC Functions menu. The
“Program Operation” dialog appears.

� Programs currently operating are displayed in the Valid Program field. Put programs to be operated in the Valid Program
field and programs not to be operated in the Invalid Program field, then click the [OK] button.

Note: The programs moved to the [Invalid Program] box are canceled by power reset (OFF to ON) of the CPU module and then
moved to the [Valid Program] box, allowing operation of all the programs assigned to the resource.
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(5) Condition Monitor
The Condition Monitor function is a function which captures word data of 20 blocks (up to 512 address points) based on the
specified trigger point condition. Unless trigger point condition is registered in the “Condition Monitor Setting” dialog, condition
monitor result display cannot be executed.

<Available monitoring stop conditions>

� Address block ................. Word data of up to 20 blocks (up to 512 address points) can be specified. Enter the start address
of each block in the Start box and the end address in the End box. Since only the word address
is possible, it is necessary to convert the bit address to the word format (WX, WY, WM, etc.) The
start address and end address of each address block must be the ones from the same PLC
data module. When you click the [Clear All] button, the address edit boxes are cleared.

� Trigger Point .................... Specify a device for triggering the condition monitor. Only the bit address can be specified.
� Trigger Condition ............ Specify the condition for triggering the condition monitor (rising, falling). With Rising, the condition

monitor is activated when the address of the trigger point changes from OFF to ON.
With Falling, it is activated when the address of the trigger point changes from ON to OFF.

� Reset Trigger .................. To stop the condition monitor, click the [Reset Trigger] button.

When the above settings are completed, click the [OK] button to transfer the condition monitor settings to the PLC. When the
trigger condition is met, the condition monitor is executed immediately.

Address block

* When a specified device is executed, a judgement on the condition is made.

<Condition monitor setting for SPH300 and SPH200>

� Execute the [Condition Monitor Setting] sub-command of the [Debug Functions] command of the PLC Functions menu. The
“Condition Monitor Setting” dialog appears. The following items are specified in this dialog.

Function Specification
SPH300
/200

SPH2000

Multi-point condition monitoring stop
For one project, up to 32 points of condition monitoring stop
points can be specified.

X O

Logical concatenation of monitoring
stop conditions

For one device, up to 4 points of monitoring stop conditions by a
specified value of data can be concatenated with AND or OR.

X O

Monitoring
stop
condition

Step match
(REACHED)

After an instruction set as the breakpoint is executed X O

BOOL data match
(=1, =0)

=1: When the specified BOOL variable is turned ON
=0: When the specified BOOL variable is turned OFF

X O *

Rising/falling edge of
BOOL data

Rising edge: When the specified BOOL variable is changed from
OFF to ON.

Falling edge: When the specified BOOL variable is changed from
ON to OFF.

O O *

Data comparison match
When the specified data meets the specified conditions.
Comparison conditions (=, , <, >, <=, >=)

X O *
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� Execute the [Condition Monitor Result Display] sub-command of the [Debug Functions] command of the PLC Functions
menu. The Condition Monitor Result Display dialog appears. Condition monitor data in the binary and integer format are
displayed in this dialog. After condition monitor setting, condition monitor result display cannot be performed until the trigger
condition is met.

<Condition monitor setting for SPH2000>

� Execute the [Condition Monitor Setting] sub-command of the [Debug Functions] command of the PLC Functions menu. The
“Condition Monitor Setting” dialog appears. For SPH2000, data to be monitored is registered on the “Monitor Data” tab
window (max. 20) and trigger conditions are specified on the “Monitor trigger” tab window.
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� The “Monitor Trigger” tab window consists of “Trigger conditions” tab window and “Trigger point list” tab window.
Both the monitor screen and the “Trigger conditions” tab window are enabled. Select an arbitrary device on the monitor
screen and click the [Get Cursor position] button. The device at the cursor position is reflected in the window. Specify the
stop condition and click the  [Entry] button to register the trigger point.

� Click the “Trigger point list” tab to display the currently registered trigger points. By setting the corresponding check box to
ON/OFF, you can enable/disable the trigger point.

* With SPH2000, up to 32 trigger points can be specified. In addition, as with break points, up to 4 trigger points can be
logically connected for one device. Follow the same procedure used for break points.



3-90

Section 3 Menu Reference

3-4 PLC Functions Menu

(6) Trace Execution
This function is a function which samples and displays the status of a specified device (memory address).

Note: CPUs with the sampling trace function are NP1PS-117, NP1PS-117R and NP1PS-74R with software version V60 or later
and the SPH2000 series (all versions).

<Devices under sampling trace>

The following device can be specified as a sampling device.

<Number of points which can be registered>

Up to 128 points of devices can be registered for sampling trace counting a bit, a word, and a double word as one point.

<Operating procedure>

� Execute the [Trace Execution] sub-command of the [Debug Functions] command of the PLC Functions menu. The “Sampling
Trace Execution” dialog appears.

� Specify devices for sampling trace execution. When you click the [Add] button, the “Trace Data” dialog appears.

Bit Word Double word

Input memory X WX DX

Output memory Y WY DY

Non-retain memory M WM DM

Retain memory L WL DL

System memory SM WSM DSM
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� Enter the address or tag of the device and then click the [OK] button. The specified device is registered.

Registered device

� Specify trace conditions.
Set Trigger Point, Sampling Period, and Sampling Quantity as trace conditions.

<SPH300/SPH200>

� For SPH300/SPH200, select [Execute Button], [Data Access] or [Circuit Execution].

<When [Data Access] is selected>
Set a device address to be specified as a trigger condition and trigger condition.

<When [Circuit Execution] is selected>
Click the [Get at Cursor] button to display the program name and circuit No. of the cursor position on the screen.

Loads the device/condition
from the specified sampling
trace file.

Starts sampling.

Cancels sampling.

Saves the device/condition
for the specified sampling
trace in a file.
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<SPH2000>

� For SPH2000, set a circuit position and stop condition of a device to be specified as a trigger condition.
Click the [Get Cursor position] button to display the program name, circuit number and device of the cursor position. Set a
trigger condition and click the [Entry] button. The registration status can be checked on the [Trigger point list] screen.

<Trigger Point>

For Trigger Point, specify the sampling zero point assuming the negative direction for points before trigger detection and the
positive direction for points after trigger detection. Select the “Execute Button”, “Data Access”, or “Circuit Execution” button.
“Data access” starts sampling into the positive direction assuming that the timing of access to the specified device is the zero
point. Select devices and trigger condition from the following:

<Usable devices>

Bit Word Double word

Input memory X WX DX

Output memory Y WY DY

Non-retain memory M WM DM

Retain memory L WL DL

System memory SM WSM DSM
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Function Specification
SPH300
/200

SPH2000

Multi-point trigger condition Up to 32 points of sampling conditions can be set for one project. X O

Logical concatenation of trigger
conditions

For one device, up to 4 points of sampling start conditions by a
specified value of data can be concatenated with AND or OR.

X O

Trigger
condition

BOOL data match
(=1, =0)

=1: When the specified BOOL variable is turned ON
=0: When the specified BOOL variable is turned OFF

O O *

Rising/falling edge of
BOOL data

Rising edge: When the specified BOOL variable is changed from
OFF to ON.

Falling edge: When the specified BOOL variable is changed from
ON to OFF.

O O *

Data comparison
match

When the specified data meets the specified conditions
Comparison conditions (=, , <, >, <=, >=)

O O *

READ/WRITE When reading or writing of data to the specified device is performed. O X

3-4 PLC Functions Menu

<Trigger conditions>

* When a specified device is executed, a judgement on the condition is made.

<Comparison data>

When the trigger condition is specified only with a comparison operational expression (only with word/double word data), set a
comparison data in the comparison data field based on the following table.

Automatic recognition of the input comparison data is also possible.
(Example) “123” INT type

“H0000001F” DWORD type
“2003-02-14” DATE type

Data type Input range Input example

BIT (BOOL) 0,1 Cannot be input.

INT -32768 to 32767 INT#123, 123

DINT -2147483648 to 2147483647 DINT#100

UINT 0 to 65535 UINT#1000

UDINT 0 to 4294967295 UDINT#1000

REAL Single-precision floating decimal point REAL#10, 10.0, 1.3E-5

TIME
10ms to 4294967295ms
0ms to 49d17h2m47s295ms

TIME#10s, T#100ms

DATE 01-01-1970 to 02-07-2106 DATE#2003-2-1, D#2003-2-14

TOD 0:00:00 to 23:59:59 TIME_OF_DAY#6:40:00, TOD#17:00:00

DT 01-01-1970 0:00:00 to 02-07-2106 6:28:15
DATE_AND_TIME#2002-01-07-15:40:00
DT#2003-02-09-4:00:00

STRING - Cannot be input.

WORD 0000 to FFFF H0000, H1234, HABCD

DWORD 00000000 to FFFFFFFF H00000000, H12345678, HABCDEF10
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<Sampling Period>

Specify the sampling interval (timing).
For Interval (fixed sampling interval), you can specify a value from 1ms to 32000ms in 0.5ms steps which is a integral multiple
of the tact time.
For example, when tact time is 3ms, you can specify 3ms, 6ms, ... 31998ms.

<Sampling Quantity>

Enter the number of samplings before and after sampling conditions are met.
Since sampling is performed also when the trigger condition is met (zero point), a value of 16383 can be entered before and
after sampling conditions are met. It is not necessary to enter a - (minus) sign for the value before sampling conditions are
met.
The maximum number of samplings is 16384.

(Number of samplings before conditions are met) + (Number of samplings after conditions are met) +1 <= 16384
However, when “Execute Button” is selected as Trigger Point, 0 is assumed before conditions are met.

<Relation between the number of registered trace data and the sampling quantity>

The sampling quantity varies with the numbers of registered trace data.
Make setting so that the product of the sampling quantity and the number of registered trace data becomes 16384 or less.

(Number of samplings before conditions are met + Number of samplings after conditions are met +1)/Sampling quantity
x Number of registered trace data <=16384

� Start sampling trace. When you click the [Execute!] button, the “Confirm” dialog appears. When “Execute Button” is selected
as Trigger Point, sampling trace starts when you click the [OK] button.

The execution status of sampling trace is displayed in the status bar at the bottom right of the screen.
� Waiting for trigger? .......... Waits until the trigger condition is met.
� Recording? ...................... Sampling trace is in progress.
� Completed? ..................... Sampling trace is completed.

� Display the result of sampling trace. When you execute the [Trace Display] sub-command of the [Debug Functions]
command of the PLC Functions menu, the “Sampling Trace Display” dialog appears. When you click the [Execute!] button,
sampling data is loaded from the CPU and then displayed in text form. The [Execute!] button is disabled during recording of
sampling data.
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� Sampling data can also be displayed in graph form. When you select the [Graph] button in the “Sampling Trace Display”
dialog, the [Add Graph] dialog appears.
Select the target device and then click the [OK] button. The sampling data is displayed in graph form.

� Right-click the area on the left side of graph (the area enclosed in dotted lines) to turn on value display. A vertical cursor
appears and the value of the cursor position is displayed in the graph. The vertical cursor can be moved using the mouse.

Vertical cursor
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3-4-13 PLC Functions Menu - Network
A link system using the P/PE Link module, the FL-net module, and the Ethernet interface module of MICREX-SX Series can
perform remote operations (program download/upload, monitor, test functions, etc.) from the loader connected with one CPU
module to the CPU module with 3-layer SPH system.
The same remote operation can also be performed from the loader connected with another CPU module. The maximum
number of remote operation routes is 2 (at the time of simultaneous operation).
In addition, in SPB series, the simplified CPU link using a communication adapter (RS-485) can perform remote operations
from the loader connected to the basic unit with station No. 0 to another basic unit.  (1 layer and 1 route only)

* A loader network using the simplified CPU link is supported by all types and all versions of basic units/communication
adapters.

<Applicable versions>

To perform remote operation with a 3-layer 2-route loader network, use a communication module with the following software
version.

(1) Loader network setting
To make loader network setting, select the [Network settings] button in the “Select CPU Type” dialog or the [Network] command
(enabled only with the online window) of the PLC Functions menu.

<“Select CPU Type” dialog>

Module Version

CPU module
High-Performance Software version V38 or later

Standard Software version V37 or later

Communication module

P Link Software version V33 or later

PE Link Software version V33 or later

FL-net Software version V30 or later

Ethernet Software version V30 or later

General purpose communication
(SR-485)

Software version V30 or later
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� Click the [Network settings] button in the “Select CPU Type” dialog. The “Network setting” dialog appears.

� Route .................................... Loads a registered network route.
� [Registration] ........................ Registers the network route currently being displayed.
� [Delete] ................................. Deletes a registered network route.
� Setting .................................. Displays the current network route settings.
� [Add] ...................................... Adds the network route information to the current cursor position.
� [Change] ............................... Changes the network route information at the current cursor position.
� [Delete] ................................. Deletes the network route information at the current cursor position.
� This setting is applied ......... When checked, communication is performed with the specified network route.
� [OK] ....................................... Enables all the settings and then closes the dialog.
� [Cancel] ................................ Cancels all the settings and then closes the dialog.
� [Help] ..................................... Displays the help window.
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� Type .................................. Select a communication module. The applicable modules are shown below.
P Link, PE Link, Ethernet interface, General-purpose communication, FL-net (OPCN-2),
Simplified CPU link

� Sending source ............... Specify the CPU number of the source communication module or the SX bus station number.
[Setting] P Link: CPU number (8 to F)

PE Link: CPU number (8 to F)
FL-net (OPCN-2): CPU number (8 to F)
Ethernet: SX bus station number (1 to 238)
General-purpose communication: SX bus station number (1 to 238)
Simplified CPU link: unit station number 8

� Sending destination ........ Specify the network number of the destination communication module.
[Setting] P Link: PA link station number (00h to 0Fh)

PE Link : PE link station number (00h to 3Fh)
FL-net (OPCN-2): FL-net station number (01h to FEh)
Ethernet: IP address (0.0.0.0 to 255.255.255.255)
General-purpose communication: RS485 station number (00h to 0Fh)
Simplified CPU link: link station number (01h to 0Fh)

� Position ........................... Select the position where the route information is added.
Add Adds the information downward from the cursor position.
Insert Adds the information upward from the cursor position.

� [OK] .................................. Enables all the settings and then closes the dialog.
� [Cancel] ........................... Closes all the settings and then closes the dialog.
� [Help] ................................ Displays the help window.

� Finally, click the [Register] button in the “Network setting” dialog. The “Registration” dialog appears. Name and register
the route information.

� Registration name of route information ........... Enter the name of the route information with up to 32 characters.
� [OK] .................................................................... Enables all the settings and then closes the dialog.
� [Cancel] ............................................................. Cancels all the settings and then closes the dialog.

� Click the [Add] button in the “Network setting” dialog. The “Addition” dialog appears.
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3-4-14 PLC Functions Menu - Set Monitor Instance
This function is used to select the instance information to be used for monitoring of user function blocks called multiple times.
Specify the instance information for the user function block currently displayed. When you execute this command, the “Monitor
Instance Setting” dialog appears. The dialog displays the instance number and the path (route) which indicates how the user
function block is called. When you select the instance information and then click the [OK] button, monitoring is performed
based on the instance information. The dialog is not displayed if there is only one instance information (or location currently
called).

The Monitor Instance Setting dialog appears when you double click a Program in the project tree or move the cursor to it and
press the <Enter> key to display a user function block.
This command can be used only with the online window.

3-4-15 PLC Functions Menu - Run/Stop
This command is used to start, stop, and reset the PLC which is connected online. It can also be executed by clicking the
Speed button in the tool bar. When you execute an instruction, the Run/Stop the PLC dialog appears. Select an operation for
the PLC from drop-down list and then click the [OK] button. The following operations can be selected from the drop-down list.

� Run All ............................. Starts all the CPUs in the SX system.
� Initial Run All .................... Initial-starts all the CPUs in the SX system.
� Stop All ............................. Stops all the CPUs in the SX system.
� Reset All .......................... Resets all the CPUs in the SX system.
� Run .................................. Starts only the connected CPU.
� Initial Run ........................ Initial-starts only the connected CPU.

With version V2.3.2.0 or later, this function is disabled by default. You can enable or disable this
function on the [Function Setting] tab window which is displayed by executing the [MICREX-SX
Environment...] command in the [Options] menu.

� Stop .................................. Stops only the connected CPU.
� Reset ............................... Resets only the connected CPU.
� Continuous Run .............. When stopped at a specified break point, execution is restarted from the position.

These commands can be executed only when the key switch of PLC is set to TERM.

* Pay sufficient attention safely when starting or stopping the PLC.
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The auxiliary menu offers the following commands. These functions are used mainly to assist programming.

� Device Usage ................................... Displays addresses used by the program.
� Device Cross Reference ................. Displays the cross reference status from the program at the specified address.
� Timer & Counter Settings ................ Displays the timers and counters used as well as all the settings.
� Program Checking ........................... Performs program check and then display the result.
� Model Change .................................. Changes the PLC model.
� Data Display PageDisplays ............. Edit menu options for the data display page.
� Documentation ................................. Outputs a tag/comment file as a text file and loads a text file.
� Export Device Information ................ Used when sharing device information with POD (UG Series).
� Export Ladder Data .......................... Outputs the information for ladder monitoring with POD (UG series) to a file.
� Save Message Window ................... Saves the message window as a text file.
� Tag Editor ......................................... Activates the tag editor.
� File Divide/Merge ............................. Divides or merges compressed files for the project.

3-5-1 Auxiliary Menu - Device Usage
This command displays the usage within the project of the specified device.

� Execute the [Device Usage] command of the Auxiliary menu. The dialog for specifying Address/Tag appears.
� Specify a device (M in the example below) to be displayed and then click the [OK] button. The Device Usage dialog appears.

Displayed symbols are as follows:
� “x” : Used devices
� “�” : Unused devices
� “w”: When devices used in bits are also used in words/double words

* The object of F (user FB memory), T (timer), TR (integrating timer), C (counter) and jump destination label (P*) is the
programs for which ladder diagram is displayed.
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3-5-2 Auxiliary Menu - Device Cross Reference
This command displays the usage of a specified address within the program, i.e., the line number at which the address is
used and the instruction type which uses the address.

�When you execute this command, the “Cross Reference” dialog appears. Enter an address you want to investigate. Not only
an address but a tag can be entered.

After the content of the cross reference tab in the message
window is cleared when this option is specified, the cross
reference is executed.  You will be able to keep the content
of the Cross Reference screen by removing the check on
this option (max. 32000 line).

�When you have entered an address, click the [OK] button. The usage of a specified address within the program, i.e., line
numbers at which the address is used and the instruction type which uses the address is displayed in the Cross
Reference tab page.

�When you select any of the displayed cross references and then double-click the left mouse button or press the <Enter> key,
the corresponding line in the program appears.

3-5-3 Auxiliary Menu - Timer & Counter Settings
When you execute this command, the “Timer and Counter settings” dialog appears. A list of line numbers at which a timer or a
counter exists and timer/counter numbers and settings is displayed.

When you select any of the displayed timer or counter settings and then double-click the left mouse button or press the Move
button, the corresponding line in the program appears.
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3-5-4 Auxiliary Menu - Program Checking
This command performs program check and the result.

� Execute the [Program Checking] command of the Auxiliary menu. The “Program Checking” dialog appears.

Set check items by checking the corresponding boxes.

1) Basic Check

Following items are checked.
I/O check  Sets whether or not to check the consistency of input/output addresses during Basic Check
� Line error: These lines are displayed in red when you scroll a ladder. The cause of the line error is displayed.
� Device type and effective address range

Indicates whether there is any jump end suitable for all jump instructions.
� Indicates whether there is any Continue instruction suitable for the loop instructions.
� Address range after a specified address in case of the BMOV and FMOV instruction
� Address range after a specified address in case of character string instructions
� Indicates whether a function block is used by the user function.
� Indicates whether the type (bit, word, double word) of the parameter instruction (PARA instruction) is the same.

2) Coil Duplication

Checks whether the bit address of devices Y, M, L, SM, F, and V was used multiple times in output instructions.
For devices Y, M, L, and SM, double writing is checked for all the Programs. For devices F and V, it is checked for the
Programs currently being displayed.

3) Word Duplication

Checks whether the bit address of devices Y, M, L, SM, F, V, T, TR and C was used as an output address multiple times in
output instructions.
For devices Y, M, L, and SM, double writing is checked for all the Programs. For devices F, V, T, TR and C, it is checked for
the Programs currently being displayed.

4) FB Memory Remapping

When this check box is set to ON, the information of system FBs and user FBs used in the program is assigned from the
top of the FB memory.

5) Illegal parameter passed by indirect reference

Checks whether an incorrect pointer is set to any address specified in indirect reference parameters.

6) Use an created the machine code by download

When you perform program check, compilation is performed inside. When this check box is set to ON, the compiled machine
code can be retained and then used at the time of project transfer when check and compilation are normally completed.
When the [Use the machine code which is already] check box in the “Load” dialog is set to ON and then transmission is
executed, compilation at the time of transfer becomes no longer necessary, shortening the transmission time.
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3-5-5 Auxiliary Menu - Model Change
This command changes the PLC model currently assigned to the resource of the project file. The Model Change function is
effective only in the offline mode.

� Execute the [Model Change] command of the Auxiliary menu. The “Select PLC Model” dialog appears. When you change the
PLC model and PLC memory capacity and then click the [OK] button, the “Warning” dialog appears.

* Model change within the same series is
possible. The series cannot be changed.

�When you click the “Yes” button, the system definition is initialized and the system configuration definition screen
(Configuration window) appears.
When you click the “No” button, only the CPU memory size definition is initialized and the remaining settings remain
unchanged, then the system configuration definition screen (Configuration window) appears.

� The following setting or data is cleared after changing the PLC model.
Data in the Undo/Redo buffer

� The following setting or data is retained after changing the PLC model.
Program (mnemonic)
Program property information
Task setting information
Tag
Line comment
Initial value settings
Local settings
Data tab settings
Data files (data of each device in the on-memory)
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3-5-6 Auxiliary Menu - Data Display Page
This command is used to edit data sheets. It can be used when a data sheet is selected. (To select a data sheet, click the
Data tag at the bottom of the program window.) The following menu can also be executed from the Speed button in data sheets.

� Data Display Edit ............... Switches between the editing mode and the monitor mode of the data display mode.
� Data Value Change ........... Changes the data of an address.
� Data Display Fill ................ Displays data of continuous addresses.
� Data Value Delete ............. Deletes display data items.
� Data Display Clear ............ Deletes the entire display page.
� Force Set ............................ Performs forced setting for the device at the current cursor position.
� Force Reset ....................... Cancels Forced Setting applied to the device at the current cursor position.
� Force All Reset ................... Cancels all forced ON/OFF setting.

(1) Data Display Edit
This command switches between data display mode and editing mode. When the editing mode is entered, the Edit button is
pressed and then a green frame cursor appears on address. This command can also be executed by clicking the Speed
button in the data edit bar.

The address to be edited can be selected using the mouse or arrow keys.

To enter a new address or change an existing one, move the cursor to the target position and then enter an address or a tag in
the edit box (on the left side) in the data edit bar. Then, select the data format from the drop-down list to the right.

� Bit
� 2-byte ASCII
� 8-byte ASCII
� 16-byte ASCII
� Binary float
� 16-bit signed multi-display
� 16-bit unsigned multi-display
� 32-bit signed multi-display
� 32-bit unsigned multi-display
� Time
� Date and time
� Date
� Duration

When multi-display is selected, bit, decimal, hexadecimal, and ASCII formats are displayed together in one row.
When you have specified an address and data format, press the <Enter> key. The new address and its data are displayed.

(2) Data Value Change
Address data can be changed using the Change Display Data command. In the online window, changed data are written to the
CPU. This command can also be executed by clicking the Speed button in the data editing bar.

Each time you execute this command, data editing is enabled or disabled. In the editing mode, a green frame cursor appears
at the data position. To enter or change data, the edit box (on the left side) in the data edit bar is used. Data is updated when
you press the <Enter> key. With the online window, the data input to the CPU is transferred.
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(3) Data Display Fill
This command is used to enter addresses continuously. This command can also be executed by clicking the Speed button in
the data edit bar.

When this command is executed, the data is displayed in the same data display format while incrementing the address
automatically from the data item at the current cursor position to the bottom of the data sheet.

This command can be used when the data sheet is in the editing mode.

(4) Data Value Delete
This command deletes the data item at the current cursor position. This command can also be executed by clicking the Speed
button in the data edit bar.

This command can be used when the data sheet is in the editing mode.

(5) Data Display Clear
This command deletes all data items in the data sheet. This command can also be executed by clicking the Speed button in
the data edit bar.
This command can be used when the data sheet is in the editing mode.

(6) Force Set
When you click this button, the Forced Setting? dialog appears. When you enter data and then click the [OK] button, forced ON/
OFF setting is performed for the device at the current cursor position.

(7) Force Reset
When you click this button, a conformation dialog appears. When you click “Yes”, the forced ON/OFF setting applied to the
device at the current cursor position is canceled.

(8) Force All Reset
When you click this button, a conformation dialog appears. When you click “Yes”, all the forced ON/OFF settings are canceled.

(9) Save Data Display Settings (V1.3 or later)
Saves the status of the device currently displayed in the “data sheet” used at the time of program debugging and data
monitoring.

� Execute the [Save] sub-command of the [Data Display Page] command of the Auxiliary menu. The “Save Data Display
Setting?” dialog appears.

� Enter a data sheet name and then click the [OK] button. The specified data sheet is saved.
The saved data sheet can also be modified and deleted.
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3-5-7 Auxiliary Menu - Documentation
This command imports and exports tags and comment files in text format. This command makes it possible to exchange tag
and comment data with a commercially available text editor or spreadsheet software and edit them on it.

� Export Tag Project
� Import Tag Project
� Export Tag Files to Text File .......................... Exports tag to a text file.
� Import Tag Files from Text File ...................... Imports tag from a text file.
� Export Comment Files to Text File ................ Exports comment to a text file.
� Import Comment Files from Text File ........... Imports comment from a text file.
� Export Initial Data Files
� Import Initial Data Files
� Export Data Files
� Export Cross Reference

(1) Export Tag Project (available with V1.4.2.0 or later version)
This command makes it possible to export tag and line comment data in text format (CSV file for tag data).  The exported files
can be edited on a commercially available text editor or spreadsheet software.

� Execute the [Export Tag Project] command in the [Documentation] pull-down menu under [Auxiliary], and the [Export Tag
Project] dialog box appears.  On this dialog box, enter an arbitrary tag project name and click the [Save] button.

 The tag and line comment files are created in the following configuration:

Arbitrary folder

       Tag project name.tpj

            Tag project name.files

                   TAGFILE.CSV  Common (global) tag file
                    
                   LCOMMENT.TXT  Line comment file

                    Program

                             Program name

                                    Program name.CSV  Program (local) tag file
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* Zip and save of tag project
It is possible to zip a tag project and save it as a single file.  Zipped project file is saved in binary format.

� On the [Export Tag Project] dialog box, set [Save as type:] to “SX ZIP Tag Project [*.Ztd],” enter your desired file name and
click the [Save] button.

(2) Import Tag Project
This function imports the files that are exported with the Export Tag Project function into the currently opened project.

� Execute the [Import Tag Project] command in the [Documentation] pull-down menu under [Auxiliary], and the [Import Tag
Project] dialog box appears.

� Specify the tag project files (.TPJ) that you want to import by checking the boxes that correspond to them.  When you want to
import also the line comment data / Program name, check the [Import line comment data] box / [Import Program name] and
click the [OK] button.

Note: The error massage appears, in the case already some Program name exists when the tag project import.
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(3) Export Tag Files to Text File
This function exports tags to a text file. This file can be loaded in a word processor, a spreadsheet, or a database.
When you execute this command, the Export Tags to Text File dialog appears.

* Common tags and all Programs can be output
to a text file.

Enter the name of the program and file to be output and then click the [OK] button. The tag data of the specified program are
saved in the specified text file. There are two types of tag data: common tag data and Program-specific tag data. Tags attached
to devices M, L, X, Y, and SM are common tag data, and tags attached to devices T, TR, C, F, and V are Program-specific tag data.

A text file is a comma-separated file. The format of each row is shown below.

[Address], [Tag], [Address comment] (CR) (LF)
The same number of tags as the number of lines in the file are created. Although address and tag are always displayed but
address comment is displayed only when it is created.

Note: (CR) (LF) denotes a combination of carriage return and line feed.
When a text editor is used, this code is entered automatically when you press the <Return> key after entering text. (CR)
is hexadecimal number 13h and (LF) is hexadecimal number 10h.
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(4) Import Tag Files from Text File
This function imports tags from a text file and then appends them to common tag data or Program-specific tag data in the
current program window.

� Execute [Import Tag Files] sub-command of the [Documentation] command of the Auxiliary menu. The following dialog
appears.

� Enter the name of the Program and file to be loaded in this dialog and then click the [OK] button. The tag data in the specified
text file is loaded.

A text file is a comma-separated file. The format of each row is shown below.

[Address] , [Tag] , [Address comment] (CR) (LF)

� Address must be a device address of effective MICREX-SX.
� A tag is a unique character string consisting of up to 32 characters. If the length of the tag exceeds 16 characters, only 16

characters from the beginning are loaded. When you check “Allow duplicate Tags” in the Editor Options tab page in the
[Environment Options for MICREX-SX] dialog of the Options menu, the duplicate tag is also loaded.
� For address comment, up to 50 characters can be specified.

* If a tag has already been registered to the specified address, the existing tag is changed to the loaded tag.

Note: (CR) (LF) denotes a combination of carriage return and line feed.
When a text editor is used, this code is entered automatically when you press the <Return> key after entering text. (CR)
is hexadecimal number 13h and (LF) is hexadecimal number 10h.

* <Use the address assignment of cut & paste between models>
This function imports data using the address translation rule of the FLEX-PC or MICREX-F Series.

� Set this check box to ON and then select a model.

� Click the [Address assignment] button. The “Address Assignment” dialog appears.
The address translation rule is registered here. Refer to 3-2-3, “Edit Menu - Paste” for the setting of the address translation
rule.

*
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(5) Export Comment Files to Text File
This function exports all the line comments in the window to a text file.
When you execute this function, the Export Comment Files to Text File dialog appears. Enter the name of a new or existing file
in this dialog and then click the [OK] button. Line comments are saved in the specified text file.

The text format for each line comment is shown below.

[Line comment address] (CR) (LF)
[Line comment line #1] (CR) (LF)
[Line comment line #2] (CR) (LF)

:
[Line comment line #n] (CR) (LF)
(CR)(LF)

� The format of the line comment address is ‘LCxxxx’ where xxxx is the line comment number in hexadecimal notation.
� Line comment line #n is the text of each row in the line comment.

Note: (CR) (LF) denotes a combination of carriage return and line feed.
When a text editor is used, this code is entered automatically when you press the <Return> key after entering text. (CR)
is hexadecimal number 13h and (LF) is hexadecimal number 10h.

(6) Import Comment Files from Text File
This function imports line comments from a text file into the current program window.

When you execute this function, the Import Comment Files from Text File dialog appears. Enter the name of the file to be
loaded this dialog and then click the [OK] button. The line comment is loaded. The line comment may not be displayed in the
program window even after loading. In this case, move the cursor to the target line and then execute the [Insert/Modify Line
Comment] command of the Edit menu to set a line comment address (number).

The text file format is shown below.

[Line comment address] (CR) (LF)
[Line comment line #1] (CR) (LF)
[Line comment line #2] (CR) (LF)

:
[Line comment line #n] (CR) (LF)
(CR)(LF)

� The format of the line comment address is ‘LCxxxx’ where xxxx is the line comment number in hexadecimal notation
(LC0001, lc5, LC002E, etc.)
� Line comment line #n is the text of each row in the line comment.

Note: (CR) (LF) denotes a combination of carriage return and line feed.
When a text editor is used, this code is entered automatically when you press the <Return> key after entering text. (CR)
is hexadecimal number 13h and (LF) is hexadecimal number 10h.
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(7) Export Initial Data Files
This function exports initial values of devices set with the Initial Data List function (explained in Section 3-4-6) to a comma-
separated text file (CSV format). Program information and initial value data of devices are exported.

� Execute the [Export Initial Data Files] sub-command of the [Documentation] command of the Auxiliary menu. The [Export
Device initial data to Text File] dialog appears.

� Specify a destination file and click the [Save] button. When export is completed, the following dialog appears.

<Output format>

The figure below is an example of a CSV file opened by EXCEL.

“#” is always appended. If you delete “#”, it becomes impossible to import the data normally.

Initial value data of 

global device

Initial value data of 

local device

�
Initial value  

�
Retain/Non retain 

�
Tag name

#PG:1 (Ladder0)
Program name

Program No.

Program type

#PG : Program

#FB  : User function block

#FCT  : User function

Note: For the “tag name”, registered tag names are output.

 If both global and local tags are registered, the local 

 tags are preferentially displayed. 
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(8) Import Initial Data Files
This function imports a text file exported with the “Export Initial Data Files” function for initial value data of devices of a program.

� Execute the [Import Initial Data Files] sub-command of the [Documentation] command of the Auxiliary menu. The [Import
Device initial data from Text File] dialog appears.

� Select a file to be imported and click the [Open] button to start import.
When import is completed normally, the following dialog appears.

If the imported data does not match the initial value data in the loader or if data in the text file is abnormal, [Initial data import
log] appears and errors and warnings are displayed.

* Initial value data is not imported to abnormal devices.

Note: This function does not import program names and tag names.
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<Error and warning message list>

Class Message and description

Warning

[address] initial data is changed from [project initial data] to [text file initial data];

<Description>
If initial values in the initial data list do not match those in the text file, the above message appears and the initial
values in the initial data list are overwritten with those in the text file. If initial values are not changed, the above
message does not appear.

Warning

The memory type of [address] was changed.

<Description>
Because the currently registered memory type is different from the one in the text file, the memory type is
overwritten with the one in the text file.

Error

Program kind or a program number is not right.

<Description>
If a program type other than PG, FB or FCT is specified, if the program number is out of the range, or if the
destination program does not exist, it is judged as abnormal. Until normal program information is imported next
time, initial value data of the local device is not imported.

Error

[address] is an address out of range.

<Description>
Import cannot be executed because the [address] described in the text file is out of the address range of the PLC.
Each device is checked in the range below.
WM0 to WM2490367, WL0 to WL425984, WV0 to WV256

Error
[address] is the device which a initial data cannot set.

<Description>
Import cannot be executed because an identifier other than M, L, F or V is speficied for the address identifier.

Error
Cannot register to instance memory (F) except for WORD DEVICE

<Description>
Only "word device (WF)" can be specified for the user FB instance memory (F).

Error

[address] is invalid to initial data for [text file initial data]

<Description>
Import cannot be executed because the [text file initial data] is not a valid format of MICREX-SX for the [address].
Check the format with <Output format> in Section 3-5-7(1) as a guide.

Error
[address] is not a local device of [program].

<Description>
Import cannot be executed because the [address] is not specified as the local device of the destination [program].

Error

Setting is invalid. setting "Retain Memory" or "Non Retain Memory".

<Description>
Import cannot be executed because the setting of the retain memory of the user FB instance memory (F) or the
parameter output for the user FB (V) is abnormal.

Error

Setting without an initial data is not possible in non retain memory. When do it without an initial data, setting "retain
memory".

<Description>
Import cannot be executed because "non retain" and no initial value is specified for the user FB instance memory
(F) or the parameter output for the user FB (V).

Error
The format is invalid. Please confirm an address, an initial value, and the memory type.

<Description>
The address, initial value or memory type is not set.

Error
[address] cannot be registered because it overlaps with the data which has already been registered.

<Description>
A set address (bit address, word address or double-word address) and the [address] overlap.
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This function exports a data file saved with the [Save as] command of the File menu to a comma-separated text file (CSV
format).

� Execute the [Export Data Files] sub-command of the [Documentation] command of the Auxiliary menu. The [Export Data
Files] dialog appears.

The currently active project and its storage folder are
displayed by default.

If this check box is set to ON, the character code is appended.

3-5 Auxiliary Menu

� Specify a file and an export folder and click the [OK] button to start export of the text file. When export is completed, the
following dialog appears. The time required for the processing depends on the amount of the data or the processing
capacity of the personal computer. The file is exported to individual memory type.

* A file is exported to individual memory type. A file name specified on the [Export Data Files] dialog with a memory symbol is
actually exported.

For example, if you specify “prog1” for a file name on the [Export Data Files] dialog, the following file names are exported:
“prog1_M.csv”, “prog1_L.csv”, “prog1_SM.csv”, “prog1_UFB.csv” and “prog1_SFB.csv”.

File name Content

[Specified file name]_M.csv Data file of the standard memory (non retain)

[Specified file name]_L.csv Data file of the retain memory

[Specified file name]_SM.csv Data file of the system memory

[Specified file name]_UFB.csv Data file of the user FB memory

[Specified file name]_SFB.csv Data file of the system FB memory
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<When the “Export the character code” check box is set to ON>

[Word address], [Bin], [Dec], [Hex], [Duration], [Date], [Time of Date], [Date and Time], [Real] and [Character] are output, each
separated by commas.

Note: For data that cannot be expressed with Real, a code such as “NAN”, “INF” and “-INF” is displayed.

(Note)

<Output format>

[Word address], [Bin], [Dec], [Hex], [Duration], [Date], [Time of Date], [Date and Time] and [Real] are output, each separated by
commas.
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(10) Export Cross Reference
This function exports device cross reference information set on the [Device Cross Reference] tab of the [Page Setup] command
of the File menu to a comma-separated text file (CSV format).

� Execute the [Export Cross Reference] sub-command of the [Documentation] command of the Auxiliary menu. The [Export
Cross Reference] dialog appears.

� Specify a file and a destination folder and click the [Save] button to start export of the text file. When export is completed, the
following dialog appears.

<Output format>

Output data is as follows:

Project name

Cross information 1

(circuit No., instruction name)

Cross information 2

(circuit No., instruction name)

Tag name

Device name Program name
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3-5-8 Export Device Information
This function is used to save the device information for the currently active project in a file.
The device information outputted is as follows:
1) Device information for realizing device sharing with this loader for POD (UG Series)

* For POD operations, refer to the manual of POD.
2) Device information for communication middleware

Note: Device information files created by this function can be used with the UG Series loader (type: UG0S-CW) version
V3.2.2.1 or later. Note that they cannot be used with versions earlier than V3.2.2.1.

�When you select “Export Device Information” from the Auxiliary menu, the following Export Device Information dialog appears.
Enter a file name and then click the [Save] button.

� Device information files are created. The device information consists of multiple folders and files as shown below.

Arbitrary folder

Project name.ini

Project name

CONFIG

CONFIG.ini

Res.lst

C

Configuration

ioarea.ini

sysdef.def
ioarea.ini

*.bdf

*.def

dataarea.ini

ocires.ini

Global_Variables.vb

Sysdef*.bdf

RES

Configuration

R

Resource

dataarea.ini

PATHID.TXT

*.lst

*.bdf

Resource

PPEAREA.INI

tyllist.typ

Device information for 

communication middleware

Device information for 

POD (UG series)
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3-5-9 Export ladder data for ladder monitoring with POD
This function is used to export the information for monitoring ladder diagrams of an application program with POD (UG series)
to a file.

� Execute the [Export Ladder Data...] command in the [Auxiliary] menu to display the [Export Ladder Data] dialog. Select the
folder to which the data is output, check the boxes for programs to be outputted, and then click the [OK] button. When output
is completed, a dialog to inform you of the completion of the output is displayed.

� Ladder information files are created. The ladder information consists of multiple folders and files as shown below.

<Availability of display on POD in each program type>

Arbitrary folder

Ladder

RasMsg

SysDef

LD<Program name>.GRD

LD<Program name>.GRD

TB_GLOBAL.TBL

TB_<Program name>.TBL

TB_<Program name>.TBL

TB_IOMAP.TBL

TG_GLOBAL.CSV

TG<Program name>.CSV

TG<Program name>.CSV

CMT.TXT

SYSDEF11.DEF

FU_APL.DEF

FU_SFB.DEF

FU_UFB.DEF

FU_UFC.DEF

SYSDEF01.DEF

CLOG001.CSV

Country No.

Program type Availability of display (output)

Standard expansion FB Unavailable

Password-protected program Unavailable

ST language program Unavailable

AFB Unavailable

Other programs Available
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3-5-10 Save Message Window
This function is used to save the information generated at the time of compilation of a project in a text file.

� Execute the [Save Message Window] command of the Auxiliary menu, the “Save Message Window” dialog appears.
� Set the check box in the message window to be saved to ON and then click the [OK] button. The dialog for specifying the

target location appears. Specify a file and then click the [Save] button.

* The message window displays six different pages which are selected with tabs. When you execute this command, the check
box for the active tab page is automatically set to ON.
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<Example of message window information screen>

When transferring a project to the PLC, compilation of the project is performed and then the result is displayed in the message
window. (The following shows an example in the compilation information screen.)

<Display items of compilation information screen>

� Configuration ............... A Displays the configuration name.
� Resource ..................... Displays the resource name.
� CPU Type ..................... Displays the CPU model in the resource.
� Information of each program
� Program Type .................... Displays the program type (program, function block, function).
� Code .................................. Displays the program step of the program.
� Instance ............................ Displays the amount of instances used by the created FB in case of function block.
� Number of FB nests ......... Displays the number of FB nests in case of function block.
� User FB ............................. Displays the number of user FBs currently being used within program.
� Edge detection FB ............ Displays the number of edge-related FBs currently being used within program.
� Counter FB ........................ Displays the number of counter FBs currently being used within program.
� Integrating timer FB .......... Displays the number of integrating timer FBs currently being used within program.
� Timer FB ........................... Displays the number of timer FBs currently being used within program.
� Other system FB ............... Displays the number of other system FBs currently being used within program.

� Sum information
� Program ............................ Displays the number of Programs of the program type currently being used within the project.
� Function block ................... Displays the number of types of user function blocks within the project.
� Function ............................ Displays the number of types of user functions within the project.
� Code .................................. Displays the program steps of the entire project.
� Edge detection FB ............ Displays the number of edge-related FBs currently being used in the entire project.
� Counter FB ........................ Displays the number of the counter FBs currently being used in the entire project.
� Integrating timer FB .......... Displays the number of integrating timer FBs currently being used in the entire project.
� Timer FB ........................... Displays the number of timer FBs currently being used in the entire project.
� Other system FB ............... Displays the number of other system FBs currently being used in the entire project.
� Number of FB nests ......... Displays the total number of FB nests currently being used in the entire project.
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3-5-11 Auxiliary Menu - Tag Editor 1
Tags and descriptions of addresses of each memory in the PLC can collectively be edited.

� Execute [Tag Editor] command in the Auxiliary menu. The [Tag Editor] dialog box is displayed.

3-5 Auxiliary Menu

Tool bar

<Tool bar>

Note: When using Windows 95 operating system (OS) for the personal computer or when “Microsoft.Net Framework1.1” has
not been installed, the [Tag Editor] window is different.
For more information about the operation, refer to “3-5-11 Auxiliary Menu - Tag Editor 2.”

(1) Adding address
� Click the position where you want to add an address, enter an address and tag.

Enter an address.

Enter a tag.

* An address can be entered with lowercase characters.
They are automatically converted to uppercase characters
when your enter is confirmed.

Progress display Message display

Line No. of the current
cursor position

Number of
registered tags

[Save] [Copy] [Insert line] [Delete line]

[Cut] [Paste] [Add line] [Find/replace] [Filter]

[Program selection]
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� After entering an address, tag and, if necessary, a description (comment), click the [Save] button and exit the Tag Editor. If
you exit the tag editor without saving them, the following window is displayed.

�When you click the [OK] button, the tag data that you edited is not saved and the Tag Editor ends.

(2) Copy, cut and paste
Tags and addresses on the Tag Editor can be copied or cut, and pasted to other cells. In addition, by using these functions, it
is also possible to paste tag data that is created with EXCEL.

<Copy/cut and paste on the Tag Editor>

� First, select a range that you want to copy or cut. Click the upper left corner of the range, and then click the lower right corner
of it while holding down the <Shift> key. The range is selected and grayed out.
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� Click the [Copy] or [Cut] button with the range selected and select (click) the upper left cell of the area where you want to
paste the selection.

� Then, when you click the [Paste] button, the data that has been copied or cut are pasted.

Upper left cell of the area where you
want to paste the selection.

<How to paste the data created with EXCEL to this Tag Editor>

� Select a range of data created with EXCEL that you want to paste to the Tag Editor and copy it.

Pasted data
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� Display the Tag Editor and select (click) the upper left cell of the area where you want to paste the selection.

Upper left cell of the area where you
want to paste the selection.

� Then, when you click the [Paste] button, the data created with EXCEL is pasted.

Pasted data

(3) Filter
By specifying the device and range, the tag data is displayed.

� Click the [Filter] button. The [Filter] dialog box is displayed.

� Select the device and range and then click the [OK] button. Only selected devices are displayed.



3-125

Section 3 Menu Reference

3-5 Auxiliary Menu

(4) Find and Replace
An address, tag and description on the Tag Editor can be found and replaced with another one.

1) Find

� Click the [Find/replace] button. The [Find and Replace] dialog box is displayed.
Select the “Target” and “Search Form” and enter a character string to be found.

�When you click the [Find] button, the cursor is moved to the occurrence.

Occurrance



3-126

Section 3 Menu Reference

3-5 Auxiliary Menu

2) Replace

� Click the [Find/replace] button. The [Find/replace] dialog box is displayed.
Select the “Target” and “Search Form”, and then enter a character string to be found and a character string with which you
want to replace the occurrence.

�When you click the [Replace] button, the character string is searched and replaced. The cursor is moved to the occurrence.

Character string that has been replaced
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3-5-12 Auxiliary Menu - Tag Editor 2
The Tag Editor dialog displayed when you execute this command allows addition, modification, and deletion of tags as well as
search, replacement, and filtering of the tag displayed in a spreadsheet.

First, set the data displayed with a tag file. There are two different tag data: common tag data and Program-specific tag data.
Tags attached to devices M, L, X, Y, and SM are common tag data, and tags attached to devices T, TR, C, F, and V are Program-
specific tag data.

Data are sorted and displayed in ascending order of address. Data which does not fit into the window can be scrolled using
the scroll bar.
The Tag Editor window is provided with the address, tag, and Description (comment) fields. The display width and display
position can be changed as required.

Enter address in the address format which is effective for the MICREX-SX Series.
Up to 32 characters can be entered for each tag. Quotation marks (“”), commas (,), periods (.), numerical values, device
address of MICREX-SX, etc. cannot be used for tags. Unless “Allow duplicate Tags” in the Editor Options tab page in the
[Environment Options for xxxx] dialog of the Options menu is checked, a tag duplicating with other tag cannot be entered.
The length of the Description (comment) field is 50 characters. Commas (,) cannot be used for description (comment).
Commas (,) in the description (comment) are deleted automatically at the time of registration.

When you change the tag database and then closes the Tag Editor dialog, changed tags are reflected to the ladder display.

<Using the navigation controller>

The tool bar at the bottom of the Tag Editor dialog is called database navigation controller. The database navigation controller
is a set of database tool buttons for editing the database.
The function of each database navigational tool button is shown below, from the left to right.

� First record ...................... Moves the cursor to the record of the first (top) record.
� Previous record ............... Moves the cursor to the previous record.
� Next record ...................... Moves the cursor to the next record.
� Last record ...................... Moves the cursor to the last (end) record.
� Insert record .................... Inserts a blank record at the current cursor position.
� Delete record ................... Deletes the record at the current cursor position. A confirmation prompt is displayed before

deleting a record.
� Edit record ....................... Puts the record at the current cursor position in the editing mode (to allow editing).
� Register record ............... Registers the record currently being edited to the database. Before registering a record, make

sure that both the address and tag exist, that the address is in the effective format, and that the
tag is unique and in the effective format.
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� Cancel editing ................. Cancels the editing mode and then restores the record to the previous condition. (This function
is effective only for the field at the current cursor position.)

� Update data ..................... Updates the database.

<Inserting and adding tag data>

The black triangle displayed to the left of the database display represents the record cursor which indicates that the current
record can be edited.

To insert a new tag, click the Insert Record button in the navigation controller or press the <Insert> key. A blank record is
inserted and then the cursor moves to the Address entry field.
Enter a device address effective for the MICREX-SX Series in the Address entry field and then press the <Enter> key. When the
input address is correct, the cursor moves to the Tag entry field.
Enter a tag in the Tag entry field.
To enter description (comment) subsequently, press the <Tab> key. The cursor moves to the Description (comment) field. If
input of description (comment) is not necessary, press the <Enter> key. The next tag data can be entered. When you have
entered a description (comment), press the <Enter> key. A new entry field is inserted in the next row.
Although input of description (comment) can be omitted, input of address and tag cannot.
When you enter address and tag and then press the <Enter> key, the record is registered to the database and then a new
blank line is inserted. Continue adding tag data as required.
The record is registered also by clicking the Register Record button of the navigation controller. In this case, a new blank line
is not inserted after registration.
Registered data are sorted automatically based on the address within the database.

<Changing tag>

To change a record, move the cursor to the target record.
Click the Edit Record button in the navigation controller or a field in the record to enable record editing. When you have
changed the record, press the <Enter> key or click the Register Record button. The changed record is registered to the
database.
In addition this operation, a changed record can be registered to the database by moving the cursor to other records.

<Deleting tag>

To delete a record, move the cursor to the target record and then click the Delete Record button in the navigation controller. The
record is deleted from the database.

<Saving tag>

To save a tag, close the Tag Editor dialog and then save the program.

<Searching for tag>
To search for a tag, enter a character string to be search for in the search text box and then click the Search button. When an
occurrence is found, the current record is the record where an occurrence was found. When “Not case-sensitive” is checked,
alphabetical characters are searched for not in case-sensitive manner. When “Word search” is checked, the extracted text is
searched for as a word using a space, a comma, and other ASCII code symbols (other than A to Z (a to z)) as a delimiter code.

<Replacing tag>

To replace a tag with another one, enter a character string to be search for in the Search text box and a replacement text text in
the Replace text box, then click the Replace button or All Replace button. Like Search, the “Not case-sensitive” and “Word
search” options can be used when searching for the replacement text.

<Displaying tag data with filtering>

Enter filter condition text in the Address, Tag, and Description text boxes in the Filter panel. Filter processing is performed as
soon as you have entered text. When “In all fields” is checked, filter processing is performed based on the AND condition of the
text entered in the Address, Tag, and Description boxes. When “In any field” is checked, filter processing is performed based
on the OR condition of the text entered in the Address, Tag, and Description boxes.
Since filter display is processed as a text, enter ‘M0001’ as address to make filter display of M0001. M0001 is not displayed
even if you enter “M1” as is the case with programming. For the text entered in the Tag and Description boxes, filter display is
made through comparison from the top of the tag and text of the record. Note that filter display of a character string in the
middle of tag or description cannot be made.
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“File Divide/Merge” dialog - Merge tab page

Specify the name of the files to be merged. Specify zps
for merge files here.
File specification is also possible using the file selection
dialog displayed by [Others] in the drop-down list.

Specify the file name after merge.
File specification is also possible using the file selection
dialog displayed by [Others] in the drop-down list.

When the focus moves out of the Merged file name entry
box, the files to be merged are displayed here.

When the focus moves out of the Merged file name entry box,
the size of the division file, division size, and the number of
resultant files are displayed here.

3-5 Auxiliary Menu

3-5-13 Auxiliary Menu - File Divide/Merge
Divides or merges compressed project? files (.zpj). File name extensions are zps (merge file) and xn (divided files).

Example:abc.zps
abc.x01
abc.x02
      :
abc.xn

”File Divide/Merge” dialog - Divide tab page

Specify the file name to be used after division.
File specification is also possible using the file
selection dialog displayed by [Others] in the
drop-down list.

Specify the name of the file to be divided.
File specification is also possible using the
file selection dialog displayed by [Others]
in the drop-down list.

Displays resultant files of division.

When the focus moves out of the Divide file name
entry box, the size of the division file, division size,
and the number of resultant files are displayed here.
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“File Divide/Merge” dialog - Setting tab page

Specify the number of files to be retained in the history
of files executed with division and merge tabs, and
specify whether the previous value is to be displayed
in the file specification fields in the Divide and Merge
tab pages when this dialog is displayed.

Specify the Division size.
The capacity can be specified or selected from the list.
With “Depends on empty capacity”, file division size is
determined according to the free space of the target drive.
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The Options menu offers the following menus:

� FLEX-PC Environment ..................... Makes environmental setting of the programming tool for the FLEX-PC Series.
� MICREX-SX Environment ................. Makes environmental setting of the programming tool for the MICREX-SX Series.
� Key assignment ............................... Customizes the shortcut keys.
� Starting Method ................................. Sets the method to start this loader.  (MICREX-SX SPH series dedicated function)
� FLEX-PC Communications ............. Makes communication setting and modem connection/disconnection of the FLEX-PC

Series.
� MICREX-SX Communications ......... Makes communication setting of the MICREX-SX Series.

3-6-1 Options Menu - Environment Options for MICREX-SX
� Execute the [MICREX-SX Environment] command of the Options menu. The following dialog appears.

(1) Editor Options tab

����� Auto Documentation
When this check box is set to ON, the dialog for registering tags appears when you enter a device address to which no tag
is assigned at the time of program editing. Tags can be assigned to the device address at the time of program editing.

����� Allow duplicate Tags
When this check box is set to ON, duplicate tags (tags with the same name) are permitted. When set to OFF, an error is
displayed if you attempt to define duplicate tags. A tag can be entered with up to 32 characters. Quotation marks (“”),
commas (,), period (.), numerical values, device address, etc. cannot be used.

����� Show line number
When this check box is set to ON, the line number is displayed to the left of the line.

����� Inhibit entering a local device
When the check box is set to ON, an error is displayed if you attempt to enter an address which is set to a local device with
other programs at the time of program editing.

����� Show the screen of address assignment each time paste
When this check box is set to ON, the address setting dialog appears when lines are pasted.

����� Express address type in MICREX-F identifier
When this check box is set to ON, the device identifier enters the MICREXF mode.
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����� The dummy module is not checked by system definition
When this check box is set to ON, a warning message is not displayed at the end of system definition even if a dummy
module (module marked *) is registered in the system definition.

����� Show warning the size of a program exceeds 4K steps
With version V1.4 or later, the maximum size of a program has been changed to 8K steps. When using a CPU not applicable
to 8K steps/Program, however, when this check box is set to ON, a warning message appears at the bottom right of the
screen if the size exceeds 4K steps.

����� Allow downloading only the system definition after changing the system configuration
It is not possible to transfer only the system definition after modification. (Default setting) When this check box was set to ON,
it is possible to transfer only the system definition to the CPU after modification.

����� The confirmation message for importing standard Ex. FB is not shown at on-line
When you set this check box to ON, the import confirmation message is not displayed even if the standard extension FB is
contained in the project uploaded from the CPU module or user ROM card.

����� When the confirmation message for importing standard Ex. FB is not shown, import it automatically
When you set this check box to ON, the standard extension FB currently used is imported when the [The confirmation
message for importing standard Ex. FB is not shown at on-line] check box is set to ON.
The extension FB is searched for in the following folders.

1) The folder set as [Import Program] in the “Folder” setup panel
2) Loader installation folder\LIBRARIES

����� The duplication of the instance number is displayed as warning.
When you set this check box to ON, the duplication error of the instance number (including Timer (T, TR) and Counter (C))
is displayed as a warning when downloading and program checking.

����� Open online window in edit mode
When you set this check box to ON, an online window opens in edit mode when connecting to PLC online.

����� When the parameter of user FB exceeds 256 words, warning is displayed.
When you set this check box to ON, a warning message is displayed to the program whose total size of the parameter
exceeds 256 words when program checking.
* For high-performance CPU (software version V63 or newer), up to 4096 words of the FB instance area are available.

����� Use the step control (contact/coil)
When you set this check box to ON, the area for the last 100 words of the retain memory area is set as a step control area.
(Please take note that the area that can be used as L-identifier is reduced by 100 words.

����� Display FB/User FCT call instruction in block type
When you set this check box to ON, the calling part of the FB and user FCT is displayed in FBD type (block type).

<Example of display in FBD type (block type)>

3-6 Options Menu

* You can switch the display by turning this check box ON or OFF anytime.
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Prioritize inserting line
Set the operation when you press <Ctrl> + <Alt> during line edit.
When you set this check box to ON, pressing <Ctrl> + <Alt> executes the “Insert Line” command.
When you set this check box to OFF, pressing <Ctrl> + <Alt> executes the “Insert Row” command.

The use of differentiation contact/coil in MICREX-F type is enabled
When this check box is set to ON, the same instance number can be used when the address of the operand is the same in
the differentiation contact and the differentiation coil. (It is not assumed to be duplication of the instance number.)
* Excluding array/structure addresses

Address/Tag Display
To display the operand of instruction, you can specify how to display it, i.e. by only address, by only tag, or by address and tag.

Address/Tag Height
The number of rows is specified for displaying addresses and tags.  You can select “1 row x 8 characters”, “2 rows x 8
characters”, “3 rows x 8 characters”, or “4 rows x 8 characters”.

Ladder Display
Sets how to display the project. (Package displays or Individual displays)
The change of the ladder display option is effected at next booting.

Program size
Specify the upper bound of the program step size which can be described in one program. The following upper bound
values are changed in proportion to the program size.

"Size concerning parameter setting" shows the total of the parameter area + work area + (number of FB used in this FB
* 2 words).

(2) Folders tab
Project file
Specify a default folder used when saving and opening a project file. The default folder position (the folder used  when no
folder is specified) depends on the version of the Windows used.

Library
Specify a default folder used when registering and loading library files. The default folder position (the folder used when no
folder is specified) depends on the version of the Windows used.

Import program
Specify a default folder used when importing program. The default folder position (the folder used when no folder is specified)
depends on the version of the Windows used.

(3) Colors tab
The Colors tab is used to set display colors of program.
Select a target element (for example, background) and then click a color. When you move the cursor to the list of elements
using the <Alt>+<M> key, select an element using the cursor key, move the cursor to Color using the <Alt>+<O> key, select a
color using the cursor, then press the <F> key, the color is selected and the FG mark moves to it. When you click the Default
button, the default settings are restored.

(4) Palette tab
The Palette tab page for MICREX-SX is used to customize the common palette of the instruction bar of the MICREX-SX Series.
For Palette Instructions, three different operations (Common Shift Tab, Common Control Tab, and Common Tab) can be selected.
When you select Palette Instructions, the assignment status of the current instruction is displayed. Up to 11 keys (F2-F12) can
be assigned to each. When you specify the assignment position in the left assignment table, select an instruction from the
right instruction list, then click the [<] button, the specified instruction is assigned. The instruction position can be changed by
clicking Upward? and Downward?. To delete an assigned instruction, select it and then press the <Delete> key. When you
click a Default button, the default settings are restored.

Program size
(step)

Size concerning
parameter setting
(WORD)

Initial data
(number)

4096 256 3200

8192 4096 3200

16384 (SPH2000 only) 16384 12800



3-134

Section 3 Menu Reference

3-6 Options Menu

Key list

Command list

(5) Data Display tab
The Data Display tab page is used to specify the order of ASCII characters in the Data tab.

����� When you select ASCII display - Low byte
High byte, character strings are displayed in order of the lower byte and the upper byte.

����� When you select ASCII display - Low byte
High byte, character strings are displayed in order of the upper byte and the lower byte.

(6) Project Tree tab
� Set show/hide of projected program.
� When you open the project, it is possible to select sort invalid, Program name, or Program number.

(7) Backup tab
If the [Online project backup] tab is activated, projects are automatically saved when the system is made to be online as well
as when changed lines are transferred to the PLC.  When changed lines are transferred to the PLC, the changes are recorded
in the log file.

<Destination to save>
<Loader installed folder>\SX_BAK\
File name: -UPLC001.Zpj (when made to be online)

-DPLC001.Zpj (when changed lines are transferred to the PLC)
-DL001.Log (log file)

For the number of backups, the number of backup files is specified.  If the number of backup files exceeds the set value, files
are deleted from the oldest one in order.

(8) Function Setting tab
� When the [Specified CPU number and route information at the downloading] check box of “Load” is set to ON, the dialog

box for specifying destination CPU or route is displayed at the time of execution of the [Load] command.
� Specify an initial state of each option of “Load Dialog” and “Verify Dialog”.

3-6-2 Options Menu - Key Assignment
Shortcut keys that are assigned to each menu of this loader can be customized.
For the shortcut keys, the following 52 key combinations can be used:

<Ctrl>+<A>  to <Ctrl>+<Z>
<Ctrl>+<Alt>+<A> to <Ctril>+<Alt>+<Z>

(1) Basic operations
� Execute [Key Assignment] command in the [Option] menu. The [Key assignment] dialog box is displayed. Select the shortcut

key from the key list.
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�When you click the [OK] button, the selected function is assigned to the shortcut key.
The assigned shortcut key is displayed on the menu window.

The assigned shortcut key

� Then, select the function that you want to assign to the selected shortcut key from the command list.

* For this example, the “System Definition” of the [PLC function]
is assigned to the <Ctrl>+<A> key combination.

* If the shortcut key that you select has already been assigned a function, the function is displayed in the command list. (The
function is selected.)
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� Enter the filename and then click the [Save] button. The data is output to the external file.

<Import of setting>

� Click the [Import] button on the [Key Assignment] dialog box. The [Import Key Assignment] dialog box is displayed.

� Select the set file to be imported, and then click the [Open] button. The setting is read (imported) from the file.

* When the <Ctrl>+<Alt>+<alphabet> key combination is assigned, check the box of [Alt].

* When you want to cancel the function that is assigned to the shortcut key, select “None” from the command list.

(2) Import/export key assignment setting
The key assignment that is customized can be output (exported) to a text file and the setting can be read (imported) into
another Standard loader.

<Export  of setting>

� Click the [Export] button on the [Key Assignment] dialog box. The [Export Key Assignment] dialog box is displayed.
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3-6-3 Options Menu - Starting Method
This command sets the method to start the loader used for MICREX-SX series.

� Execute [Starting Method] command in the [Options] menu.  The [Starting Method] dialog box is displayed.

� Select a method for starting this loader, and click the [OK] button.

<Available starting methods>

����� Start in the previous status
The project that was opened when the loader was terminated is opened and restored when the loader is started the next time.
For example, if two projects were opened when the loader was terminated, the two projects are opened when the loader is
started the next time.  If there was a project that was connected online to monitor the operation of a PLC, the project is
connected online to the PLC and starts monitoring.

����� Open previous file/project
Only the offline projects that were opened when the loader was terminated are opened and restored when the loader is
started the next time.
For example, if two projects were opened when the loader was terminated, the two projects are opened when the loader is
started the next time.  If there was a project that was connected online to monitor the operation of a PLC, neither online
connection is made nor is the project opened.

����� Load from previously connected PLC
Only the online connected projects that were opened when the loader was terminated are opened and restored when the
loader is started the next time.
For example, if two projects were opened when the loader was terminated, the two projects are not opened when the
loader is started the next time.  If there was a project that was connected online to monitor the operation of a PLC, the
project is connected online to the PLC and starts monitoring.

����� Start with wizard
When the loader is started, the wizard for creating a new project is opened.

����� No file/project is opened
Even when the loader was terminated with a project opened, no project is opened when the loader is started the next time.
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3-6-4 Options Menu - MICREX-SX Communications
This command is used to make communication setting and modem setting for connection with PLC of the MICREX-SX Series.

The MICREX-SX Series performs communication through the Message Manager. As the communication interface, COM Port,
Communication Board, or USB Port can be selected. Even if you change this setting during online operation, it is not reflected.
Changes made in this dialog are enabled only at the time of online mode connection.

When COM Port is selected, the MICREX-SX communicates with PLC using the COM port.
For “Communications”, select the communication port of the computer from Com 1 to Com 286. Make detailed communication
setting using the Comm Port Properties button. The following settings are required to perform loader port of PLC.

Transmission rate: 38400 bits/second
Data bit: 8 bits
Parity: Even parity
Stop bit: 1 bit
Flow control: None

When Communication Board is selected, the MICREX-SX communicates with PLC using the communication board.
For Board Type, select the type of the communication board used for communicates with PLC. For Parameter, enter settings of
the communication board.
For details on parameter settings for each board, refer to Appendix, “Parameters for Using Communication Board.”

When USB Port is selected, the MICREX-SX communicates with PLC using the USB port.
To install the USB driver, connect the USB connector of the MICREX-SX to the personal computer and then, when the device
driver is requested, specify the folder containing setup file SxUsb.inf. Subsequently, follow directions of the setup program.
SxUsb.inf is stored in folder Driver\MICREXSX under the folder in which this loader is installed.

When Modem is selected, the MICREX-SX communicates with PLC through a telephone line. Select the modem installed and
then enter the telephone number of the remote site.

For Time out, specify the time to wait for response from connected devices (CPU module, modem, etc.) in ms.
If no response is received from a device after the specified time has elapsed, retrial processing is performed twice. If there is
no response, a communication error results. Therefore, the total monitor time for response is [timeout setting x 3].
For Data size, specify the maximum value transferred in communication with the controller.
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<Parameters when using communication board>

Parameter settings of the communication board differs according to the board type. Make setting referencing the following:

1) In the case of SX bus board
There is no parameter.

2) In the case of P link board
“Communication partner point P station No.”
Example: 15 (decimal notation)

3) In the case of PE link board
“Communication partner point PE station No.”, “Own No.”
Example: 63 0 (decimal notation)

4) In the case of ISA bus PLC board
There is no parameter.

5) In the case of Ethernet
“Partner IP address”, “Port No.”
Example: 192.0.0.7507 (decimal notation)

6) In the case of PCI bus SX bus board
There is no parameter.

7) In the case of PCI bus PLC board
There is no parameter.

8) In the case of PCI bus FL-net board
“Partner IP address”, “Own IP address”
Example: 192.168.250.5 192.168.250.1 (decimal notation)

9) In the case of FL-net (LAN board)
“Partner IP address”, “Own IP address”, “A = IP address”, “B = IP address”

Example: 192.168.250.5 192.168.250.1 A=192.168.250.1 B=192.168.250.2 (decimal notation)
* Parameters other than “Partner IP address”, “Own IP address” can be omitted.
* The allowable ranges of the node number (host address) in the “Own IP address” is 1 to 64.
* Be sure to make “Own IP address” agree with the IP address in the LAN board.

Note: To enter multiple parameters, put a blank (space) between between parameters as a delimiter.
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This menu offers the following commands:

� Status Bar ................................... Shows or hides the status bar.
� Main Toolbar ............................... Shows or hides the main tool bar.
� Project Window .......................... Shows or hides the project window.
� Message Window ...................... Shows or hides the message window.
� Trigger Window .......................... Shows or hides the trigger window.
� Save Window Boundary ............. Save the boundary position of the window.
� Default ........................................ Displays the value of word and double word devices during program monitoring in a form

which fits the operand (data type) of the instruction.
� Integer ........................................ Display the value of word and double word devices during program monitoring with

signed decimal number.
� Hexadecimal .............................. Display the value of word and double word devices during program monitoring with a

hexadecimal number.
� Zoom........................................... Changes the display size (zooming ratio) of the program window.
� Split Window ............................... Splits the program window into two sections: upper and lower sections.
� Ladder Filter ............................... Displays lines after filtering (extracting) them based on specified conditions.

(1) View Menu - Status Bar
This command is executed to hide the status bar from the display of the loader as required. The status bar is usually displayed
with this command checked.

(2) View Menu - Main Toolbar
This command is executed to hide the main tool bar from the display of the loader as required. The main tool bar is usually
displayed with this command checked.

(3) View Menu - Project Window
This command is executed to hide the project window from the display of the program window as required. The project window
is usually displayed with this command checked.

(4) View Menu - Message Window
This command is executed to hide the message window from the display of the program window as required. The message
window is usually displayed with this command checked.

(5) View Menu - Trigger Window (only for SPH2000)
This command is executed to hide the trigger window from the display of the program window as required. The trigger window
is usually displayed with this command checked.

(6) View Menu - Zoom
This command is executed to enlarge or reduce the ladder and data sheet of the program window. A zooming ratio of 50 to 300%
can be specified. The default value is 100%.
When you enter a zooming ratio and then press the <Enter> key or when you select a zooming ratio from the drop-down list
using the mouse, the zooming ratio of the window changes.

(7) View Menu - Split Window
This command splits the program window into two sections: upper and lower sections. When you execute this command, the
mouse pointer moves to the Divide button. To change the division position, press the up and down cursor keys or drag the
Divide button using the mouse.
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(8) View Menu - Ladder Filter
This command extracts ladder diagrams which contains a specified address or instruction type.

When you execute this command, the cursor moves to the Filter box. When extracting lines which contains the LD command or
X0, enter LD OR X0 and then press the <Enter> key. Then, the background color of this text box becomes red and only the lines
meeting the conditions are displayed. For conditions, only the OR logic can be used and up to five instruction types or
addresses can be specified.

To cancel the filter status, move the cursor to the Filter box, delete the displayed condition expression using the <Backspace>
key, etc., then press the <Enter> key. The display of the box is restored to “All (No Filter)” resulting in the usual ladder diagram
display.

* From V1.3 or later, the wild card specification function can be used for the “ladder filter function” which displays desired
ladder diagrams. Wild cards (an asterisk “*” and a question mark “?”) can be supplied to address specification in the
ladder filter function. When you specify “WM*” as shown below, the lines using device WM are all displayed.

<Using wild cards>

Example of wild card specification Example of address display Remarks

X*.* X02.0003, X03.0003, X03.001D

Y.*.*.* Y01.01.0002, Y02.05.0000, Y07.03.0003

Y* Y01.0002, Y02.05.0000

WL* WL0004, WL003B, WL005F

WM*30? WM000303, WM00030A

*M* M000009, WM00010E8, DM00050, WSM0007

?L WL000A00, DL00021 Bit address is not displayed.
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The Window menu offers the following commands:

� Tile ............................. Displays windows in tile form.
� Cascade .................... Displays windows in cascade form.
� Arrange Icons ............ Arranges window icons.

(1) Window Menu - Tile
When you execute this command, all the program windows currently opened are arranged in tile form. All program windows
can be displayed in the loader with reduced window size.

Note: This command can be used only when two or more program windows are opened.

(2) Window Menu - Cascade
When you execute this command, all the program windows currently opened are arranged in cascade form.

Note: This command can be used only when two or more program windows are opened.

(3) Window Menu - Arrange Icons
This command aligns minimized program window icons.

Note: This command can be used only when two or more program windows are opened.
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This menu offers the following commands:

� Contents .......................... Displays the table of contents of Help.
� Shortcut Key List ............. Displays the shortcut key list.
� Topic Search .................... Searches for Help based on a keyword.
� How to Use Help ............. Explains how to use Help.
� About ................................ Displays the program copyright and version information.

(1) Help Menu - Contents
When you execute this command, the table of contents of Help of Programmer is displayed.

(2) Help Menu - Shortcut Key List
When you execute this command, the shortcut key list is displayed.

(3) Help Menu - Topic Search
When you execute this command, the Help search function of the Programmer is displayed. This function allows you to search
for a specific topic of Help using a specific keyword.

(4) Help Menu - How to Use Help
When you execute this command, how to use Windows Help is displayed. This allows you to find efficiently all the information
necessary to use Help.

(5) Help Menu - About...
When you execute this command, the copyright and version information of the loader are displayed.
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The MICREX-SX sets entire system operations, registers the modules to be used under configuration, and sets parameters.

4-1 System Definition of SPH Series

The following items are specified in the system definition of SPH series.

4-1-1 Registering Modules
(1) Module registration
With the MICREX-SX, it is necessary to register all the modules to be used under one configuration.
The following explains module registration procedures using the sample system configuration below.

<Sample system configuration>

Module registration

� Explained in “4-1-3 System property”.

Running definition, Memory size

I/O group setting

Fail-soft setting

System properties System running definition

System fail-soft activation

System redundancy definition

� Explained in “4-1-2 CPU parameter setting”. 

Registration of modules to be used

CPU parameters 

Explained in “4-1-1 Registering modules”.

Power supply

CPU

I/O

16

point

input

I/O

32

point

input

I/O

16

point

output

I/O

32

point

output

Empty slot (reserved for future installation of modules)

<System configuration registration screen>
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The method to open the system definition window depends on program display mode.

In “Package displays” mode, execute [System Definition...] command in the [PLC functions] menu.  The system definition
window is displayed.
In “Individual displays” mode, double-click [System Definition] on the project tree.  The system definition window isdisplayed.

Change the base board to 8-slot base to be used actually. Select a base board and then click the [Property] button. The
“Module property” dialog appears.

[Property] button

Select “NP1BS-08 8slots Base” from the [Outline specification] list box and then click the [OK] button. The base board
becomes the 8-slot base.
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Register module registration sequentially from the left of a base board. Since a power supply and a CPU module are
registered by the default, register the 16-point input module. To register (add) the module below the CPU module, select the
CPU module and then click the [Insert] button. The “Module insert” dialog appears.

[Insert] button

Inserted below the selected module.

Select the module
attribute.

Select the module type. Select the insertion position of module. Set module parameters.

Select the module (NP1X1606-W DC/AC Input 16points) according to the actual configuration. For SX bus station No., any
desired number from 1 to 238 can be specified. However, CPU modules are assigned to numbers 1, 2, 3, and so on from
right to left.
When you select a module and then click the [OK] button, the module is registered.

Select the SX bus station number.
For the CPU and processor link
module, select the CPU number.

Select a module.
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Register modules in the same manner. If you want to mount a module in the future and leave the slot unused as shown in
the system configuration, specify the SX bus station number and the module to be mounted in the same manner as other
modules, check [No equipment], then click the [OK] button.

The module is registered with its icon marked “Not mounted.”

[No equipment batch setting] button

[No equipment batch release] button

* With V2.2.0.0 or later version, no equipment registration of modules/units registered in the system definition can be collectively
made or cancelled on the system registration screen. When collectively making/cancelling no equipment registration of the
entire system, press the button with the “System structure” selected. Likewise, when collectively making/cancelling no
equipment registration of modules/units on a base board, press the button with the base board selected. For units connected
to a remote I/O master module, press the button with the remote I/O master selected.

[No equipment] button
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(2) Module parameter setting
The following describes the procedure for setting module parameters for the MICREX-SX, i.e., the procedure for setting
parameters of input and output modules. Refer to 4-3, “CPU Parameter Setting” for parameter setting for the CPU module.
For other modules, refer to the manual of each individual module.

Select the module for parameter setting from the system configuration registration screen and then click the [Property]
button. The “Module property” dialog appears.

[Property] button

Click here.

Click the [Parameter] button. The parameter setting dialog for the module appears.
The parameter setting dialog differs for each module type. The following shows the setting dialog for the input module.

Set the input filter time.

Set each item and then click the [OK] button. The “Module property” dialog appears again. Click the [OK] button of the
“Module property” dialog to complete registration.

Note: Parameter setting for each module can be performed also at the time of module registration.
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<Parameter setting for output module>

Two parameters can be set for the digital output module.

1) HOLD Definition

If the system fails and the CPU module stops, this setting is used to retain the output condition immediately before the
failure occurs or retain, while the CPU stops, the output condition immediately before the CPU stops.

2) System DO (Output) Definition

A bit which outputs the operating status of the system regardless of application can be defined in each configuration.
It is set to ON when the entire system is operating normally or OFF if a failure (fatal fault) occurs in the system. Only bit 0 of
the output module can be set.

<Operating procedure>

Select the digital output module for parameter setting from the system configuration registration screen and then click the
[Property] button. The “Module property” dialog appears.
Click the [Parameter] button. The “Direct I/O parameter setting” dialog of the output module appears.

To perform HOLD definition, set the [HOLD mode] button to ON.
To perform System DO definition, set “Select system digital output” check box to ON.
Upon completion of system parameter setting, click the [OK] button.
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(3) Module deletion
The following describes the procedure for deleting a registered module.

Select a module to be deleted from the module registration screen and the click the [Delete] button.

[Delete] button

Select the module to be deleted.

Click the [Yes] button. The selected module is deleted.
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4-1-2 CPU Parameter Setting
Parameter settings for the CPU module include “CPU Running Definition”, “CPU Memory Size Definition”, “I/O Group Setting”,
“Fail-Soft Operation Setting” and “Constant scanning setting (only for SPH2000)”.

(1) CPU running definition
Select a CPU from the system configuration screen and then click the [Property] button. The “Module property” dialog for the
CPU appears.

[Parameter] button

Click the [Parameter] button. The “CPU parameter” dialog appears.
The dialog consists of four tab pages. The “CPU Running Definition” tab page is displayed first.

Note: Set an integral multiple of the tact time for the constant scanning time.
For details, refer to “User’s Manual <Instructions> (FEH588)”.
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(2) CPU memory size definition
The size of the data memory in the CPU module is set.
The default size of data memory is predetermined for each CPU module, but you can change the size of individual memory
area in 0.5-k word steps as needed.  For more information of the memory of individual CPU module, see the “User’s Manual
<Instruction>” (FEH588).

1) SPH200/300 series

Click the [Memory allocation setting] tab on the [CPU parameter] dialog box. The [Memory allocation setting] tab page
appears.

Enter the size of each memory in the text box, and then click the [OK] button.
Click the [Default] button when you want to reset to default values.

For SPH300, all the remainder

after setting these 3 memory 

capacities becomes the capacity 

of non-retain memory.

For standard CPU modules, the 

user can set the capacity of 

non-retain memory, and the 

remainder becomes the memory 

capacity for initial data.

Edge detection, counter, addition

timer and timer can also be set 

for system FB.  The remainder 

becomes the area for other FBs.
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2) SPH2000 series (NP1PM-48R/48E)

Click the [Memory allocation setting] tab on the [CPU parameter] dialog box. The [Memory allocation setting] tab page
appears.
Make the settings for non-retain memory and other types of memory.

Enter the size of each memory in the text box, and then click the [OK] button.
Click the [Default] button when you want to reset to default values.

* If inter-CPU memory access is performed using a processor bus on a SPH2000 series multi-CPU system,
General memory  memory area must be reserved in multi-CPU non-retain memory.
Retain memory  memory area must be reserved in multi-CPU retain memory.

The reserved memory addresses are as follows.
Multi-CPU non-retain memory: Starting at WM . 98304
Multi-CPU retain memory: Starting at WL . 32768

The CPU number is entered in .

If memory other than non-retain 

general memory is changed, 

the non-retain general memory 

and memory selected via the 

automatic calculation button 

become a buffer, increasing or 

decreasing in size.

In the example of the right figure, 

when the multi-CPU non-retain

memory, retain memory,

multi-CPU retain memory, or 

user FB memory is changed, the 

system FB memory selected via 

the automatic calculation button 

automatically grows or shrinks.

If the number of edge detection, 

counter, or addition timer points 

is changed, the system-FB 

capacity other than that grows or 

shrinks.

Set whether to make a buffer when

changing each memory, etc.
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2) SPH2000 series (NP1PM-256E)

Click the [Memory allocation setting] tab on the [CPU parameter] dialog box. The [Memory allocation setting] tab page
appears.
Make the settings for non-retain memory and other types of memory.

To change the number of edge detection, counter, addition timer or timer points, click the [Detail] button. The [Detail of
system FB memory] dialog box appears. By clicking the corresponding tab, display the [Detail of system FB memory]
window or [Detail of system FB normal memory] window.
On this dialog, change the numbers of points of arbitrary items. If the number of points is changed, the word size of the
“Other system FB area” indicated at the bottom of the dialog is also changed. Click the [OK] button to complete the setting.

Enter the size of each memory in the text box, and then click the [OK] button.
Click the [Default] button when you want to reset to default values.

If the memory size is changed, 

the non-retain general memory 

and memory selected via the 

automatic calculation button 

become a buffer, increasing or 

decreasingin size.

In the example of the right figure, 

when the normal memory size, 

multi-CPU non-retain memory, 

multi-CPU retain memory, or 

user FB memory is changed, the 

system FB memory selected via 

the automatic calculation button 

automatically grows or shrinks.

In the example of the right figure, 

when the size of the retain 

memory, or user FB normal 

memory is changed, the system 

FB normal memory selected via 

the automatic calculation button 

automatically grows or shrinks.

Set whether to make a 

buffer when changing 

each memory, etc.



4-12

Section 4 System Definition

4-1 System Definition of SPH Series

<Note>

With V07 or later software version of NP1PM-256E, the memory arrangement has been changed for high-speed access of the
system FB memory. The combinations of CPU version and loader version with which the system FB memory high-speed
access function can be used are as follows.
In the user FB memory and system FB memory, user FB normal memory and system FB normal memory are accessible at
high speed. When using user FBs, the user FB normal memory and system FB normal memory are used first.

When using V6 or earlier software version of NP1PM-256E, check the [A CPU before V06 is used] check box ON.
If the check box is checked ON, the following window appears.

Click the [OK] button to complete the setting.

Note: When using V6 or earlier software version of NP1PM-256E, be sure to check this check box ON. Otherwise, programs
cannot be loaded to the CPU.

Software version
of NP1PM-256E

Loader version

Earlier than V2.3.1.0 V2.3.1.0 or later

V06 or earlier
Not supported
(conventional mode)

Not supported
(conventional mode)

V07 or later
Not supported
(conventional mode)

High-speed access supported
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(2) I/O group setting
This setting specifies the CPU and task which control input/output modules within the configuration.
This setting is important for the CPU module to access module input and output.

* When system definition is terminated without I/O group setting, settings are registered in the default task automatically.
When system definition is terminated, a warning is displayed.

Click the [I/O Group Setting] tab in the “CPU parameter” dialog. The “I/O Group Setting” tab page appears.

Select a task. Only the tasks under “Tasks” in the project tree are displayed.

Specify output as reference input. For details,
refer to <Input for referring output value>.

Click this button to register the
modules selected in the I/O List.

Module output can be registered on a point basis.
For registration procedure, refer to <Output detail setting>.

Select (click) a module from the I/O List and then click the register button. The selected module is registered.

Register all the modules to be controlled and then click the [OK] button.

Registered module

Only the modules occupying the input and output areas out of the modules
registered by Module Registration are displayed in the I/O List.
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<Standard setting>

When only one CPU is registered in the configuration and only task “DEFAULT” controls I/O, modules can be registered at one
time.

Select “DEFAULT” as Level and then click the [Standard setting] button. The module is registered automatically to the Input
select box and the Output select box.

Note 1: It is necessary to register modules with input/output area, such as the high-speed counter and the positioning module,
in both the [Input select] list box and the [Output select] list box.

Note 2: To reference an output module registered for other CPU modules in the multi-CPU system configuration, it is necessary
to register the output module in the [Input select] list box. Output modules registered in the [Output select] list box for
other CPU modules cannot be registered in duplicate manner.

[Input select] list box

[Output select] list box
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<Output detail setting>

With the multi-CPU system configuration, which CPU controls the module output can be specified on a bit or word basis.

Select a module for “output detail setting” from [Output select] and then click the [Detail] button.

When the digital output module is selected, the “Port mode IO Detail Setting” dialog is displayed.

All bits are selected by default.

Click the button corresponding to the bit to be controlled by other CPU to set it to OFF.
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Note 1: The dialog displayed when you click the [Detail] button differs according to the selected module.

<When the digital output module with pulse train output is selected>

<When the analog output module is selected>

Note 2: If you select a module which cannot perform “output detail setting”, the dialog for detail setting is not displayed even if
you click the [Detail] button.
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<Input for referring output value>

With the multi-CPU system configuration, if you want to use the output of an output module used by other CPUs as “Input” with
an application program of the local CPU, register the bit or word to “Input select” for the I/O group of the local CPU.

Select the output module to be referenced, click the [>>] button , then register it to “Input select”.

Click the [Input for referring output value] button. The “Port mode IO Detail Setting” dialog appears.

All bits are selected by default.

Click the button corresponding to the bit without output value reference to set it to OFF.

Bit with output value reference

Click the [OK] button.
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Note: When referencing analog output or other output values, setting on a word basis is required.
In this case, the “Memory mode IO Detail Setting” dialog appears.
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(3) Fail-soft operation setting
Even if a failure occurs in a module or unit on the SX bus and remote I/O (T link, etc.), operations of other normal modules and
units are continued. This operation is referred to as “fail-soft” operation.

Click the [Fail-Soft Operation Setting] tab in the “CPU parameter” dialog. The “Fail-Soft Operation Setting” tab page appears.

Select a module for fail-soft operation setting and then click the [>>] button.

For example, when RT1:TLINK-00 is registered,
all modules on the extension unit are registered.

Click the [OK] button.

Note: For extension units on the remote I/O, fail-soft operation is registered for each individual unit. Registration for each
module is not possible.

[Register] button

[Batch registration] button

[Reset] button

[Batch reset] button
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4-1-3 System Property
In the System property dialog, “System Running Definition”, “Redundancy setting”, and “Fail-soft operation setting” can be
specified. The following describes the procedure for setting system running definition and fail-soft operation setting.

(1) System running definition
The system running definition includes SX bus tact time setting, configuration check wait time setting, and initialization mode
selection.

1) SX bus tact time

The SX bus tact time refers to the interval of data data communication with modules (input/output module, etc.) connected to
the SX bus.
For SX bus tact, select 0.5, 1, 1.5, 2, 2.5, ... 9.5, and 10ms. The default value is 1.0ms.

2) Waiting time for structure check

When the power of the system is turned on, the CPU module starts configuration check of all modules on the SX bus.
When all the modules has been activated within the time specified as “Waiting time for structure check”, the system starts.
When the system consists of multiple bases and the power of each base is turned on at different timing, adjust the tact
time with “Waiting time for structure check.”
(The default value of “Waiting time for structure check” is 20 seconds. It can be specified within a range from 1 to 180
seconds.)

3) Initialization method

When the power of the system is turned on, the CPU module is initialized. This setting allows you to specify whether CPU
module internal memory diagnosis is performed or not.

4) Start up system without CPU “0”

This setting allows you to specify whether the system is started up when “0” station does not exist in a system such as a
duplex system.

Select “System property” in the system configuration definition screen (Configuration window) and then click the [Property]
button. The “System Running Definition” tab page is displayed in the “System property” dialog.

Set the SX bus tact time.

Set the waiting time for structure check.

Select the initialization method.

Set each item and then click the [OK] button.

Specifiy whether to start up the system without CPU “0”.
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(2) Fail-soft operation setting
When the MICREX-SX system is activated, if there are modules whose power cannot be turned on (modules under fail-soft
operation, such as the servo module), the system can be activated by excluding these modules after the configuration check
waiting time has elapsed. In this case, the system starts operation in the nonfatal fault condition.

Click the [Fail-soft operation setting] tab in the “System property” dialog. The “Fail-soft operation setting” tab page appears.

If there is any device under system fail-soft operation, select “Partial Fail-soft start up” and then enter the SX bus station
number from which fail-soft operation is to be started.
Click the [OK] button.
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(3) System redundancy definition
If a failure occurs in an Active CPU module, the mating Standby CPU operates to continue PLC system operation. This
configuration is referred to as CPU redundancy.

<Overview of redundancy system>
1) 1-to-1 redundancy system

A redundancy system with one Standby CPU for one Active CPU. Each of CPU0-CPU1, CPU2-CPU3, CPU4-CPU5, and
CPU6-CPU7 indicates a pair of an Active CPU and a Standby CPU. Therefore, when building a multi-CPU 1-to-1 redundancy
system, up to four CPUs are installed. In this case, the same application program is used.

<Example of redundancy system configuration>
Generally, the Active CPU and Standby CPU are mounted on different base boards and other modules to be controlled by
the CPU are mounted on another base board, as shown below. If the Active CPU fails and the Standby CPU is activated, this
configuration makes it possible to replace the failed CPU during operation of the Standby CPU.

Note: It is also possible to build a redundancy system with an Active CPU and a Standby CPU mounted on the same base
board. In this case, however, the Standby CPU module cannot be replaced during system operation.

2) N-to-1 redundancy system

A redundancy system with one Standby CPU for multiple (2 to 7) Active CPUs. Up to two pairs of N-to-1 redundancy groups
can be defined for each configuration. The CPU module with the largest CPU number functions as the Standby CPU within
a registered group.

<Example of N-to-1 redundancy system configuration>

CPU 0 CPU 1

Empty slot

* On the base board mounting the CPU, only the power supply and CPU are mounted.

Empty slot

* On the base board mounting the CPU, only the power supply and CPU are mounted.

CPU 0 CPU 1 CPU 2 Memory card if module
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<System redundancy definition>
1) Module registration

Modules and units to be mounted are registered in the same manner as usual systems.

Register modules according to the actual system configuration, as shown below.

For the CPU module which functions as Standby CPU
by default, select “Standby CPU” as Resource name.
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2) System redundancy definition

With the system redundancy definition of System property, redundancy ON/OFF and the redundancy mode (1-to-1
redundancy, N-to-1 redundant), etc. are specified.

Select System property in the system configuration definition tree and then click the [Property] button. The “System property”
dialog appears.

[Property] button

Click the [Redundancy setting] tab in the “System property” dialog. The “Redundancy setting” tab page appears. Set each
item and then click the [OK] button.

Turn redundancy ON or OFF.

Make setting for 1-to-1 redundancy system.

Make setting for N-to-1 redundancy system.
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<Settings for 1-to-1 redundancy system>
Settings for 1-to-1 redundancy system are shown below. With the 1-to-1 redundancy system, the mating CPUs are
predetermined and up to four pairs can be specified.

Select a pair of CPUs for 1-to-1 redundancy.
Mating CPUs are predetermined as shown below.

Specify the memory copy range for the case of warm standby
system with 1-to-1 redundancy. The range from the top of the
AT specification area to the size specified here is the copy range.

Specify whether interlock selection is made or
not with the multi-CPU system configuration.

Select the standby mode.

<Settings for N-to-1 redundancy system>
Settings for N-to-1 redundancy system are shown below. With the N-to-1 redundancy system. up to two groups of N-to-1
redundancy systems can be built.

Specify Active CPUs for N-to-1 redundancy. Select Standby CPU for N-to-1 redundancy.

Select the SX bus station number of the memory card
interface module for storing a project of Active CPU.
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The following items are specified in the system definition of SPB series.

4-2-1 Registering Units
(1) Unit registration
With the MICREX-SX, it is necessary to register all the units to be used under one configuration.
The following explains module registration procedures using the sample system configuration below.

<Sample system configuration>

Units registration

CPU running definition

Memory allocation

I/O group setting

High-speed counter

I/O running mode

� Explained in “4-2-2 Basic unit parameter setting”. 

Registration of units to be used

Basic unit parameters

Explained in “4-2-1 Registering units”.

Basic unit with 40 I/O points Analog unit

RS-232C communication adapter

Expansion unit with 16 I/O points
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The method to open the system definition window depends on program display mode.

In “Package displays” mode, execute [System Definition...] command in the [PLC functions] menu.  The system definition
window is displayed.
In “Individual displays” mode, double-click [System Definition] on the project tree.  The system definition window is displayed.

Units are registered in their connected order; the unit on the right of the basic unit is registered just below the basic unit.
Select the basic unit and then click the [Insert] button. The [Module insert] dialog box is displayed.

[Insert] button

Select a unit.

Select the module type.

Set module parameters.

Select the insertion position of module.
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Select the unit (NW0AX04-MR: Analog Input 4CH) according to the actual configuration. Units’ station numbers are
automatically determined according to their connected order. When you select a unit and then click the [OK] button, the unit
is registered.

Register units in the same manner.
Since only one communication adapter can be connected on the left side of the basic unit in a single SPB system, its
station number is fixed to “8”.

* The communication adapter is registered at the bottom of the system definition screen regardless of the registered order.
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4-2-2 Basic Unit Parameter Setting
The basic unit parameter setting includes five setting items: “CPU running definition”, “memory allocation”, “I/O group setting”,
“high-speed counter”, and “I/O running mode”.

(1) CPU running definition
Select the CPU for parameter setting from the system configuration registration screen and then click the [Property] button.
The “Basic unit parameter” dialog appears.
The dialog box consists of five windows, which can be changed over by clicking the corresponding tab.
The “CPU running definition” status is displayed first. Set all necessary items.
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(2) Memory allocation
When you click the “Memory allocation setting” tab, the following window appears. Set all necessary items.

(3) I/O group setting
When you click the “I/O group setting” tab, the following window appears.
Each unit that is registered to the system configuration definition is automatically assigned to “DEFAULT” task.
Set all necessary items.
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(5) I/O running mode
When you click the “I/O Running mode” tab, the following window appears.
Set all necessary items.

After setting each parameter of the basic unit, click the [OK] button to complete the setting.

(4) High-speed counter setting
When you click the “HI Counter Definition” tab, the following window appears.
Set all necessary items.
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With version V1.4 or later, the “simulation” function has been added which allows you to check operation of a created circuit
offline.

The simulation is provided with the following functions:
Monitor function in the ladder screen *
Monitoring and data setting functions in data display/setting dialog *
Simulation screen function
Auto feedback function

*Operation of display specifications are the same as those of the online monitor.

Appendix 1-1-1 Screen Configuration at Simulation
In the following example, the ladder screen and the simulation screen are displayed for simulation.

* The simulation screen arranges push buttons for simulation and graphical objects for data setting/display, allowing easier
simulation operation.

Ladder screen

Simulation tab page
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Appendix 1-1-2 Specifications of Simulation Function

Note 1: This simulation function is used to check program logic operations. It does not allow process simulation of the entire
system.

Note 2: The accuracy of the timer is not ensured.

Note 3: About the simulation screen and AFB screen
(a) When a project created with a version earlier than V1.4.*.* is opened, it is necessary to save it once with V1.4.*.* or

later version since the simulation screen and SFB screen are not provided.
(b) When online, the AFB screen is not displayed.
(c) After online connection, the simulation screen is not displayed. Transfer a project saved with V1.4.*.* or later

version to the PLC by using the [Load] command to display the simulation screen.

Note 4: Even if simulation is stopped, contents of all memories are hold. If you want to clear them, use the [Memory Clear]
command in the [PLC Functions] menu.

Specification and function Description

Simulation target
User program registered to tasks
* User functions and user function blocks need to be used by the user program.

Restrictions on instructions

1) Communication-related FBs have some restrictions because they have no remote
station to communicate with. Refer to Appendix 1-1-3, "Details of Instruction Operation
Restrictions" for detailed restrictions/operations. There are restrictions as for the
following FBs.
M_OPEN, M_SEND, M_RECEIVE, READ_WORD, READ_BOOL, WRITE_WORD,
WRITE_BOOL, R_READ, R_WRITE, F_READ, F_WRITE, EXT_S_S, BANK_CHG,
T_S, HW_RTC, FFST, FILO, FIFO

2) As for extension FBs supplied from Fuji Electric, simulation cannot be performed
normally.

Tact cycle

The tact cycle is fixed to a multiple of 10ms.
Example: 20ms if the task processing time exceeds 10ms. 30ms if it exceeds 20ms.
Example: When the tact cycle setting is less than 10ms, a tact cycle of 10ms is assumed.
Example: When the tact cycle of a fixed-cycle task is 35ms, a tact cycle of 40ms is

assumed.

Operation at FB monitoring
The path currently being used is displayed during monitoring of FBs currently being called
(used) by multiple locations.

Simulation screen

Graphic objects are arranged in the Simulation tab page, allowing easy simulation operation.
Graphic objects which can be arranged include "label", "button", "switch", "lamp", "analog
display", "analog input", and "timer/counter."
Refer to Appendix 1-2-2, "Using Simulation Screen" for details on each object.

Auto feedback screen
Allows creation of a circuit for automatic response to the AFB (auto feedback) tab page.
Only one AFB tab can be used for on project.
Refer to Appendix 1-2-3, "Using Auto Feedback (AFB)" for details.
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Appendix 1-1-3 Details of Instruction Operation Restrictions
Since the PLC Programmer performs the simulation function in the offline mode, operations are restricted with respect to
communication-related FBs requiring a remote site to communicate with.

(1) M_OPEN
<Operation>

Performs error check and memorizes the result using a scan where a rising edge of open request “S2” was detected. If no
error occurs, this function registers the remote station port number “S9” specified by the combination of module number
“S3”, channel number “S4”, station number “S5”, and module type “S6”, and local port number “S10” in the list, then outputs
the registration number as connection number “D4.”
Prepares send and receive buffers (4096 words each) as a port for each “D4.”
Memorizes whether the remote station is within the configuration or not according to the value of module type “S6”  terminal.
If no error occurs, this function turns on the open enable flag “D1” output at the next scan; otherwise, it outputs the error
code to error status “D3”, then turns on the open error flag “D2” output for one scan.
Closes the currently opened port at a scan where a falling edge of open request “S2” was detected and turns off open
enable flag “D1” at the next scan.

<Error status “D3”>

If “S3” is out of the range of the SX station number (1 to 254), 177 (B1h) results.
If “S10” is not within the range from 1 to 127, 200 (C8h) results.
If an attempt to open 57 or more ports (exceeding 28 pairs) is made, 201 (C9h) results.

(2) M_SEND

<Operation>
Performs error check at the scan next to the one at which a rising edge of send request “S2” was detected and, if no error
occurs, writes transmit data “S4” (the number of words specified by “S5”) to the transmit buffer with connection number
“S3” obtained by M_OPEN. (The remote station uses this buffer as a receive buffer.)
If no error occurs, normal completion flag “D1” turns on for one scan; otherwise, error flag “D2” turns on for one scan and
the error code is output to error status “D3.”
With extra-configuration communication, operation is terminated immediately after data has been written to the buffer.
With intra-configuration communication, operation is continued until the remote station has read the data written in the buffer.

<Error status “D3”>

If the remote station is closed during extra-configuration communication, 199 (C7h) results.
If the remote station is closed during intra-configuration communication, 200 (C8h) results.
If S5 exceeds 4096 during extra-configuration communication, 206 (CEh) results.
When S5 exceeds 2048 during intra-configuration communication, 206 (CEh) results.
If the value of S5 is 0, 177 results.
If the transmit data storage device (S4) is out of the memory area, 177 results.

Note: When S4 is specified indirectly, no operation results.

(3) M_RECEIVE
<Operation>

Performs error check at the scan next to the one at which a rising edge of send request “S2” was detected and, if no error
occurs, reads the data in the receive buffer with connection number “S3” obtained by M_OPEN and then writes the data
(the number of words specified by “S5”) to the area specified by receive data “S4.” (The remote station uses this receive
buffer as a transmit buffer.)
If no error occurs, normal completion flag “D1” turns on for one scan; otherwise, error flag “D2” turns on for one scan and
the error code is output to error status “D3.”
If the receive data has not yet been received, this function waits until the remote station writes the data to the buffer.

<Error status “D3”>

If the remote station is closed during extra-configuration communication, 199 (C7h) results.
If the remote station is closed during intra-configuration communication, 200 (C8h) results.
If S5 exceeds 4096 during extra-configuration communication, 206 (CEh) results.
When S5 exceeds 2048 during intra-configuration communication, 206 (CEh) results.
If the value of S5 is 0, 177 (B1h) results.
If receive data “S4” is out of the memory area, 177 (B1h) results.

Note: When S4 is specified indirectly, no operation results.
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(4) READ_W, READ_B

<Operation>
Reads the variable indicated by remote station read device “S4” into data storage device “S5” at the scan next to the one
at which a rising edge of read request “S2” was detected.
If no error occurs, normal completion flag “D1” turns on for one scan.
If an error occurs, error flag “D2” turns on for one scan and the error code is output to error status “D3.”

<Error status “D3”>

If the CPU code of the device specified by S4 is FF, 176 (B0h) results.
If 0 is input to S3, 177 (B1h) results.
If the data storage area (S5) is out of the memory area, 177 (B1h) results.

Note: When S4 and S5 are specified indirectly, no operation results.

(5) WRITE_W, WRITE_B
<Operation>

Writes write data “S5” to remote write device “S4” at the scan next to the one at which a rising edge of write request “S2”
was detected.
If no error occurs, normal completion flag “D1” turns on for one scan.
If an error occurs, error flag “D2” turns on for one scan and the error code is output to error status “D3.”

<Error status “D3”>

If the CPU code of the device specified by S4 is FF, 176 (B0h) results.
If 0 is input to S3, 177 (B1h) results.

Note: When S4 and S5 are specified indirectly, no operation results.

(6) R_READ

<Operation>
Performs only error check at the scan next to the one at which a rising edge of read request “S2” was detected, but does
not perform data transmission.
If no error occurs, normal completion flag “D1” turns on for one scan.
If an error occurs, error flag “D2” turns on for one scan and the error code is output to error status “D3.”

<Error status “D3”>

If 0 is input to read data size “S8”, 177 (B1h) results.
If read data storage device “S9” is out of the memory area, 177 (B1h) results.
If SXX bus station number “S3” of the communication module is out of the range of the SX station number (1 to 254), 177
(B1h) results.

Note: When read address “S7” and read data storage device “S9” are specified indirectly, no operation results.

(7) R_WRITE
<Operation>

Performs only error check at the scan next to the one at which a rising edge of write request “S2” was detected, but does
not perform data transmission.
If no error occurs, normal completion flag “D1” turns on for one scan.
If an error occurs, error flag “D2” turns on for one scan and the error code is output to error status “D3.”

<Error status “D3”>

If 0 is input to write data size “S8”, 177 (B1h) results.
If write data storage device “S9” is out of the memory area, 177 (B1h) results.
If SX bus station number “S3” of the communication module is out of the range of the SX station number (1 to 254), 177
(B1h) results.

Note: When write address “S7” and write data storage device “S9” are specified indirectly, no operation results.
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(8) F_READ
<Operation>

Performs only error check at the scan next to the one at which a rising edge of read the request “S2” was detected and, if
noerror occurs, reads the number of words specified by read data storage size “S5” from the file specified by file name
“S4”,then writes it to the area specified by read area start address “S6.”
Since the number of words actually read may differ from the number of words specified by S5, this function outputs the
number of words actually read to read file size “D4.”
If no error occurs, normal completion flag “D1” turns on for one scan.
If an error occurs, error flag “D2” turns on for one scan and the error code is output to error status “D3.”
The full path for the target file is formed by combining sub-directory “Files” created under the directory where the loader
(flexpc.exe) exists with the path character string specified by S4. For example, if the loader (flexpc.exe) exists in C:\FujiElec
and S4 is “Params\Param1.txt”, the full path for the target file is C:\FujiElec\Files\Params\Param1.txt. If sub-directory “Files”
does not exist, it is created by the loader (flexpc.exe).

<Error status “D3”>

If the specified file does not exist, 65 (41h) results.
If the data storage area (S6) is out of the memory area, 177 (B1h) results.
If S3 is out of the range of the SX station number (1 to 254), 177 (B1h) results.

Note: When S4 and S6 are specified indirectly, no operation results.

(9) F_WRITE
<Operation>

Performs only error check at the scan next to the one at which a rising edge of write request “S2” was detected and, if no
error occurs, writes the number of words specified by write data size “S5” from the area specified by write area start
address “S6” in the file specified by file name “S4.” If the file does not exist, it is created; otherwise, it is overwritten.
If no error occurs, normal completion flag “D1” turns on for one scan.
If an error occurs, error flag “D2” turns on for one scan and the error code is output to error status “D3.”
The file location is the same as the case of F_READ.

<Error status “D3”>

If the directory included in the file path specified by S4 does not exist, 65 (41h) results.
If the data storage area (S6) is out of the memory area, 177 (B1h) results.
If S3 is out of the range of the SX station number (1 to 254), 177 (B1h) results.

Note 1: When S4 and S6 are specified indirectly, no operation results.
Note 2: When the directory is included in the file path specified by S4, be sure to create that directory under sub-directory “Files.”
Note 3: When S4 and S6 are specified indirectly, no operation results.

(10) EXT_T_S
<Operation>

Performs error check at the scan next to the one at which a rising edge of test & set request “S2” was detected, then
outputs 0 to test & set result “D2.”
If no error occurs, normal completion flag “D1” turns on for one scan.
If an error occurs, error flag “D3” turns on for one scan and the error code is output to error status “D4.”

<Error status “D4”>

If both the CPU codes and remote station number of the device specified by S3 are FF, 170 (AAh) results.

Note: When S3 is specified indirectly, no operation results.

(11) BANK_CHG
<Operation>

Performs only error check at the scan next to the one at which a rising edge of S2 was detected.
If no error occurs, D1 turns on for one scan.
If an error occurs, D2 turns on for one scan and the error code is output to D3.

<Error status (D3)>

If S3 is out of the range of the SX station number (1 to 254), 64 (40h) results.

(12) FFST, FILO, FIFO, T_S
<Operation>

The error flag is always OFF.

(13) HW_RTC
<Operation>

The clock in the CPU is not set because of offline operation.
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Appendix 1-2-1 Basic Simulation Procedure
The simulation procedure for the created program is shown below.

After editing the program in the offline mode, click the [Edit Project] button. The editing mode changes to the monitor mode.

[Edit Project] button

Click the [Start/Stop] button. The simulator starts allowing program monitoring.

[Start/Stop] button

* Data monitor/setting can be operated in the same manner as online monitoring.



App.1-7

Appendix 1 Specifications of Simulation

Appendix 1-2 Simulation Procedure

Appendix 1-2-2 Using Simulation Screen
The use of the simulation screen makes it easier to perform simulation.

<Using simulation screen>

Label

Button Lamp Timer/counter Analog input

(1) Objects which can be used in the simulation screen
Seven different objects can be arranged at any position in the simulation screen.

<Speed buttons for the simulation screen when opened in the editing mode>

[Switch] button [Lamp] button

[Button] button

[Label] button

[Analog Input] button

[Timer/Counter] button

[Analog Display] button

1) Label

Used to create characters. The character font, size, and color can be specified.

<Label setting dialog>

Main settings for the label dialog are shown below.

Enter a label name.

Specify the character, size, and color.
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2) Button

Used to create a button which turns on when clicked.
A bit device (mandatory) to be assigned to the button, switch size, color when ON, color when OFF, button name, button
operation (momentary or latch) can be specified.

<Button setting dialog>

Main settings for the button setting dialog are shown below.

Specify address of the bit device which turns on when the button is clicked.

Specify operation when the button is clicked. (The default setting is momentary.)

Enter name of the button.

Specify color when the button is OFF (not clicked).

Specify color when the button is ON (clicked).

3) Switch

Used to create a slide switch which turns on when clicked and off when clicked again.
A bit device (mandatory) to be assigned to the button, switch size, button type (horizontal slide or vertical slide), and button
name can be specified.

<Switch setting dialog>

Main settings for the switch setting dialog are shown below.

Specify address of the bit device which turns on when the button is clicked.

Enter name of the button.

Enter button type.

Horizontal
     slide
(Horizontal)

Vertical
   slide
(Vertical)
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4) Lamp

Used to create a lamp which displays the ON/OFF status of the specified bit device.
A bit device (mandatory) to be assigned to the lamp, lamp size, color when ON, color when OFF, and lamp name can be
specified.

<Lamp setting dialog>

Main settings for the lamp setting dialog are shown below.

Enter address of the bit device.

Enter lamp name.

Specify color when the lamp is OFF (device OFF).

Specify color when the lamp is ON (device ON).

5) Analog display

Used to create a box which displays the data value of the specified device.
A device (mandatory) to be displayed, display data type (mandatory), display box size, and box name can be specified.

<Analog display setting dialog>

Main settings for the analog display setting dialog are shown below.

Specify address of the device.

Enter name of the display box (display device).

Specify display data type.

Specify display data size.
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6) Analog input

Used to create a slider (or data input box) used to enter data in a specified device.
The target device (mandatory), input data type (mandatory), minimum value, maximum value, display box size, input form, and
name can be specified.

<Analog input setting dialog>

Main settings for the analog input setting dialog are shown below.

Specify address of the device.

Enter name of the display box (display device).

Enter maximum value of the input data.

Enter minimum value of the input data.

Specify input data type.

Specify input data format.

Specify input data size.

   Slider
(stSlider)

 Input box
(stEditbox)

7) Timer/Counter

Used to create a display box which displays the setting and current value of a specified timer or counter.
In addition to settings of the timer/counter to be displayed (mandatory), the display color at the time of time-up (count-up) can
be specified. The display box has two rows and the setting is displayed in the lower row and the current value in the upper one.

<Timer/counter setting dialog>

Main settings for the timer/counter setting dialog are shown below.

Specify address of the timer/counter (mandatory).

Specify name of the timer/counter.

Specify POU using the timer/counter to be assigned (mandatory).

When timer/counter is used in a User FB, specify the FB instruction and instance number.
(Example: FB0.011 (FB name: FB0, instance number: 011 - Note))

Specify task to which the corresponding POU is assigned (mandatory).

Specify color of the box at the time of count-up.

Note: When timer/counter is present in a user FB called within a user FB,
use a colon (:) to delimit them (nesting structure).
Example: FB0.011:FB1.02
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(2) Simulation screen creation procedure
The following describes the procedure for creating a button, lamp, and timer display in the simulation screen as shown below.

Button
Lamp Timer display

Click the Simulation tab in the editing mode. The simulation screen appears.
Create a button first. Click the [Button] button and then move the pointer to the simulation screen. A button mark is attached
to the pointer as shown below and the button arrangement mode is entered.

Click a position where you want to put a button. A button is created and a dialog for specifying button properties appears.
Set each item. In the following example, corresponding bit address in PLC, button name, and color when ON/OFF are
specified.

Button name

Assigned device

Address specification
Contact connected to external input
can be specified here conveniently.

Button name

Color when OFF

Color when ON
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Then, create a lamp. Click the [Lamp] button and then a position where you want to put a lamp in the simulation screen. A
lamp is created and a dialog for specifying lamp properties appears.
Specify each item. In the following example, corresponding bit address in the PLC and lamp name are specified. As the
color when ON/OFF, the default value is used.

Lamp name

Assigned device

Address specification

Lamp name

Color when OFF

Color when OFF

Create a box for displaying the current value/setting of the timer. Click the [Timer/counter] button and then a position where
you want to put a display box in the simulation screen. A display box is created and a dialog for specifying timer display box
properties appears.
Specify each item. In the following example, corresponding timer address in the PLC and display box name are specified.
As the color for count-up, the default value is used.

Assigned timer

Display box name

Address specification of timer

Display box name

Target POU name
(POU calling T0)

Name of task to which corresponding
POU is assigned

Display color for count-up
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(3) Simulation operation program
The following simple line was created for simulation operation check.

(4) Simulation operation check
When the simulation screen and simulation program have been created, simulations is performed.

Click the [Edit Mode] button to change the mode from the editing mode to the monitor mode.

Click the [PLC Run/Stop] button to start the simulator.

When you click the start input button, the start display lamp goes on (in red) allowing the timer current value to be monitored.

Timer current value

Timer setting
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Appendix 1-2-3 Using Auto Feedback (AFB)
The auto feedback function is used to automate simulation of the created program.
For example, to perform simulation of communication with external devices, when the signal or program turns ON and the
program created in auto feedback outputs a value to a desired device, simulation can be automated for improved efficiency.

(1) Creating an auto feedback line
Create an auto feedback line which receives the value of a desired device (except local devices) of the program under
simulation, performs calculation, and returns a value to the simulation program.

Click the Auto Feedback tab in the editing mode. The following auto feedback line variable screen appears. The operating
procedure is completely the same as that of the usual line editing screen.

Here, create the following line which receives the signal from “simulation operation program” in Appendix 1-2-2 (3), starts
the timer, then returns the bit signal.

<Operation>

When this line receives the ON signal (M0 turns on for one scan) from the simulation operation program, the re-triggerable
timer (T0) is activated. The re-triggerable timer is a timer which captures a rising edge of the input signal and turns ON the
timer output bit for specified time interval. With this line, when the specified time interval has elapsed, the timer output turns
OFF and then M2 (feedback signal to the simulation program) turns ON only for one scan.
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(2) Revising the simulation program
Revise the “simulation operation program” in Appendix 1-2-2 (3) so that the program exchanges signals with the auto feedback
line.

<Revisions>

1) Add contact M2 so that the on-delay timer (T0) starts when the feedback signal (M2 turns ON for one scan) is received from
the auto feedback line.

2) Add a line which transfers the count-up signal of timer T0 to the auto feedback line.
Since on-delay timer T0 is a local device and therefore cannot be transferred to the auto feedback line as it is (T0), T0 is
output to M1 and M1 is transferred to the auto feedback line.

(3) Checking auto feedback operation
When the lines in (1) or (2) have been prepared, start simulation and then check operation.

Click the [Edit Mode] button to change the mode from the editing mode to the monitor mode.
Click the [PLC Run/Stop] button to activate the simulator. The on-delay timer (T0) of the simulation operation program and
the re-triggerable timer (T0) of the auto feedback line operates alternately.

1)

2)
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Appendix 2-1-1 ST Operators
Operators that can be used in ST language are listed below:

* Take note of data types available in each operator.

Appendix 2-1-2 ST Statements
The following eight control statements are used in ST language.

No. Operation Operator Example

1 Parentheses (expression)

2 Function Function name
(parameter)

WM1 := BCD(WM0);
WL100 := BMOV(WL0, 5);

3 Exponentiation ** DM100 := DM0 ** REAL#3;

4 Logical not NOT Y2.0 := NOT X1.0;

5 Multiplication * DM10 := DM8 * DINT#1000;

6 Division / DM12 := DM12 / DINT#3;

7 Division remainder MOD WL10 := WM0 MOD 10;

8 Addition + WM2 := WM0 + WM1;

9 Subtraction - WM3 := WM2 - 100;

10 Comparison <, >, <=, >= M0 := WM100 > 100;

11 Equality = M1 := DM100 = DINT#10000;

12 Inequality < > M2 := WL200 <> 1000;

13 Logical Product &, AND M3 := M1 & X1.0;

14 Exclusive or XOR WM100 := WM99 XOR WL100;

15 Logical add OR WM0 := WX1.0 OR 16#00FF;

Format Description

:= Assignment statement.
Assigns the value of the expression, variable, or numeric value on the right-hand side to the vairable on
the left-hand side.

IF Condition statement.
Executes the executable statement if the conditional expression is true.

CASE Condition statement.
Selects the executable statement to be executed according to the value of the conditional expression.

FOR Iteration statement.
Repeatedly executes the executable statement according to the initial value, final value, and
incremental or decremental value.

WHILE Iteration statement.
Repeatedly executes the executable statement while the loop condition is true.

REPEAT Interation statement.
Repeatedly executes the executable statement until the loop condition is true.

RETURN Return statement.
Returns control from the called function or function block to the calling POU.

EXIT Exit statement.
Used to exit an iteration loop.
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Appendix 2-1-3 Basic Description Specifications
(1) Basic syntax of instruction
The describing method in ST language is as follows:

(2) Example of describing a multi-operation
In the Standard loader, monomial expressions are used for the representation of expressions. Therefore, a multi-operation
that uses multiple operators must be described as follows:

Device  :=   Device   or   Constant   or   Expression   ;

Semicolon

<Sample programs>

ST language representation  Ladder language representation

WM0  :=  WM1;

Example of memory address

Y2.0  :=  X1.0;

Example of memory address

WM0  := 1000;

Example of constant

WM7  :=  WM5 + WM6;

Example of expression

WM3  :=  BCD (WM2);

Example of expression (function)

Example of multi-operation 

(WM0 + WM1 + WM2) / 3 = WM3 

ST language representation

WM3  :=  WM0 + WM1;

WM3  :=  WM3 + WM2;

WM3  :=  WM3 / 3;



App.2-3

Appendix 2 How to Use ST Language

(3) Example of describing a sequential circuit
Sequential circuits can also be described in ST language.

Appendix 2-1 Overview of ST Language

(4) Describing a comment
A comment is created above an instruction line.

ST language representationSample sequential circuit

Example of AND circuit

Example of OR circuit

Example of latching circuit

M2 := M0 & M1 ;(     )

M0 M1 M2

M2 := M0 OR M1 ;(     )

M0

M1

M2

MF := M0 OR M2 ;

ME := NOT M1 ;

M2 := MF & ME ;

(     )

M0 M1

M2

M2

MF ME

Auxiliary relay

��

(*Execute processing when M0 is turned ON*)

IF  M0 = TRUE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

IF  M0 = TRUE THEN 

  

WL100 := WL101 + 100 ;

END_IF ;

Note: When creating a comment on the right of an instruction line:

(*Execute processing when M0 is turned ON*)

� A comment is created above an instruction line.

� When a comment is created on the 

    right of an instruction line, by confirming 

    the edit of the ST editor, the comment is 

    relocated below the circuit.
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Appendix 2-2-1 Condition Statements
The condition statement is a control statement to execute the selected instruction (executable statement) if certain conditions
are met. Two types of condition statements, the IF statement and CASE statement, are provided.

(2) IF statement
For the IF statement, three types of syntaxes are provided according to the option to be executed.

<1) IF...THEN structure>

When the value of the conditional expression is TRUE, the executable statement is evaluated (executed). When the value of
the conditional expression is FALSE, nothing is executed.

* For the “conditional expression”, a monomial expression whose operation result is a BOOL type value can be used. If you
want to designate an operation result of a multi-operation as the condition, program as shown in the sample program 4.

IF <conditional expression> THEN 

  <executable statement>;

END_IF;
Conditional

expression

Executable

statement

FALSE

TRUE

<Basic syntax> <Flowchart>

IF  M0 = FALSE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

IF  WL101 < 99 THEN 

  WL100 := WL101 + 100 ;

END_IF ;

IF  M0 = TRUE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

<Sample program 1>

When M0 is ON, the conditions are met and 

the operation of “WL101 + 100 = WL100” is

executed.

<Sample program 2>

When M0 is OFF, the conditions are met and 

the operation of “WL101 + 100 = WL100” is 

executed.

<Sample program 3>

When WL101 is less than 99, the conditions 

are met and the operation of “WL101 + 100 

= WL100” is executed.

<Sample program 4>

When WL101 is “50 < WL 101 < 99”

the conditions are met and the operation 

of “WL101 + 100 = WL100” is executed.

M0 := WL101 > 50 ;

M1 := WL101 < 99 ;

M2 := M0 AND M1 ;

IF  M2 = TRUE THEN 

  WL100 := WL101 + 100 ;

END_IF ;

,
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< 2) IF...ELSE structure (choice between two) >

When the value of the conditional expression is “TRUE”, the executable statement 1 is evaluated and when the value is “FALSE”,
the executable statement 2 is evaluated.

< 3) IF...ELSIF structure >

When the value of the conditional expression 1 is “TRUE”, the executable statement 1 is evaluated. When the value is “FALSE”,
the next conditional statement 2 is evaluated. Then, when the value of the conditional expression 2 is “TRUE”, the executable
statement 2 is evaluated. When the value is “FALSE”, the conditional statement 3 is evaluated next. Thus, selectively branched
processing can be realized.

IF <conditional expression> THEN 

  <executable statement 1>;

ELSE 

  <executable statement 2>;

END_IF;

Conditional

expression

Executable

statement 1

Executable

statement 2

FALSE

TRUE

<Basic syntax> <Flowchart>

IF <conditional expression 1> THEN 

  <executable statement 1>;

ELSIF <conditional expression 2>  THEN

  <executable statement 2>;

ELSIF <conditional expression3>  THEN 

  <executable statement 3>; 

    

        

ELSE

END_IF;

Conditional

expression 1

Conditional

expression 2

Conditional

expression 3

Executable

statement 1

Executable

statement 2

Executable

statement 3

FALSE

FALSE

FALSE

TRUE

TRUE

TRUE

<Basic syntax>

<Flowchart>
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(2) CASE statement
The condition expression of the CASE statement is used when the executable statement is selected by a single INT type value.

<Method of expressing INT-type selection value>

INT-type selection values can be expressed by numeration or range.
Expression by numeration  Delimit the selection values with commas (,) to register.
Expression by range  Express the range with “..”.

CASE <conditional expression> OF

<INT type selection value 1>  :  

  <executable statement 1>;

<INT type selection value 2>  :  

  <executable statement 2>;

   

 

ELSE     

  <executable statement 3>;        

END_CASE;

=Selection

value 1 ?

=Selection

value 2 ?

=Selection

value n ?

Executable

statement 1

Executable

statement n
Executable

statement n+1

Executable

statement 2

YES

YES

YES

NO

NO

NO

<Basic syntax>

<Flowchart>

Example of selection values 

expressed by numeration

Example of selection values 

expressed by range
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Appendix 2-2-2 Iteration Control Statements
The iteration statement is used to execute one or more instruction repeatedly according to a certain condition.

(1) FOR statement
The FOR statement repeatedly executes the instruction (executable statement) according to the iteration count (word address).

(2) WHILE statement
The WHILE statement repeatedly executes the executable statement while the value of the condition expression whose
operation result is a BOOL type value is “TRUE”.

FOR <iteration count (word address)>  :=  <initial value>  TO  <final value>  BY  <incremental value>  DO

    <executable statement>;

END_FOR;

Iteration count

> final value

Iteration count (initial value)

Executable statement

Iteration count +

incremental value

FALSE

TRUE

* A determination whether the iteration count has reached the 

  final value or not is made before the executable statement. 

  Therefore, at the instant when the iteration count has exceeded 

  the final value, the next process begins.

Note: “-” (minus) cannot be used for the incremental value of the

          FOR statement. Be sure to prevent the result of the expression

          becoming a minus.

<Basic syntax>

<Flowchart>

WHILE <loop conditional expression>  DO

    <executable statement>;

END_WHILE;

Loop 

Conditional

expression

Executable statement

FALSE

TRUE

* Due to a loop, a determination is made before the executable 

statement. Therefore, if the value of the conditional expression

has been “FALSE” from the beginning, the executable statement 

is never processed.

<Basic syntax>

<Flowchart>
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(3) REPEAT statement
The REPEAT statement repeatedly executes the executable statement until the value of the final conditional expression
becomes “TRUE”.

(4) EXIT statement
The EXIT statement is only used in the iteration control statement (FOR, WHILE, and REPEAT statement). If the EXIT statement
is executed, the loop processing can be terminated halfway through.

Appendix 2-2-3 RETURN Statement
The RETURN statement is used in a user function or a user function block.
When the RETURN statement is executed, control is immediately returned from the user function or user function block to the
main program.

<Flowchart of RETURN statement processing>

REPEAT

    <executable statement>;

    UNTIL  <final conditional expression>

END_REPEAT;

Final

conditional

expression

Executable statement

FALSE

TRUE

* In the REPEAT statement, a determination of the loop condition 

is made after the executable statement. Therefore, even if the 

final conditional expression is “TRUE” the executable statement 

is inevitably executed at least once.

,

<Basic syntax>

<Flowchart>

Processing time

User FB call Executing user FB

If M0 becomes “TRUE” 

in the user FB internal 

processing, the RETURN 

statement is executed and 

control is returned to the 

user FB calling program. 

If the RETURN statement 

has not executed, control 

is returned to the user FB 

calling program after the 

program in the user FB is 

executed until it is completed. 

IF M0 = TRUE THEN

    Y2.0 := TRUE;

    RETURN;

END_IF;

The processing time is shortened

by this length.
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Appendix 2-2-4 Nesting Structure of Control Statements
When another control statement is used in the control statement (condition statement or iteration statement), up to eight levels
of nesting are allowed. (nesting structure)

<Example of nesting>

The following is an sample program of a function block operation that stores data in the INT-type array data from 1 to 100.

Note: Although up to eight levels of nesting are allowed (guaranteed operation), the program may become complicated if the
nesting is deep. Therefore, when you program, it is recommended that the nesting depth should be four of five levels at
the deepest.

IF WM0=0 THEN

  M0 := TRUE;

END_IF;

IF M1=FALSE THEN

  WL100 := WL100 + 1;

  WL101 := WL101 + 2;

  M0 := FALSE;

 

  IF WL100 >= 100 THEN

     M1 := TRUE;

  END_IF;

END_IF;

IF X1.0 THEN

  WL100 := 1;

  

  FOR WL100:=1 TO 100 BY 1 DO

   WM100 := 0;

  END_FOR;

  (*File empty*)  

  M0 := TRUE;

  (*File full*)

  M1 := FALSE;

  WL100 := 0;

END_IF;

This is a nesting structure where another 

IF statement is used in a IF statement. 

(This is counted in the nesting depth.)

This is a nesting structure where a FOR 

statement is used in a IF statement. 

(This is counted in the nesting depth.)
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Appendix 2-3-1 Basic Operations
(1) Adding a program (in package displays mode)
If a program is created in ST language, select “ST” for the language type when the program is inserted.

Select the position where you want to insert a program, and execute the [Insert Program] command in the [Edit] menu. The
[Insert] dialog box  is displayed.

After setting all necessary items, click the [OK] button. The program (page) is added as shown in the figure below.

In the editing mode, when you right-click on the page portion and then execute the [ST Editor] command, the following “ST
Editor” dialog box is displayed.
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(2) Adding a program (in individual displays mode)
If a program is created in ST language, select “ST” for the language type when the program is inserted.

Select the position on the project tree where you want to insert a program and then execute the [Insert] command in the
right- click menu. The [Insert] dialog box is displayed.

A program is added in the project tree. If “insert” is selected for [Mode], a program is added above the cursor position. If
“Append” is selected, added below the cursor position.

In the editing mode, when you double-click on the program worksheet area, the following “ST Editor” dialog box is displayed.

Double-click here.

Program worksheet area
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(3) Overview of ST Ediotr dialog
The layout of the ST Editor dialog box is shown below.

Program name Tool barMenu bar

Program editing area

Message display area

(4) Programming
The basic operations for creating a program in ST language is explained below.

Write a program in ST language on the program editing area.

After writing a program, execute the [Exit] command in the [File] menu. The confirmation dialog of compilation is displayed.

Row No.
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When you click the [Yes] button, a composition check of ST language is performed. If no composition error is found,
compilation is completed and the program is displayed as shown below.

Note 1: If any composition error is found by compilation, the error description is displayed on the message display area.
Note 2: The compilation explained here checks representations of ST language. When you want to check the address in the

PLC internal memory etc., use the [Options] command in the [Auxiliary] menu.

(5) Monitor
A program created in ST language is monitored as shown below.

* In the monitor of ST language programs, monitoring of the device on the left of the assignment statement (:=) and, in the
case of IF statement or WHILE statement, the leftmost device is performed. In addition, for an FB or a function, the value of
the device that is designated as the first operand is displayed.

Monitored value
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Appendix 2-3-2 Applied Operations
(1) Inserting an instruction using the wizard function
Control statements, FBs, functions, etc. can be inserted by using the wizard function.

Place the cursor on the row where you want to insert an instruction and then execute the [Insert Instruction] command in the
[Edit] menu on the [ST Editor] dialog box. The “Insert Instruction” dialog box is displayed.

After selecting the instruction to be inserted on the [Insert Instruction] dialog box, click the [OK] button. The selected instruction
is inserted as shown in the figure below. In “(* *)”, the data type of the device to be entered is displayed.

Rewrite these with actual devices.
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(2) Saving a program in a text file
A program created in the “ST Editor” dialog box can be saved in a text file and edited with a commercially available text editor.

When you execute the [Save to file...] command in the [File] menu, the [Save As...] dialog box is displayed.

Specify a folder for saving the program, enter a filename, and then click the [Save] button. The program is saved in text  format.
The saved program can be displayed and edited with a commercially available text editor.

Appendix 2-3 Operations of ST Language Editor
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(3) Setting keyword color
You can change the color of ST language control statements.

When you execute the [MICREX-SX Environment] command in the [Options] menu. The [Environment Options for “MICREX-SX”
dialog box is displayed. Click the [Colors] tab on it to display the color setting window.

Appendix 2-3-3 Restrictions for Creating a Program in ST Language
(1) Display and Edit

The indent is automatically adjusted to the fixed width.
Blank lines are cut down and not displayed.
On a ladder diagram, marks indicating a line change are displayed while editing a program online. However, they are not
displayed on the ST Editor.
A comment in a statement is displayed on another row.
A multi-operation using two or more operators cannot be created on a single row.

(2) Functions unavailable in a program created in ST language
The [Go to Line] command is not available; it is not possible to move on to a line with the specified line number.

Appendix 2-3 Operations of ST Language Editor

Select the “Control string for ST” and then click a color that you want to use. After determining the setting, click the [OK]
button. The ST language control statements are displayed in the specified color.
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Appendix 3-1 Basic Procedure for Converting a Program

To convert a program, start up the Windows loader for M/F series (MICREX-F PLC Programmer) and the Windows loader for SX
series (SX-Programmer Standard) on one personal computer, and then copy and paste the program. The basic converting
procedure is as follows:

Appendix 3-1-1 Description of convert operation
(1) Copying an M/F program (line) to be converted

Open a program of M/F with the PLC Programmer and click the [Edit] button to place the program in edit mode.

[Edit] button

End

NO

YES

Start

1)  Open a program of M/F with the Windows loader for M/F (PLC Programmer).

     Select and copy the line that you want to convert.

2)  On the Standard loader, paste the copied line.

     The [Address Assignmant] dialog is displayed. Set the rules of address conversion.

3)  The line is converted and pasted on the program sheet on the Standard loader.

     The result of conversion is displayed.

Change the settings 

of the [Address Assignment] and

convert the program again.

By setting the [Address Assignment] again according to 

the result of conversion, the convertibility is improved.

4)  According to the result of conversion, modify the program on the Standard loader.
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Click and select lines to be copied. To select two or more lines, click the top of the lines to be selected and then click the
last line while holding the <Shift> key down.

* On the left and right power rails of the selected lines, S’s are marked.

Copy the selected lines. Execute the [Copy] command in the [Edit] menu. (The lines can also be copied by right-clicking on
the screen and executing the [Copy] command in the menu or by pressing the <Ctrl> key + <C> key.)
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(2) Pasting the copied lines to the Standard loader 1)
By using the task bar of Windows, switch the task to the Standard loader.
Open the program to which the copied lines are pasted and paste them in edit mode.
Execute the [Paste] command in the [Edit] menu. (The lines can also be pasted by right-clicking on the screen and executing
the [Paste] command in the menu or by pressing the <Ctrl> key + <V> key.)
When you execute the paste, the [Address Assignment] dialog is displayed as shown below.

* The [Address Assignment] dialog is a correspondence list to convert the memory addresses used in a program of M/F
series into the memory addresses of SX series.

For example, the above figure (I/O memory) shows the setting for converting bit addresses (B****) and word addresses
(WB****) from WB0000 to WB0511 used in the M/F program into bit addresses (X1.**** or Y1.****) and word addresses
(WX1.**** or WY1.****) in SX.

Note 1: In the case of I/O memory (B), the contact is converted into input memory (X) and the coil is converted into output
memory (Y).

Note 2: In the case of the above address setting, all the SX bus station numbers are converted into “1”. Therefore, after
conversion is completed, you need to modify them.

B10A B0 B20

Program of M/F

X1.10A X1.0 Y1.20

Program of SX
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(3) Pasting the copied lines to the Standard loader 2)
When you clink the [OK] button on the [Address Assignment] dialog, the result of conversion is displayed on the [Paste Log]
dialog as shown below..

The information about unconverted points displayed on the [Paste Log] dialog can be saved in a text file.
Click the [Save] button on the dialog to display the [Save Paste Log File] dialog.
You can save the information in an arbitrary folder under whatever filename you please. (The extension of the file is “.log”.)

* Line Nos. and descriptions of lines that have not been converted 

  are displayed. “E” marks are indicated on the both power rails of the 

  lines where conversion is not completed yet. “?” marks are indicated 

  at unconverted points.



App.3-5

Appendix 3 Convert Function

Appendix 3-1 Basic Procedure for Converting a Program

(4) Modifying the converted program
On the [Paste Log] dialog, “line Nos.” and “descriptions” of lines that include an unconverted device are displayed.

* In the case of <line No. 1> shown above
Since L0100 used in the M/F program is not on the correspondence list of the [Address Assignment] dialog, it has not been
converted.

* In the case of <line No. 8> shown above
The operation target device is 32-bit length (BD****) in the M/F program, however, the device where the operaion result is
stored is 16-bit length (WB****). Therefore it has not been converted.

Double-click on the unconverted point (instruction area) to display the [Address Entry] dialog shown below.
The box for the unconverted device is blank. Enter a device to be used and click the [OK] button.

Note 1: If there are many unconverted points, change the setting of address conversion on the [Address Assignment]
dialog and convert the program again.

Note 2: Modify the I/O addresses according to the system configuration.

Unconverted instruction
<Line No. 1>

Unconverted instruction
<Line No. 8>
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Appendix 3-1-2 Description of convert operation from a file (V2.2.1.0 or later)
A program file (*.Ldx) created with the Windows loader for the MICREX-F series can be directly opened and converted by the
Standard loader.

Note: If a password is set for the program file, it is not possible to convert it. Before converting it, cancel the password with the
Windows loader. .

<Operational procedure>

Execute the [Open...] command in the [File] menu of the Standard loader. The [Open Ladder File] dialog box is displayed.
Select “Micrex-F Program [*.Ldx]” for the files of type and then a file to be converted.

After selecting a file to be converted, click the [Open] button. The [Select PLC Model] dialog box is displayed. On this dialog
box, select a CPU for the MICREX-SX series and the program memory size.

After setting the PLC model, click the [OK] button. The necessary program is automatically imported.
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When import is completed, the [Address Assignment] dialog box is displayed.

When you clink the [OK] button on the [Address Assignment] dialog, the result of conversion is displayed on the [Paste Log]
dialog as shown below..

With the result of conversion as a guide, correct the program.
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By changing the address conversion setting on the [Address Assignment] dialog according to the actual configuration and the
memory size of the CPU, the convertibility can be improved.

Appendix 3-2-1 Modifying address assignment
Select the line that you want to modify on the [Address Assignment] dialog and click the [Modify] button. The [Address Entry]
dialog is displayed.

According to the system, enter arbitrary addresses and click the [OK] button. The changes take effect.



App.3-9

Appendix 3 Convert Function

Appendix 3-2 Setting Address Assignment

Appendix 3-2-2 Adding address assignment
(1) Adding address assignment

If you want to add a new rule of address correspondence, click the [Add] button to display the [Address Entry] dialog. When
you execute the [Add] command, the boxes of setting items are blank. Enter arbitrary addresses according to the system
configuration and click the [OK] button.

(2) Changing file definition
If there is a file definition in the program of MICREX-F and a file (from W30) is used, by adding a file definition to the [Address
Entry] dialog, the convertibility can be improved.

Click the [File Definition] tab on the [Address Entry] dialog to display the dialog shown below.
After setting each item, click the [OK] button. The address convertion of the file (from W30) is registered.
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Appendix 4-1 Overview

The “3-level access restriction function”, which restricts online operations to the PLC, has been supported with V2.2.3.0.
With this function, operations to the PLC can be restricted at 3 different levels by setting passwords for access authentication.
When the 3-level access restriction function is not used, it is possible to restrict access using the password function of
versions earlier than V2.2.3.0.

* In addition, users can change the range of access restriction.

<Differences between existing security function and this function>

The Standard loader has already supported the project security function (password of project), which aims to maintain
confidentiality and avoid falsification of projects. It contains online access restriction function, however, it only protects projects
on the loader; the PLC itself cannot be protected.
In addition, only one password can be set, therefore, it is not possible to set multiple access levels.

Level 3

User

Level 3

User

Level 3

User

Level 2

User

Level 2

User

Level 1

User

Level 2 � For maintenance (Rights of level 3 are not given.)

Level 1 

(Password authentication is not required.)

No password

Level 3 password

Level 2 password

Level 3 � For administrator (There is no restriction.)
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Appendix 4-2 Specifications of 3-level Access Restriction Function

Appendix 4-2-1  Target CPU

3-level access restriction function is targeted at SPH300, SPB and Board Controller.

Appendix 4-2-2  Operating range for each access level

Available operations of Standard loader for each level (default) are shown below.
Note: For access restrictions that are not on the list below, use the conventional project security function.

* For the shaded items on the list above, it is not possible to change access restriction setting.

Note: If you clear a program or system definition, all passwords are cleared.

Function Level 3 Level 2 Level 1

Load

Program O O X

System definition / module driver O X X

Data / ZIP file / parameter data O O X

Download changes to PLC O O X

User ROM

Loading of project O O X

Write-protection O O X

Export of user ROM file to text file O O X

Writing of tag project O O X

Import of tag project O O X

Monitor O O O

Data modify O O X

PLC information O O O

Task execution time measurement O X X

Memory clear
(Note)

Program O X X

System definition / data / ZIP file / resource initialization O O X

Memory transfer O O X

PLC calendar display O O O

PLC calendar setting O O X

Debug
Breakpoint / step execution
forcible ON/OFF
Program operation / condition monitor / sampling trace

O O X

Redundancy control Switch between active and standby CPUs O O X

PLC run/stop O O X

SX control utility

Backup - Transfer (PLC to file) O O X

Backup - Transfer (file to PLC) O X X

Backup - Verify O O O

Data change - Transfer to PLC O O X

Password

Level 3 password setting O X X

Level 2 password setting O O X

Password clear O X X

Access restriction setting O X X

Failure diagnosis O O O
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Appendix 4-2 Specifications of 3-level Access Restriction Function

Appendix 4-2-3  Functions to manage password

Operations required to manage the password (“Registration”, “Authentication”, “Change” and “Clear”) and the authority to
perform them are as follows:

* Effective duration of password authentication

Once password authentication is completed, it is effective until the online window is closed.

Function Access level Authority

1) Registration
The password is registered for the PLC.

Level 3 user or
No password
registered

Allowed to register passwords for level 3 and level 2.

Level 2 user Allowed to register only a password for level 2.

Level 1 user Not allowed.

2) Authentication (logon)
Logon operation to allow operations to
the PLC.

Level 3 user By performing password authentication for each level,
operations for each level are allowed.
* If passwored authentication is not performed, access level 1

is provided.Level 2 user

Level 1 user

3) Change
The registered password is changed.

Level 3 user Allowed to change passwords for level 3 and level 2.

Level 2 user Allowed to change a password for level 2.

Level 1 user Not allowed.

4) Clear
All registered passwords are cleared.

Level 3 user Allowed to clear passwords for level 3 and level 2.

Level 2 user Not allowed.

Level 1 user Not allowed.

5) Restriction setting
Operations for each level can be
individually enabled/disabled.

Level 3 user Allowed to change access restriction.

Level 2 user Not allowed.

Level 1 user Not allowed.
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Appendix 4-3 How to Use Password

Appendix 4-3-1 Registering password (when no password has been registered)

Connect the loader to the PLC online.
Execute the [Password...] command in the [PLC Functions] menu to display the [Password] dialog.
If the PLC is running, stop it.

Click the [Registration/Change] button to display the [Registration/Change] dialog.

* If the [Access level effective] checkbox is set to ON,
the screen changes into the password entry screen
for level 2 and 3.
If a password is set without setting this checkbox to
ON, access restriction of the password function of
versions earlier than V2.2.3.0 is imposed.



App.4-5

Appendix 4 3-level Access Restriction Function

Appendix 4-3 How to Use Password

After setting passwords for level 2 and 3, click the [OK] button. The passwords are registered in the PLC and control returns
to the [Password] dialog.

* It is possible to register only the password for level 3.
However, it is not possible to register only the password
for level 2.
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No. Password registration pattern Authentication and access level after authentication

1 The password is not registered. No restriction (Level 3)

2 The password is registerd.
(Access level is not effective.)

Authentication is performed with the registered password.
No restriction (Level 3)

Password authentication is not performed.
Access rights when no password is entered in the
password function of versions earlier than V2.2.3.0.

3 Only the password for level 3 is registered.
(Access lavel is effective.)

Authentication is performed with the registered password for
level 3.

No restriction (Level 3)

Password authentication is not performed.
Level 2 access right

4 Passwords for level 3 and level 2 are registered.
(Access level is effective.)

Authentication is performed with the registered password for
level 3.

No restriction (Level 3)

Authentication is performed with the registered password for
level 2.

Level 2 access right

Password authentication is not performed.
Level 1 access right

Appendix 4-3 How to Use Password

<Password registration patterns and access level>

Note: If the same password is set for level 2 and level 3, access is allowed at level 2 after authentication. If you want to
access at level 3, set different passwords for level 2 and level 3.
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Appendix 4-3 How to Use Password

Appendix 4-3-2 Password authentication

When connecting to the PLC for which passwords for level 2 and 3 are set, use the following procedure to perform password
authentication.

(1) Password authentication when connecting to the PLC online
Connect the loader to the PLC, and then execute the [Online] command in the [File] menu. The following dialog is displayed.
After checking connection with the PLC, click the [OK] button to display the [Authentication] dialog.

Enter the password for level 2 or level 3 and click the [OK] button. The loader loads a program from the PLC and is placed
in the online mode.

* If you click the [OK] button without entering a password, the loader loads a program from the PLC and is placed in the online
mode regarding you as a level 1 user.

Note: When “Clear PLC memory on opening window” checkbox is set ON, the memory of the PLC is cleared before connecting
to the PLC online only when the password for the level that allows resource clear is entered.

* If the password for the access level is registered,
the [Memory Clear] button is disabled.

(Note)
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Appendix 4-3 How to Use Password

(2) Password authentication in the online mode
Execute the [Password...] command in the [PLC Functions] menu to display the [Password] dialog. The current access
level is indicated.

* Indicates “Level 1 “ when password authentication
has not been completed (initial state)

Click the [Authentication] button to display the [Authentication] dialog.
Enter the registered password and click the [OK] button. The authenticated access level is indicated as shown below. (In
this example, the password for level 2 was entered.)
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Appendix 4-3 How to Use Password

(3) Password authentication when loading a project offline
Execute the [Load...] command in the [File] menu to display the [Authentication] dialog.

Enter the password for the level that allows loading of a project and click the [OK] button. The [Load] dialog is displayed.

* Items that cannot be loaded with the access level of the entered password are disabled.

*
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Change the password for access level 2 and click the [OK] button. The following dialog appears. Clicking the [Yes] button
returns control to the [Password] dialog. The current access level is not changed.

Note: While the PLC is running, it is not possible to change the password.

Appendix 4-3 How to Use Password

Appendix 4-3-3 Changing password

Change the currently registered password.

Execute the [Password...] command in the [PLC Functions] menu to display the [Password] dialog. The current access
level is indicated.

Click the [Registration/Change] button to display the [Registration/Change] dialog. As shown below, a user with access
level 2 cannot change the password for level 3.
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Appendix 4-3 How to Use Password

Appendix 4-3-4 Clearing password

Clear the currently registered passwords. Only users with access level 3 can clear passwords.

Execute the [Password...] command in the [PLC Functions] menu to display the [Password] dialog. The current access
level is indicated.

Click the [Clear] button. The confirmation dialog appears as shown below. Clicking the [Yes] button clears all passwords.
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Appendix 4-3 How to Use Password

Appendix 4-3-5 Changing access restriction setting

Change the currently set restrictions on online operations individually. Only users with access level 3 can use this function.

Execute the [Password...] command in the [PLC Functions] menu to display the [Password] dialog. The current access
level is indicated.

Click the [Restriction Setting] button to display the [Access Restrict Set] dialog.
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Appendix 4-3 How to Use Password

Select the access level to be changed, and then set the checkboxes for each function to ON or OFF to enable or disable the
function.

* If you set the checkbox to ON, the function becomes accessible.

After determining the setting, click the [OK] button to complete it.

* The setting contents are transferred to the PLC when the [OK] button is clicked. Therefore, it is not possible to change the
access restriction setting while the PLC is running.

<Checking set items>

When you click the [Confirm Setup] button on the [Access Restrict Set] dialog, the following dialog appears. You can check
the current setting status.



App.4-14

Appendix 4 3-level Access Restriction Function

Appendix 4-3 How to Use Password

<Initializing set items>

When you click the [Default] button on the [Access Restrict Set] dialog, the following dialog appears. Click the [OK] button to
reset the access restriction settings.

* For the default setting of access restriction, refer to the table in “Appendix 4-2-2 Operating range for each access level”.

<Exporting settings>

The settings of the selected access level can be saved under an arbitrary filename. (The extension is “.ARI”.)
By importing the saved file, it can be used as a kind of template.

In the [Access Level] list box on the [Access Restrict Set] dialog, select the access level whose settings are to be saved in a
file and then click the [Export] button. The [Export] dialog is displayed.

Enter a filename and click the [Save] button.
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Appendix 4-3 How to Use Password

<Importing settings>

Import information of access restriction settings saved by the export function.

In the [Access Level] list box on the [Access Restrict Set] dialog, select the access level to which settings are imported and
then click the [Import] button. The [Import] dialog is displayed.

Select a filename to be imported and click the [Open] button.
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Appendix 4-4 Notes on Use

(1) When you forget password
If you forget the password, it becomes impossible to access at level 2 and level 3.

(2) Position of the key switch
Set the key switch to the “TERM” position. If the switch is at the “RUN” or “STOP” position, it is not possible to register the
password.

(3) State of PLC
When the PLC is in the following states, it is not possible to set the password for access level 2 or 3.

When the program and system definition have not been downloaded
When the breakpoint function is used
When the condition monitor function is used
When the sampling trace function is used
When a user ROM card is write-protected
When in a N-to-1 redundant system
When a function No. where a password is stored has already been used
The function No. where the password is stored depends on the PLC type.

SPH300: 510,  SPB: 14,  Board controller: 510

(4) Consumption of program memory
When registering passwords for access level 3 and level 2, 33 steps of program memory is consumed. If there is not 33 steps
or more available space in the program memory, it is not possible to set the password.
In addition, when a program with maximum steps is downloaded to the PLC in which a password with the access level is
registered, the 3-level access restriction function becomes disabled and access restriction of the password function of
versions earlier than V2.2.3.0. is imposed.

(5) Loading of a program
A project that uses the following No. cannot be loaded to a PLC for which a password of 3-level access restriction function is set:

SPH300: 510,  SPB: 14,  Board controller: 510

(6) Setting password for a memory card utility
It is not possible to set a password of 3-level access restriction function for a user ROM card utility. To set a password for a
user ROM, mount it in the PLC, set the key switch to the “UROM-TERM” position, and then set a password for the PLC.

(7) Setting password in a multi-CPU system
In a multi-CPU system, set a password for each CPU. When you want to register the same password for all the CPUs, set it
for each CPU.
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The SX control utility allows MICREX-SX system I/O and internal memory monitoring, data change, and data backup without
starting the loader. This utility can also be used for I/O check in a system where no project is downloaded to the CPU module.

Appendix 5-1 Starting SX Control Utility

Connect the loader and MICREX-SX system
Execute the [SX Control Utility] command in the [Auxiliary] menu to start the SX control utility.

* The SX control utility can be started even if the loader is not started.

The SX control utility can also be started by clicking [Start] of Windows  [All Programs]  [SX-Programmer Standard] and
then executing the [SX Control Utility] command.

When the SX control utility is started, the message shown below appears.

Clicking the [OK] button displays the screen for confirming to read the system configuration.

Clicking the [OK] button reads the system configuration from the connected CPU module.

Click here

Click here
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Appendix 5-1 Starting SX Control Utility

Clicking the [Yes] button displays the screen in the monitor started state.
Clicking the [No] button displays the screen in the monitor stopped state.

Note 1: For a CPU module with no system definitions registered, the message shown below appears. The SX control utility
recognizes the I/O modules of the connected system, creates system definitions, and downloads them.

Clicking the [OK] button creates and downloads the system definitions to the CPU and displays the message shown
below.

Click the [OK] button, reset the CPU, and then use the SX control utility.

Note 2: If communications with the CPU are not established when starting the SX control utility, the message shown below
appears. In this case, check the connections with the CPU and communication settings for the SX control utility.
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Appendix 5-2 SX Control Utility Window

Select the memory type. Menu

1) Mark display area 2) Address display area 3) Data display area

Tool button4) Monitor status display

1) Mark display area

Displays the mark settings.
When a mark is set for an address, this area shows a marker (O in light blue).
Displays the reference input specification for output address.
When an output area has been defined as the reference input in I/O group setting of the system definitions, “R” is added
to the address.

2) Address display area

Displays the addresses in the CPU memory in the order of CPU numbers and addresses. If the corresponding address has
not been registered to an I/O group, it is not displayed. Modules registered as “no equipment” are displayed, however, the
binary display area is grayed out.

3) Data display area

Binary display area
Displays binary data of the memory related to “Address display area.”

<Detailed display of I/O group definition>
This area also displays detailed information of I/O group settings. Bits for which I/O groups have been set are displayed
in the ordinary character display color (black) and the ones for which no I/O groups have been set are displayed in gray.

Forcible set status display (valid only when forcible ON/OFF display is set)
Bits set for forcible ON/OFF are displayed with an underscore.

Decimal display area
Displays decimal data of the I/O module related to “Address display area.”
(The data type can be selected from signed integer, unsigned integer, or real number.)

Hexadecimal display area
Displays hexadecimal data of the I/O module related to “Address display area.”

Time display area
The data that corresponds to the data in the address display area is displayed in time format (selectable from “T” (ms),
“D” (year, month and day), “TOD” (hour, minute and second) and “DT” (year, month, day, hour, minute and second)).

String display area
The data that corresponds to the data in the address display area is displayed in the form of character string (STRING type).

4) Monitor status display

Displays the monitor status (stopped or running).
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(1) Setting monitor ON/OFF
Start or stop the monitor.

Monitor can be switched ON/OFF by clicking the  [Monitor] button or  [Monitor (force having)] button.

Appendix 5-3 SX Control Utility Operations

When monitoring is started by clicking the [Monitor (force having)]
button, the bits that are forcibly set ON/OFF are displayed with an
underscore in the binary data display area.

(2) Setting bit data
Overwrite data or forcibly set/reset (force ON/OFF) for the bit data in the binary data display area. Force ON/OFF is valid only for
actually existent I/O memory.

Select the bit to be set data and click one of the following buttons:

 [Bits ON],  [Bits OFF],  [Force set], and  [Force reset].

For releasing the forcibly set/reset I/O, select the forcibly set bit and click the  [Force release] button. For releasing
multiple I/Os set/reset forcibly, execute the [Batch release] command in the [Force] pull-down menu under [Data change].
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Appendix 5-3 SX Control Utility Operations

(3) Setting word data (16- or 32-bit data)
Overwrite data on the word data in the decimal or hexadecimal display area on the SX control utility window.

Click the decimal or hexadecimal display area of the memory to be overwritten, set decimal or hexadecimal data in
accordance with the display area, and press the <Enter> key.

Set data

* Double-word data can also be set by switching word/double-word display by the  [16-bits display] and  [32-bits display]
buttons.

*
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(4) Batch data change
Change the data in multiple memories at once.

Note: Because batch data change sets data in batch offline and then transfers the data to CPU, the CPU must be in the stop
state.

Place the SX control utility in the monitor stopped state.

Set data.

Data set in batch

Transfer the set data to the CPU. Executing the [Move to PLC...] command in the [Data change] menu displays the [Move to
PLC] dialog.

Select the data transfer destination CPU and click the [OK] button to display the confirmation dialog shown below. Clicking
the [OK] button transfers the data to the CPU.

* For multiple-CPU configuration, select the CPU the data is to be transferred to.

Appendix 5-3 SX Control Utility Operations

Clicking the [OK] button completes the transfer operation.
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Appendix 5-4 CPU Memory Backup

The SX control utility can store backup data files (*.bup) for program memory, data memory, system definitions, etc. from the
CPU into the personal computer.

Note: Backup files for programs and system definitions cannot be opened with the loader. Data stored in files are in SX-specific
machine code.

(1) Data backup
Transfer the data in the CPU module to the personal computer.

Place the monitoring stopped state and execute the [BackUp] command in the [Tool] menu to display the [Backup] dialog.
Set the transfer source CPU and the transfer destination file and then select the backup data type from the list box.

Transferring from backup file to CPU is also available
by specifying a backup file as the transfer source
and CPU as the transfer destination.

Click the [Browse...] button to display
the [Browse] dialog. From this dialog,
specify the transfer destination file.

The backup range in the data memory area can be specified. When you select a data memory, the [Range setting...] button
is valid. Click it to display the [Range setting] dialog. On this dialog, specify the range and click the [OK] button.
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Appendix 5-4 CPU Memory Backup

Select the transfer source, transfer destination, and backup data and then click the [Execution] button to display the
confirmation dialog shown below. Clicking the [OK] button starts data transfer.

When data transfer has completed, the dialog appears, showing the transfer results.

(2) Data verify
Verify the contents of the memory in the CPU with those of the backup file.

Set the [Verify] button ON in the [Backup] dialog, select the verify source file, verify destination CPU, and verified data type
and then click the [Execution] button.

The confirmation dialog shown below appears. Clicking the [OK] button starts verify.
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When verify has completed, the dialog appears showing the verified results.

(3) Backup text file input/output function
It is possible to save backup data as text files and display or edit the saved data with commercially available text editor or
spreadsheet program.

First, read backup files that have been created with [BackUp] command in the [Tool] menu.
Execute the [Open backup file...] command in the [File] menu.  The [Open backup file] dialog is displayed.

After selecting a backup file, click the [Open] button. The selected backup file is opened.

Appendix 5-4 CPU Memory Backup
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Then execute the [Save as...] command in the [File] menu to display the dialog shown below. Check the [Save the memory
area data by the text form] box, enter a desired file name for the file to be saved, and then click the [Save] button. The backup
data is saved in the file, in the “tab delimited text” format.

<Saved file name and folder>

By above explained operations, a folder and a file are created in the following structure.

Arbitrary folder

Backup file name.bup

Backup file name

SYSDEF01.BDF

SYSDEF02.BDF

MTER_1.TXT

MTER_2.TXT

RMTER_1.TXT

RMTER_2.TXT

SYSDEF03.BDF

SMTER_1.TXT

SMTER_2.TXT

TEXT

Binary data file group
 The binary files that have been created with the 
 backup function are saved in this folder.

Text data file group
 The text files that have been created with the backup function 
 are saved in this (TEXT) folder.
 The following data are created:
  Non-retain memory: MTER_n.TXT
  Retain memory: RMTER_n.TXT
  System memory file: SMTER_n.TXT
If address range exceeds 32k words, the data is divided in units of 
32k words.  Accordingly, the number of files differs depending on the 
size of individual backup memory size.  For example, when the size 
of non-retain memory is 128k words, maximum 4 files can be saved 
in the non-retain memory.

Appendix 5-4 CPU Memory Backup



App.5-11

Appendix 5 SX Control Utility

<Format of created text file>

The created text file is delimited by tabs to have the following format.

* The figure shown below is an example when a file is opened with a text editor.

Appendix 5-4 CPU Memory Backup
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This utility is used to change the mode of supported programming language to “SX-mode” that conforms to IEC 61131-3, an
international standard, or to update the SPB firmware.
(SPB is set to “N-mode” at shipment.)

<Necessary system configuration>

<Operating procedure>

From the program group of the Standard loader, execute [System Software Utility].

Note: Be sure to end other application programs before this utility is executed.

When the [OK] button is clicked after other application programs are ended, the currently connected SPB is checked.  After
the checking, the following dialog box is displayed.  (This checking takes approximately maximum 18 seconds.)

The status of currently connected
SPB is displayed.

The system software to be updated is set.
Set [Mode] to “SPB SX-mode”.

MEM/BAT

ALM

RUN

PWR

Standard loader
V10.** or later versions of SPB

Loader cable
 Converter Type: NW0H-CNV
 Cable Type: NW0H-CA3 (3 m long)

*For loader cable, either NN-CNV1 or NN-CNV3 can be used.

(Note)
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When the [System software Update Execution] button is clicked, the following confirmation dialog box is displayed.
When application programs exist in the SPB, make their backup copy as needed.

When the [Yes [Y]] button is clicked, the system software begins to be updated.

When system updating is completed successfully, the following dialog box is displayed.
Click the [OK] button to finish the operation.

* If system updating does not finish successfully, change the setting of baud rate and re-execute update.

Note: Be careful not to turn off the power switch of
the system or disconnect the power cable
while system software is being updated.
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